ZoomText 9.1
User’s Guide
Copyrights

**ZoomText Magnifier**
Copyright © 2009, Algorithmic Implementations, Inc. All Rights Reserved.

**ZoomText Magnifier/Reader**
Copyright © 2009, Algorithmic Implementations, Inc. All Rights Reserved.

**ZoomText 9.1 User’s Guide**
Copyright © 2009, Algorithmic Implementations, Inc. All Rights Reserved.

Unauthorized copying, duplicating, selling or otherwise distributing this software or documentation is a violation of Federal Copyright Law. No part of this publication can be reproduced, transmitted, stored in a retrieval system, or translated into any language in any form by any means without the express written consent of Algorithmic Implementations, Inc. (d.b.a. Ai Squared).

Credits

<table>
<thead>
<tr>
<th>Software Development</th>
<th>Product Testing</th>
<th>Product Usability</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jamie Clayton</td>
<td>Derek Bove</td>
<td>Scott Moore</td>
</tr>
<tr>
<td>Richard Demar</td>
<td>Cathy Gettel</td>
<td>Ben Weiss</td>
</tr>
<tr>
<td>Jost Eckhardt</td>
<td>Ritwick Ghai</td>
<td></td>
</tr>
<tr>
<td>Jim Edwards</td>
<td>Maurie Hill</td>
<td></td>
</tr>
<tr>
<td>Tim Lalar</td>
<td>Tony Jomaa</td>
<td></td>
</tr>
<tr>
<td>Fred Lichtenfels</td>
<td>Gary Walker</td>
<td></td>
</tr>
<tr>
<td>Chris Millsap</td>
<td>Shawn Warren</td>
<td></td>
</tr>
<tr>
<td>David Proskin</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Jayesh Shukla</td>
<td></td>
<td></td>
</tr>
<tr>
<td>Shawn Warren</td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

**Backend Web Development**
Doug Hacker
Mike Trainor

**Documentation / Packaging**
Scott Moore

Trademarks

**ZoomText** and **xFont** are registered trademarks of Algorithmic Implementations, Inc.

**ZoomText Magnifier** and **ZoomText Magnifier/Reader** are trademarks of Algorithmic Implementations, Inc.

**TruVoice** is a trademark of ScanSoft, Inc.

**NeoSpeech** is a trademark of NeoSpeech, Inc.

**ViaVoice** is a registered trademark of International Business Machines Corporation.

**Microsoft**, **Windows** and **Microsoft Speech Synthesis Engine** are registered trademarks of Microsoft Corporation.

Second Edition: February 2009
Ai Squared, P.O. Box 669, Manchester Center, VT 05255
Software License Agreement

IMPORTANT – Read this carefully before using this product.

ALGORITHMIC IMPLEMENTATIONS, INC. (D.B.A. AI SQUARED) IS WILLING TO LICENSE THE ENCLOSED SOFTWARE TO YOU ONLY IF YOU ACCEPT ALL OF THE TERMS IN THIS LICENSE AGREEMENT. IF YOU DO NOT AGREE TO THESE TERMS, LICENSOR WILL NOT LICENSE THIS SOFTWARE TO YOU, AND IN THAT CASE YOU SHOULD RETURN THIS PRODUCT PROMPTLY, INCLUDING THE PACKAGING, CD-ROM, AND ALL WRITTEN MATERIALS, TO THE PLACE OF PURCHASE FOR A FULL REFUND.

Ownership of the Software

1. The enclosed Licensor software program ("Software") and the accompanying written materials are owned by Licensor and are protected by United States copyright laws, by laws of other nations, and by international treaties.

Grant of License

2. The licenses granted in this Section 2 are subject to the terms and conditions set forth in this Software License Agreement:

(a) Subject to Section 2(b), you may install and use the Software on a single computer; OR install and store the Software on a storage device, such as a network server, used only to install the Software on your other computers over an internal network, provided you have a license for each separate computer on which the Software is installed and run. Except as otherwise provided in Section 2(b), a license for the Software may not be shared, installed or used concurrently on different computers.

(b) For a "Single-User" product license, the Software may be installed and activated on up to three computers. While the Software may be activated on three computers, use of the collective installations is restricted to one user at any given time. Simultaneous use by more than one user violates this license agreement.

(c) You agree that Ai Squared, or a legal representative of Ai Squared may audit your use of the Software for compliance with these terms at any time, upon reasonable notice. In the event that such audit reveals any use of the Software by you other than in full compliance with the terms of this Agreement, you shall reimburse Ai Squared for all reasonable expenses related to such audit in addition to any other liabilities you may incur as a result of such non-compliance.
(d) Mandatory Product Activation. The license rights granted under this Agreement may be limited to the first sixty (60) days after you first install the Software unless you supply information required to activate your licensed copy in the manner described during the activation sequence of the Software. You may need to activate the Software through the use of the Internet or telephone; toll charges may apply. There are technological measures in this Software that are designed to prevent unlicensed or illegal use of the Software. You agree that Ai Squared may use those measures and you agree to follow any requirements regarding such technological measures. You may also need to reactivate the Software if you modify your computer hardware or alter the Software. Product activation is based on the exchange of information between your computer and Ai Squared. None of this information contains personally identifiable information nor can it be used to identify any personal information about you or any characteristics of your computer configuration.

**Restrictions on Use and Transfer**

3. You may not copy the Software, except that (1) you may make one copy of the Software solely for backup or archival purposes, and (2) you may transfer the Software to a single hard disk provided you keep the original solely for backup or archival purposes. You may not copy the written materials.

4. Other than with respect to an "Evaluation" version of the Software, you may permanently transfer the Software and accompanying written materials (including the most recent update and all prior versions) if you retain no copies and the transferee agrees to be bound by the terms of this Agreement. Such a transfer terminates your license. You may not rent or lease the Software or otherwise transfer or assign the right to use the Software, except as stated in this paragraph. You may not sell or transfer any Evaluation version of the Software.

5. You may not reverse engineer, decompile, or disassemble the Software.

**Limited Warranty**

6. Licensor warrants that the Software will perform substantially in accordance with the accompanying written materials for a period of 90 days from the date of your receipt of the Software. Any implied warranties on the Software are limited to 90 days. Some states do not allow limitations on duration of an implied warranty, so the above limitation may not apply to you.

7. Licensor disclaims all other warranties, either express or implied, including but not limited to implied warranties of merchantability, fitness for a particular purpose, and non-infringement, with respect to the software and the accompanying written materials. This limited warranty gives you specific legal rights. You may have others, which vary from state to state.
8. Licensor’s entire liability and your exclusive remedy shall be, at licensor’s choice, either (a) return of the price paid or (b) replacement of the software that does not meet licensor’s limited warranty and which is returned to licensor with a copy of your receipt. Any replacement Software will be warranted for the remainder of the original warranty period or 30 days, whichever is longer. These remedies are not available outside the United States of America.

9. This Limited Warranty is void if failure of the Software has resulted from modification, accident, abuse, or misapplication.

10. In no event will licensor be liable to you for damages, including any loss of profits, lost savings, or other incidental or consequential damages arising out of your use or inability to use the software. Because some states do not allow the exclusion or limitation of liability for consequential or incidental damages, the above limitation may not apply to you.

11. This Agreement is governed by the laws of the State of Vermont.

12. If you have any questions concerning this Agreement or wish to contact Licensor for any reason, please write: Ai Squared, P.O. Box 669, Manchester Center, VT 05255 or call (802) 362-3612.

13. U.S. Government Restricted Rights. The Software and documentation are provided with Restricted Rights. Use, duplication, or disclosure by the Government is subject to restrictions set forth in subparagraph (c)(1) of The Rights in Technical Data and Computer Software clause at DFARS 252.227-7013 or subparagraphs (c)(1)(ii) and (2) of Commercial Computer Software - Restricted Rights at 48 CFR 52.227-19, as applicable. Supplier is Ai Squared, P.O. Box 669, Manchester Center, VT 05255.
# Contents

## 1 Introduction

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>ZoomText Magnifier</td>
<td>2</td>
</tr>
<tr>
<td>ZoomText Magnifier/Reader</td>
<td>4</td>
</tr>
<tr>
<td>What's New in ZoomText 9.1</td>
<td>6</td>
</tr>
<tr>
<td>System Requirements</td>
<td>9</td>
</tr>
<tr>
<td>About the ZoomText User's Guide</td>
<td>10</td>
</tr>
<tr>
<td>Documentation formatting</td>
<td>11</td>
</tr>
</tbody>
</table>

## 2 Getting Started

<table>
<thead>
<tr>
<th>Contents</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installing ZoomText</td>
<td>14</td>
</tr>
<tr>
<td>Downloading Program Components</td>
<td>17</td>
</tr>
<tr>
<td>Automatic Updating</td>
<td>18</td>
</tr>
<tr>
<td>Starting ZoomText 9.1</td>
<td>20</td>
</tr>
<tr>
<td>Activating ZoomText 9.1</td>
<td>21</td>
</tr>
<tr>
<td>Preparing to Activate ZoomText</td>
<td>22</td>
</tr>
<tr>
<td>The Activation Process</td>
<td>23</td>
</tr>
<tr>
<td>Activating a Magnifier/Reader installation with a Magnifier serial number</td>
<td>26</td>
</tr>
<tr>
<td>Activating ZoomText on more than one computer</td>
<td>26</td>
</tr>
<tr>
<td>Transferring Your ZoomText Software License</td>
<td>27</td>
</tr>
<tr>
<td>Frequently Asked Questions About Product Activation</td>
<td>28</td>
</tr>
<tr>
<td>Registering ZoomText 9.1</td>
<td>30</td>
</tr>
</tbody>
</table>
3 Magnification Features

The Magnifier Toolbar .............................................. 47
Setting the Magnification Level .................................. 50
Mouse Wheel Zooming .............................................. 53
Zoom Windows ....................................................... 55
  Selecting a Zoom Window ...................................... 56
  Adjusting a Zoom Window ..................................... 60
The Freeze Window ................................................ 62
Using View Mode and the View Locator ....................... 66
Dual Monitor Support ............................................... 69
  Dual Monitor System Requirements ......................... 71
  Required Display Settings .................................... 72
  Using ZoomText's Dual Monitor Support .................. 73
  Advanced Dual Monitor Settings .............................. 77
4 Screen Reading Features

The Reader Toolbar .......................................................... 141
Speech Settings .................................................................. 144
  Turning Speech On and Off ............................................ 144
  Adjusting the Speech Rate ............................................. 145
Synthesizer Settings .......................................................... 146
Text Processing .................................................................. 150
Hints ................................................................................ 153
Echo Settings .................................................................... 156
  Typing Echo ................................................................ 156
  Mouse Echo ................................................................ 159
  Program Echo ............................................................... 161
Verbosity ......................................................................... 164
Reading Tools .................................................................... 171
  AppReader .................................................................. 172
  AppReader Settings ....................................................... 174
  AppReader Hotkeys ....................................................... 176
DocReader ......................................................................... 178
The DocReader Toolbar ..................................................... 180
DocReader Settings ............................................................ 182
DocReader Hotkeys ............................................................ 185
Reading Zones .................................................................... 187
Reading Zones Toolbar ..................................................... 187
Creating, Editing and Deleting Reading Zones ............ 189
Using Reading Zones ......................................................... 192
Reading Zones Settings ........................................................ 195
What are Scripts and Scripting Languages? ........................ 250
Writing ZoomText Scripts.................................................. 251
Other Sources of ZoomText Scripts ................................... 251
Scripting Documentation for Script Writers ......................... 252
Managing Scripts.............................................................. 253
Registering Scripts........................................................... 257
Script Hotkeys.................................................................... 262
ZoomText 9.1 is a powerful computer access solution designed for the visually-impaired. Consisting of two adaptive technologies – screen magnification and screen reading – ZoomText allows you to see and hear everything on the computer screen, providing complete access to applications, documents, email and the Internet.

ZoomText 9.1 is available in two product versions:

- **Magnifier** – a standalone screen magnifier.
- **Magnifier/Reader** – an integrated magnifier and screen reader.

Both versions of ZoomText 9.1 are designed for users of all ages and skill levels. With a precise mix of power and simplicity, ZoomText provides total independence at home, school and in the workplace.
ZoomText Magnifier

ZoomText Magnifier is an advanced screen magnification program that enlarges and enhances everything on the computer screen.

ZoomText 9.1 Magnifier features include:

- **Flexible Magnification**  Full range of magnification levels up to 36x. Levels include: 1x to 8x in steps of 1, 10x to 16x in steps of 2, 20x to 36x in steps of 4, and fractional powers of 1.25x, 1.5x, 1.75x and 2.5x.

- **Powerful Zoom Windows**  8 different zoom windows allow you to configure the magnified view according to your needs.

- **Font Enhancements**  xFont technology (patented) displays print-quality text that's easy to read at all magnification levels. Smooth, bold and condense settings allow you to fine-tune the thickness and spacing of text for added legibility.

- **Dual Monitor Support**  Allows you to expand your magnified view or simultaneously see magnified and normal views of your screen (Windows Vista and XP only).

- **Enhanced Screen Colors**  Innovative color controls improve screen clarity and reduce eyestrain. Special effects include color dyes, two-color modes and replacement of problem colors.
Visible Pointers and Cursors  Size and color enhancements make it easy to see the mouse pointer. Special locators make it easy to find and follow the mouse pointer and text cursor.

Focus Enhancements  New focus enhancements make it easy to locate and follow the control focus when you navigate through application menus, dialogs and other application controls.

Smooth Navigation  Navigating your applications and scrolling the view is always smooth and comfortable. Constrained mouse movement allows you to examine rows and columns, and keeps you within the active window.

Desktop Finder  Desktop Finder helps you find and launch programs and documents on your desktop, system tray and quick launch bar.

Web Finder  Web Finder helps you find links and controls in any web page.

Text Finder  Text Finder helps you locate words, phrases and topics of interest in documents, web pages, and application windows.

Application Settings  Save unique settings for each application that you use. As you switch applications, ZoomText automatically loads the desired settings.

Windows Vista Logon Support  Magnification and screen reading support when logging on in the Windows Vista logon screen.
ZoomText Magnifier/Reader

ZoomText Magnifier/Reader is a fully integrated magnification and screen reading program that enlarges, enhances and reads aloud everything on the computer screen.

ZoomText 9.1 Magnifier/Reader includes all the features of ZoomText Magnifier, plus:

- **Complete Screen Reading**  ZoomText automatically speaks all program controls, including menus, dialogs, list views and messages. Three verbosity levels give you complete control over the amount of information spoken.

- **Automatic Document Reading**  'AppReader' automatically reads documents, web pages and email within the parent application. 'DocReader' reads documents in a special environment where text is reformatted for easier viewing.

- **Reading Zones**  Reading Zones allow you to instantly see and hear selected locations in your applications. Define up to 10 zones per application that you can trigger via pop-up menu or keyboard commands.

- **Full Internet Accessibility**  ZoomText reads any web page, in the proper reading order. You can read automatically or manually navigate by word, line, sentence and paragraph.
• **Text Navigation**  Navigation keys make it easy to read while creating and editing documents. With simple commands you can read by character, word, line, sentence and paragraph, even while selecting text.

• **Typing Echo**  Each key or word that you type is automatically spoken. You can choose to have all keys spoken or only selected groups of keys.

• **Mouse Echo**  Mouse echo automatically reads text that you point to. Single words or complete lines of text are spoken instantly or after hovering briefly.

• **SpeakIt Tool**  The SpeakIt tool allows you to read selected areas of the screen by clicking or dragging the mouse.

• **Special Application Support**  Built in support for popular applications – including Microsoft Office 2007 (Word, Excel, Outlook), Adobe Acrobat 8, Adobe Reader 8, Firefox 2.0 and Java – allow you to read and navigate your documents with 100% accuracy.

• **Built-in Synthesizers**  ZoomText includes four built-in speech synthesizers, each providing a variety of male and female voices to choose from. The new NeoSpeech synthesizer provides human-sounding voices (English only) that are closer to the real thing than ever before.
What's New in ZoomText 9.1

ZoomText 9.1 contains the following new features and enhancements, allowing for greater productivity and support for the latest versions of popular applications.

- **Support for Windows Vista**  ZoomText 9.1 offers robust support for Windows Vista, allowing users to take advantage of the advanced security and stability of the Vista operating system. Note: Vista’s Aero Glass feature is not supported.

- **Support for Microsoft Office 2007**  The new Office 2007 user interface components are fully tracked and spoken by ZoomText.

- **Support for Adobe Acrobat 8 and Adobe Reader 8**  ZoomText’s reading tools, including AppReader and DocReader, can now read in all of the page view types in Adobe Acrobat 8 and Adobe Reader 8.

- **Support for Mozilla Firefox 2.0**  ZoomText offers advanced support for Firefox 2.0, including complete tracking of web page controls and accurate reading in complex page layouts.

- **Support for the ZoomText Large-Print Keyboard**  ZoomText 9.1 provides full support for the ZoomText Large-Print Keyboard. Used together, your low-vision workstation is complete.
• **New Dual Monitor Support**  ZoomText’s new dual monitor support allows you to utilize two monitors to extend your magnified viewing area, or simultaneously share a magnified or unmagnified view of your desktop on a second screen (Windows Vista and XP only). For more information, see Chapter 3 - "Dual Monitor Support."

• **New ZoomText Scripting**  ZoomText’s scripting feature lets you create and utilize scripts to customize the behavior of ZoomText and other applications, providing more informative visual and audible feedback, and automation of tasks.

• **New Smooth Panning**  Smooth panning (patent-pending) provides a more natural panning motion when the magnified view scrolls to keep the focus in view.

• **New Focus Enhancements**  The new Focus Enhancement feature makes it easy to locate and follow the control focus when you tab and arrow key through menus, dialogs, toolbars, and other application controls. For more information, see Chapter 3 - "Focus Enhancements."

• **New Screen Enhancement Schemes**  Additional schemes have been added to each of ZoomText’s screen enhancement options.
• **New Inverted Block Locator Type**  A new type of view locator that provides greater emphasis on the area that’s currently being magnified, making it easier to select a new area to zoom in on.

• **New Windows Vista Logon Support (with ZoomText Logon UI)**  ZoomText’s new logon support provides essential magnification and screen reading features when logging into Windows Vista. For more information, see Chapter 2 - "Windows Vista Logon Support."

• **New Cursor Enhancement Sample Box**  The Cursor Enhancement dialog now includes a sample box to help you select a cursor enhancement scheme or select custom cursor settings. For more information, see Chapter 3 - "Cursor Enhancements."

• **New 60-day Trial Periods**  The ZoomText trial period has been extended to 60 days, allowing more time for customers to try out ZoomText before making a purchase decision.
System Requirements

The following hardware and software is required to run ZoomText 9.1:

- 450 MHz Pentium® III processor or equivalent
  1.5 GHz for Windows Vista
- One of the following operating systems:
  - Windows Vista
  - Windows XP with service pack 2 (SP2) or later
  - Windows 2000 with service pack 4 (SP4) or later
- Internet Explorer 5.0 or later
- Minimum 256 MB RAM
  Minimum 1 GB required for Windows Vista
- Minimum 25 MB free hard disk space (additional 60 MB required for each NeoSpeech synthesizer)
- Sound card (for Magnifier/Reader version only)

Note: Hardware requirements are higher for systems running the core features of Windows Vista. For more information, see the Minimum Support System Requirements on the Windows Vista website.
About the ZoomText User's Guide

The ZoomText 9.1 User's Guide provides complete instructions for installing and using ZoomText Magnifier and ZoomText Magnifier/Reader. Features that are unique to ZoomText Magnifier/Reader are grouped together in Chapter 4 - "Screen Reading Features", or are noted as a screen reader feature only.

This user's guide assumes you have a working knowledge of Microsoft Windows® and its conventions, including how to use the mouse and standard menu commands. For help with these techniques, please refer to your Microsoft Windows documentation.

Before using this manual, we recommend you install ZoomText 9.1.
Documentation formatting

Throughout this user's guide you will see special formatting used to represent important information. The following table outlines these formats and what they represent.

<table>
<thead>
<tr>
<th>Format</th>
<th>Represents</th>
</tr>
</thead>
<tbody>
<tr>
<td>Screen item</td>
<td>On-screen items that you select or click on, such as menus, dialogs and controls.</td>
</tr>
<tr>
<td><em>Screen item</em></td>
<td></td>
</tr>
<tr>
<td>Hotkey commands</td>
<td>Keys that you should press. The plus sign between keys means that you should hold down the first key while you press the second key. If three keys are represented, hold the first two keys while you press the third.</td>
</tr>
<tr>
<td></td>
<td></td>
</tr>
</tbody>
</table>
In this chapter you will learn the basics of ZoomText, including:

- How to install and activate ZoomText.
- How to start and exit ZoomText.
- How to enable and disable ZoomText.
- How to use the main ZoomText user interface and tray icon.
- How to use ZoomText's logon support for Windows Vista.
- How to get help on using ZoomText.

Although the information in this chapter should get you up and running, please refer to the following chapters for complete instructions.
Installing ZoomText

ZoomText 9.1 is easy to install on your system. The ZoomText CD includes a talking setup program with large-print dialog boxes that guide you through the installation. The setup program offers two methods of installation: *Automatic* and *Custom*.

*Automatic* installation installs ZoomText using the most common setup options (listed in the table on the next page). You are presented with fewer dialogs and the installation is completed in less time.

*Custom* installation allows you to choose all of the setup options.

**Note:** When you install ZoomText the setup program will install system-level components. In order to install these components you must have administrator privileges. If you do not have these privileges, contact your network administrator before proceeding with the installation.

The following table describes the setup options that are applied during automatic installations.
<table>
<thead>
<tr>
<th>Setup Options</th>
<th>Automatic Installation Settings</th>
</tr>
</thead>
<tbody>
<tr>
<td>Installation folder</td>
<td>C:\Program Files\ZoomText 9.1</td>
</tr>
<tr>
<td>Display a ZoomText icon on the Windows desktop *</td>
<td>Yes</td>
</tr>
<tr>
<td>Start ZoomText automatically when the system starts *</td>
<td>No</td>
</tr>
<tr>
<td>Speech synthesizers **</td>
<td>*ZoomText English-only version: All English speech synthesizers are installed.</td>
</tr>
<tr>
<td></td>
<td>**ZoomText International versions: TruVoice English and all available synthesizers for the selected language are installed.</td>
</tr>
</tbody>
</table>

* This setting can be changed at any time after installing ZoomText. This setting is located in ZoomText's Program Preferences dialog. To open this dialog, in the Settings menu, choose Program...

** Speech synthesizer options only apply when installing ZoomText Magnifier/Reader.
To install ZoomText

1. Disable virus-protection software and close all other programs.
2. Insert the ZoomText 9.1 CD into the CD-ROM drive. 
   *The ZoomText Setup program will start automatically.*
3. Follow the on-screen instructions to complete the installation.

If Setup does not start automatically

1. Click on the Windows Start button and select Run...
2. Browse to your CD-ROM drive.
3. Select the Setup program and click Open.
4. Click OK in the Run dialog box.
Downloading Program Components

If you obtained your ZoomText 9.1 software via download from Ai Squared’s website, you may not have received some of ZoomText’s optional program components. These components include speech synthesizers and product localizations (versions of ZoomText in other languages). You can download these components at any time.

Note: The selection of components that you can download depends on the type of ZoomText product installed on your system.

▶ To download program components

In ZoomText's Help menu, select Download Program Components...

Your web browser launches to the ZoomText program components web page. A list of available components is displayed along with instructions for downloading and installing.
Automatic Updating

ZoomText 9.1 includes automatic online version checking and updating. This service keeps your installation of ZoomText up-to-date with the latest fixes and enhancements. Here's how it works...

Each time you start ZoomText, the Update Wizard checks to see if you are online. If so, it quickly checks to see if you are running the latest version. If an update is available, the Update Wizard will ask if you want to download it. By clicking on the 'Yes' button, the update will download and install automatically.

Note: An Internet connection is required to use this feature.
If you or your network administrator do not want to check for updates each time you start ZoomText, you can disable automatic updating as follows:

► **To disable automatic updating**
  1. In the **Settings** menu, choose **Program**...
  2. Uncheck **Check for online updates each time ZoomText is launched**.
  3. Click **OK**.

In addition to the automatic updating, you can manually check for updates at any time

► **To manually check for updates**
  In the Windows **Start** menu, choose **Programs ➤ ZoomText 9.1 ➤ Check for Updates**.

  *The Update Wizard appears and walks you through the update procedure.*
Starting ZoomText 9.1

Once ZoomText is installed on your system, it can be started using one of the following procedures.

- On the Windows desktop, select the **ZoomText 9.1** program icon.
- In the Windows **Start** menu, choose **Programs** ➤ **ZoomText 9.1** ➤ **ZoomText 9.1**.

**Note:** ZoomText can be configured to load automatically when starting Windows. This option can be enabled while installing ZoomText, or in the **ZoomText Preferences** dialog box. For more information, see "Program Preferences" in Chapter 5.

When ZoomText starts up, it changes your display to show a magnified view of the normal screen. As you move the mouse, type text and navigate within your applications, the magnified view automatically scrolls, keeping the area of activity in view.

If you have installed ZoomText **Magnifier/Reader**, ZoomText will also speak aloud, narrating your actions as you work with your documents and applications. All of your Windows programs will operate normally while ZoomText is running.
Activating ZoomText 9.1

ZoomText 9.1 contains product activation technology designed to eliminate unauthorized use of ZoomText, without imposing a burden on legitimate users. Product activation is a simple, straightforward and anonymous process that takes just a few seconds to complete when performed over the Internet.

After you install ZoomText you have up to 60 days to activate the software. Until you do, ZoomText will run as a trial. You can activate immediately or anytime during the 60-day trial period. All features are available during the trial period, so you have full use of the software. When the trial period expires you must activate ZoomText to continue using it.
Preparing to Activate ZoomText

To activate ZoomText 9.1 you will need your ZoomText 9.1 serial number, provided with your purchased copy. If you have purchased an upgrade version of ZoomText 9.1 you will also need the serial number from your previous version of ZoomText (version 9.0 or earlier), unless your previous version is already installed on your system. These serial numbers can be found within your ZoomText product packages, as described below.

▶ Where to find your ZoomText serial number

- On the ZoomText CD sleeve
- On the product registration card
- On the top of the ZoomText product box
- On the back of the ZoomText User's Guide

Note: If you purchased your ZoomText 9.1 product from Ai Squared's online store, your product serial number will be included in your purchase confirmation email.
The Activation Process

During the 60-day trial period, each time you start ZoomText the Activation Wizard appears. The wizard presents the following options for you to choose from:

- **Option 1: I have a serial number and want to activate ZoomText**
  Choose this option if you have already purchased or been provided with a ZoomText product and you're ready to activate the software. The wizard will guide you through the activation process.

- **Option 2: I want to purchase ZoomText**
  Choose this option if you are ready to purchase a ZoomText product. The wizard will display information on how to purchase ZoomText.

- **Option 3: I want to try ZoomText**
  Choose this option if you want to run ZoomText in trial mode. Trial mode allows you to use ZoomText for up to 60 days. When the 60-day trial period expires, you must activate ZoomText to continue using it.
When you choose to activate ZoomText you are prompted to enter your product serial number. Once you have entered your serial number, the manner in which activation is completed depends on whether or not you have an Internet connection.
• **If you are connected to the Internet** your serial number and system code are automatically passed to the Ai Squared activation server for validation. An activation code is then passed back to your computer, activating your ZoomText license. This process takes just a few seconds to complete.

• **If you are not connected to the Internet** the wizard displays your serial number and system code, along with instructions on how to manually obtain an activation code. An activation code can be obtained from Ai Squared's activation website (using another computer that is connected to the Internet), or by contacting Ai Squared's Product Support department.

Telephone activation support is available Monday through Friday, 9am to 5pm Eastern Time.

In North America, call toll-free (866) 331-1233
Outside North America, call (802) 362-5393
Activating a Magnifier/Reader installation with a Magnifier serial number

If you have installed the ZoomText Magnifier/Reader software and then activate ZoomText using a Magnifier serial number, the software will convert to a ZoomText Magnifier product - i.e. all screen reading features will be disabled. To regain the use of the screen reading features, you must purchase a Magnifier/Reader serial number and reactivate ZoomText.

Activating ZoomText on more than one computer

With single-user versions of ZoomText, you can install and activate ZoomText on up to three computers (in accordance with the ZoomText Software License Agreement). Multiple activations are provided to accommodate individuals that use more than one computer, such as a home computer, a work computer and a laptop computer. While ZoomText may be installed on up to three computers, use of the collective installations is restricted to one user at any given time.

Note: Multi-user standalone versions of ZoomText provide one activation per licensed user.
Transferring Your ZoomText Software License

Should you want to move your ZoomText software to a new computer, or need to reformat the hard drive on your current computer, it is important that you first transfer your software license back to the ZoomText activation server. This preserves your license so that it may be used to activate your new installation of ZoomText.

To transfer your ZoomText software license, from the ZoomText menu bar, select Help ▶ Transfer Software License... This action will launch the ZoomText Activation Wizard and guide you through the transfer process. This process will deactivate ZoomText on your current computer so that it can be reactivated on the new computer.
Frequently Asked Questions About Product Activation

- **What is product activation?**
  Product activation is an anti-piracy technology designed to verify that ZoomText has been legitimately licensed.

- **How does product activation work?**
  The activation process verifies that the serial number is legitimate and has not been activated on more computers than allowed by the ZoomText Software License Agreement.

- **What happens if I don’t activate my product?**
  If you don’t activate your product by the 60th day (after installation), ZoomText will stop working until you activate it.

- **What if my product activation fails?**
  Product activation will only fail under exceptional circumstances. In most cases, you can reactivate ZoomText as quickly and easily as the original activation. If your attempt to reactivate fails, contact Ai Squared Product Support for help.

- **What if I need to reformat or upgrade my computer?**
  If you need to reformat your hard drive or upgrade your Windows operating system, you should first transfer your ZoomText software license back to the ZoomText activation server. See "Transferring Your ZoomText Software License" in the preceding section.

**Note:** You do not need to transfer your ZoomText license when installing Windows service packs and hot fixes.
What if I want to move my ZoomText software to another computer?
Should you want to move your ZoomText software to a new computer, it is important that you first transfer your software license back to the ZoomText activation server. This preserves your software license so that it may be used to activate your new installation of ZoomText. See "Transferring Your ZoomText Software License" in the preceding section.
Registering ZoomText 9.1

To ensure that you get the most out of ZoomText and to protect your product license, Ai Squared recommends that you promptly register ZoomText immediately after completing the product installation. By registering ZoomText you are eligible for technical support, low-cost upgrades, and cost-saving support plans. You’ll also receive our email newsletter, providing information about new product releases, special offers, and helpful ZoomText tips and tricks.

And don’t worry, when registering with Ai Squared your personal information is always held in the strictest confidence. Ai Squared does not share customer information with other organizations, so you don’t have to worry about unwanted solicitations from 3rd parties.

There are three ways to register your ZoomText product:
• **Register ZoomText online (recommended)**
  Registering ZoomText online is quick and easy. Just create or login to your Ai Squared customer account and select ‘Register your product’.

  With your Ai Squared customer account you can log in 24 hours a day to update your account information, view your Ai Squared orders, and retrieve your ZoomText product serial number. This is a real convenience when you need to activate your product and don’t have your serial number on-hand.

  To initiate the online registration process, do one of the following:
  
  • In the ZoomText Activation Wizard, select the **Register online now** link (in the final wizard dialog).
  
  • In ZoomText’s Help menu, select **Register ZoomText**…
  
  • In your web browser, go to www.aisquared.com/register

• **Mail in the ZoomText registration card**  A large-print ZoomText registration card is included with every ZoomText product. Just fill-in the card, attach the required postage and drop it in the mail.

• **Phone in your registration**  If you prefer, you can call Ai Squared to register your product – Monday through Friday, 9am to 5pm Eastern Time.
  
  • Inside of North America 1 (800) 859-0270
  
  • Outside of North America ++1 (802) 362-3612.
The ZoomText User Interface

When you start ZoomText its user interface appears on the screen. This window contains all of the controls for operating ZoomText. All of ZoomText’s settings can be accessed through standard menus or easy-to-use toolbars. Each toolbar features a set of buttons that provide fast access to the most important and frequently used settings. Each button contains an intuitive icon and label for easy identification. Buttons are grouped by function and each group is labeled with a clickable link that opens the group’s associated dialog box (with the exception of the Finders label).

Note: Features associated with magnification and screen reading are grouped into separate toolbars and dialogs. Features associated with screen reading only appear in ZoomText Magnifier/Reader.
**ZoomText button** Enables or disables ZoomText. When disabled, all magnification and speech features are turned off without exiting the program.

**Magnifier tab** Displays toolbar controls for ZoomText's magnification features.

**Reader tab** Displays toolbar controls for ZoomText's screen reading features. *(ZoomText Magnifier/Reader only)*

**Help tool** Displays help information about the clicked-on item.

**Status bar** Displays the name of the active application and informs you when AppReader and DocReader ("Readers"), reading zones ("Zones") and application settings ("App Settings") are available for use.

**Minimize button** Hides the ZoomText user interface.
Minimizing and Restoring the User Interface

The ZoomText user interface can be minimized (hidden) and restored (made visible) without affecting the operation of ZoomText.

▶ To minimize ZoomText

Do one of the following:

- On the ZoomText title bar, click on the minimize button.
- While the ZoomText user interface is active, press ESC.

▶ To restore ZoomText

Do one of the following:

- Click on the ZoomText 9.1 button in the task bar.
- Press the Display User Interface hotkey: CTRL + SHIFT + U.

Note: If the ZoomText user interface is already open but covered by other applications, restoring it will bring it into view.
Enabling and Disabling ZoomText

You can enable and disable ZoomText at any time, without exiting the program. When disabled, ZoomText returns the screen to its normal (unmagnified) state and all speech output is suspended.

▶ To enable ZoomText

On the ZoomText user interface, select the ZoomText button.

Hotkey: ALT + INSERT

▶ To disable ZoomText

On the ZoomText user interface, select the ZoomText button.

Hotkey: ALT + DELETE
Using the Tray Icon

When ZoomText is running, its program icon appears in the system tray (next to the clock). Clicking on the tray icon will pop up menus that contain important ZoomText settings.

By left-clicking the tray icon, you can perform the following:

- Enable and disable ZoomText
- Adjust the magnification level
- Start AppReader or DocReader (ZoomText Magnifier/Reader only)

By right-clicking the tray icon, you can perform the following:

- Restore and minimize ZoomText
- Exit ZoomText
Using Tools with the Keyboard

ZoomText's Adjust, Freeze and SpeakIt tools allow you to click and drag to select screen areas associated with their respective features. Although these tools were designed for easy use with a mouse, they can also be operated using keyboard commands that simulate mouse actions. When these tools are active, you can control them using the keyboard commands from the following table.

<table>
<thead>
<tr>
<th>Mouse Action</th>
<th>Keyboard Command</th>
</tr>
</thead>
<tbody>
<tr>
<td>Move the pointer</td>
<td>UP, DOWN, LEFT, RIGHT</td>
</tr>
<tr>
<td>Left-click</td>
<td>ENTER</td>
</tr>
<tr>
<td>Right-click</td>
<td>ESC</td>
</tr>
<tr>
<td>Drag object right</td>
<td>SHIFT + RIGHT</td>
</tr>
<tr>
<td>Drag object left</td>
<td>SHIFT + LEFT</td>
</tr>
<tr>
<td>Drag object up</td>
<td>SHIFT + UP</td>
</tr>
<tr>
<td>Drag object down</td>
<td>SHIFT + DOWN</td>
</tr>
</tbody>
</table>
Exiting ZoomText

You can exit the ZoomText program at any time. When ZoomText is exited, the screen returns to its normal (unmagnified) state and all speech output is terminated.

To exit ZoomText

Do one of the following:

- In the **File** menu, choose **Exit**.
- In the ZoomText title bar, click the close box.
Uninstalling ZoomText

If you no longer need ZoomText on your system, you can uninstall it at any time. Uninstalling ZoomText erases all its program files and returns your system to the state it was in before installing.

Before you uninstall ZoomText, you should be aware of the following:

- If you are running ZoomText in its 60-day trial period, uninstalling the software will result in loss of all remaining trial days. Reinstalling ZoomText will not restore the trial days.

- If your installation of ZoomText has been activated, you should transfer your software license back to the ZoomText activation server before uninstalling. This will preserve your software license so that may be used to activate ZoomText on another system. For more information, see "Transferring Your ZoomText Software License" in this chapter.

To uninstall ZoomText

1. In the Windows Start menu, choose Programs ▶ ZoomText 9.1 ▶ Uninstall ZoomText 9.1.

2. Follow the on-screen instructions.

The ZoomText Uninstall program starts.
Windows Vista Logon Support

ZoomText’s logon support provides essential magnification and screen reading features when logging into Windows Vista. You can zoom in and out (up to 36x), invert the screen colors, and enable screen reading so that each control is spoken as you navigate the logon dialog box.

Note: ZoomText’s xFont text magnification is not available during Windows Vista logon; therefore the quality of magnified text will be degraded. ZoomText will also use the default speech synthesizer configured in Windows.

The ZoomText Logon Support Toolbar

When ZoomText’s logon support is enabled, the ZoomText Logon Support toolbar appears automatically each time the Windows Vista logon screen is displayed. The Logon Support toolbar provides controls for enabling, disabling and adjusting the available magnification and screen reading features.
**ZoomText button**  Enables or disables ZoomText. When ZoomText is disabled, all magnification and screen reading features are turned off without exiting the program.

Hotkeys:
Enable ZoomText: **ALT + INSERT**
Disable ZoomText: **ALT + DELETE**

**Power**  Sets the magnification level from 1x to 36x.

Hotkeys:
Increases magnification: **ALT + NUMPAD PLUS**
Decreases magnification: **ALT + NUMPAD MINUS**

**Invert**  Enables and disables color inverting.

Hotkey: **CTRL + SHIFT + C**

**Speech**  Enables and disables speech output.

Hotkey: **ALT + SHIFT + S**

**Note:**  Each time you log into Windows Vista using ZoomText’s logon support, the selected logon support settings are automatically saved and then restored the next time the Windows logon screen is displayed.
Enabling and Disabling ZoomText’s Logon Support

Enabling and disabling ZoomText’s logon support is performed in ZoomText’s Program Preferences dialog box. When ZoomText’s logon support is enabled, it is available to all users in the Windows Vista logon screen.

▶ To enable ZoomText’s logon support

1. In ZoomText’s Settings menu, choose Program…
   
   The Preferences dialog appears with the Program tab displayed.

2. Make sure the Enable ZoomText’s logon support for Windows Vista box is checked.
   
   Note: You must be logged in with administrative privileges to adjust this option. If you are not logged in with administrative privileges this option will be grayed out.

3. Select the OK button.
Windows Vista User Account Control

One of the important new security features in Windows Vista is “User Account Control”, referred to as UAC for short. UAC is designed to prevent malicious programs from damaging files, changing system configurations, and even transmitting confidential data outside the system. To accomplish this task, UAC forces all of your applications to run as a standard user, even if you are logged in with administrative privileges. As a result, when you run a program that requires administrative privileges, a UAC prompt appears requesting your permission.

With the Windows UAC feature, many legitimate program processes will generate a UAC prompt, even for common tasks such as changing the clock’s time or installing a new printer driver. UAC prompts may also appear when adjusting or using the following ZoomText features, all of which are completely safe to run on your system:

- Running the Activation Wizard
- Running the ZoomText updates wizard
- Transferring your ZoomText software license
- Downloading and installing program components
- Using certain Fix-It commands (in the Support dialog)
- Changing ZoomText’s program or user interface preferences
For more information on User Account Control, refer to the Windows Vista Help system. If you have questions or concerns about ZoomText that generate a UAC prompt, please contact Ai Squared’s Product Support department.
Getting Help

ZoomText provides the following documentation and tools to help you learn and work with the program:

- **ZoomText 9.1 User's Guide**  Contains complete information on using all ZoomText features and commands.

- **ZoomText 9.1 Quick Reference Guide**  Provides concise, user-friendly instructions for each of ZoomText's essential features.

- **ZoomText 9.1 Online Help**  Contains all of the information in the ZoomText 9.1 User's Guide, optimized for use online. You can access complete documentation directly from the user interface and find topics using the Contents, Index, and Search tabs.

- **ZoomText Help Tool**  Displays pop-up descriptions for clicked-on items in the ZoomText toolbars.

- **What's This? Help Tool**  Displays pop-up descriptions for clicked-on items in all ZoomText dialog boxes.
To use ZoomText Online Help
1. In the Help menu, choose ZoomText Help.
2. In the Help window, click one of the following tabs:
   - Contents  Lets you choose a topic from a section of the online Help.
   - Index  Lets you use the index to find a topic.
   - Search  Lets you find a topic by searching for a particular word or phrase in the online Help.

Note: Each ZoomText dialog box also contains a Help button that, when selected, displays context-sensitive Help for that dialog.

To use the ZoomText Help tool
1. On the ZoomText user interface, select the ZoomText Help tool.
   The Help Tool becomes active.
2. Move the pointer over a toolbar item.
3. Click to display a pop-up description for the item.
4. To exit the Help tool, right click or press ESC.

To use the What's This? Help tool
1. While in any ZoomText dialog, select the What's This? Help tool (located in the title bar).
   The What’s This? tool becomes active.
2. Move the pointer over a dialog item.
3. Click to display a pop-up description of the item.
This chapter describes ZoomText's magnification features. These features are included in ZoomText Magnifier and ZoomText Magnifier/Reader.

The Magnifier Toolbar

The Magnifier toolbar provides quick access to ZoomText's magnification features. Each toolbar button has an intuitive icon and label for easy identification. Many of these buttons have pop-up menus that provide fast access to the most important and frequently used settings. Related buttons are grouped together and the group is labeled with a clickable link that opens their associated dialog box.
**Power**  Sets the magnification level from 1x to 36x.

**Type**  Sets the zoom window type: Full, Overlay, Lens, Line or one of four Docked types. Each of these windows offers a unique way of viewing what is on the screen, accommodating different tasks and application environments.

**Color**  Selects color enhancement settings. Color enhancements improve screen clarity for easier viewing and reduced eyestrain. You can choose from a variety of preset color schemes or configure your own custom color settings.

**Pointer**  Selects mouse pointer enhancement settings. Pointer enhancements make it easy to locate and follow the mouse pointer. You can choose from a variety of preset pointer enhancement schemes or configure your own custom pointer enhancements.

**Cursor**  Selects cursor enhancement settings. Cursor enhancements make it easy to locate and follow the text cursor. You can choose from a variety of preset cursor enhancement schemes or configure your own custom cursor enhancements.

**Focus**  Selects focus enhancement settings. Focus enhancements make it easy to locate and follow the control focus when you tab and arrow key through menus, dialogs and other application controls. You can choose from a variety of preset focus enhancement schemes or configure your own custom focus enhancements.
Desktop  Activates the Desktop Finder. The Desktop Finder helps you find and launch programs on the desktop, system tray and quick launch bar. In addition, the Desktop Finder also helps you find and open items in the Control Panel, Programs menu and My Documents folder.

Web  Activates the Web Finder. The Web Finder helps you find links and controls in any web page.

Text  Activates the Text Finder. The Text Finder helps you locate words or phrases within the active application window or anywhere on the entire screen.
Setting the Magnification Level

ZoomText provides a wide range of magnification levels, allowing you to enlarge the view according to your needs. Magnification levels include: 1x to 8x in steps of 1, 10x to 16x in steps of 2, 20x to 36x in steps of 4, and fractional powers of 1.25x, 1.5x, 1.75x and 2.5x.

To adjust the magnification level

On the Magnifier toolbar, adjust the level in the Power spinbox.

Hotkeys: Increase Magnification: ALT + NUMPAD PLUS
Decrease Magnification: ALT + NUMPAD MINUS

The magnification level can also be adjusted in the Zoom Windows dialog, as follows:

1. In the Magnifier menu, choose Magnification...

   The Zoom Windows dialog appears with the Magnification tab displayed.

2. Adjust the level in the Power spinbox.

3. Click the OK button.
The following table describes the Magnification Level settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Power</td>
<td>Sets the magnification level. Magnification levels include: 1x to 8x in steps of 1, 10x to 16x in steps of 2, 20x to 36x in steps of 4, and fractional powers of 1.25x, 1.5x, 1.75x and 2.5x.</td>
</tr>
<tr>
<td>Display whole powers only</td>
<td>Excludes fractional magnification levels from the Power spinbox.</td>
</tr>
</tbody>
</table>
Mouse Wheel Zooming

If your mouse has a wheel, it can be used to zoom-in and zoom-out over the mouse pointer position. Turning the wheel away from you will increase magnification, while turning the wheel towards you will decrease it.

Since the mouse wheel is used to scroll documents in some programs, ZoomText uses a modifier key to share the wheel with other programs. By default the modifier key is **CTRL**, which means that you must hold down the **CTRL** key while turning the wheel. Turning the wheel without the modifier key will allow the mouse wheel to perform its normal function.

You can turn off all modifier keys allowing ZoomText to use the mouse wheel without a key, but if you do so the normal mouse wheel functions will no longer operate in other applications.

**To enable and configure mouse wheel zooming**

1. In the **Magnifier** menu, choose **Magnification**...

   The Zoom Window dialog appears with the Magnification tab displayed.

2. Make sure the **Enable wheel zooming** box is checked.

3. Select the modifier key (or keys) that must be pressed in order for the mouse wheel to be used for zooming.

4. Click the **OK** button.
Magnification tab

The following table describes the Mouse Wheel Zooming settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable wheel zooming</td>
<td>Enables use of the mouse wheel to change the magnification level.</td>
</tr>
<tr>
<td>Modifier Keys</td>
<td>Selects the key combination to be used for mouse wheel zooming. The selected keys must be held down while rotating the mouse wheel in order to change the magnification level.</td>
</tr>
</tbody>
</table>
Zoom Windows

A zoom window displays a magnified view of the computer screen. You can think of a zoom window as a magnifying glass held in front of the screen. A zoom window can only display a portion of the screen at any one time, but by scrolling its magnified contents, any area of the screen can be viewed.

ZoomText provides eight zoom window types: Full, Overlay, Lens, Line and four Docked positions. Each of these windows offer a unique way of viewing what is on the screen. At any time, you can switch zoom window types to accommodate a different task or application environment.
Selecting a Zoom Window

You can select a different zoom window at any time while ZoomText is active.

▶ To select a zoom window

On the Magnifier toolbar, select Type, and then select the desired zoom window.

Hotkey:  **CTRL + SHIFT + Z**
Cycles through the zoom window types.

A zoom window type can also be selected in the Zoom Windows dialog, as follows:

1. In the Magnifier menu, choose **Zoom Window**...

   *The Zoom Windows dialog appears with the Window tab displayed.*

2. Select the desired zoom window type.

3. Click the **OK** button.
### Window tab

The following table describes the Window Type settings.

<table>
<thead>
<tr>
<th>Window Type</th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Docked Top</td>
<td>Docked Bottom</td>
</tr>
<tr>
<td>Overlay</td>
<td>Docked Bottom</td>
<td>Docked Left</td>
</tr>
<tr>
<td>Lens</td>
<td>Docked Left</td>
<td>Docked Right</td>
</tr>
<tr>
<td>Line</td>
<td>Set Line window height to cursor height</td>
<td></td>
</tr>
</tbody>
</table>

**ZoomText Dual Monitor Support**

- **Enable Dual Monitor**
  - Primary Span
  - Primary Clone
  - Primary with 1x
  - Advanced...
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>Displays a zoom window that occupies the entire screen.</td>
</tr>
<tr>
<td>Overlay</td>
<td>Displays a zoom window that lies on top of the normal screen and can be sized and moved to occupy any area.</td>
</tr>
<tr>
<td>Lens</td>
<td>Displays a zoom window that moves over the normal screen like a magnifying glass, displaying what is directly beneath it. The lens automatically follows as you move the mouse pointer, type text and navigate through your programs.</td>
</tr>
<tr>
<td>Line</td>
<td>Displays a zoom window that moves up and down the screen like a magnifying ruler, displaying what is directly beneath it. The line automatically follows as you move the mouse pointer, type text and navigate through your programs.</td>
</tr>
<tr>
<td>Docked Top</td>
<td>Displays a zoom window that occupies the top half of the screen. The height of the zoom window can be adjusted to occupy a larger or smaller portion of the screen.</td>
</tr>
</tbody>
</table>

(Continued)
### Docked Bottom
Displays a zoom window that occupies the bottom half of the screen. The height of the zoom window can be adjusted to occupy a larger or smaller portion of the screen.

### Docked Left
Displays a zoom window that occupies the left side of the screen. The width of the zoom window can be adjusted to occupy a larger or smaller portion of the screen.

### Docked Right
Displays a zoom window that occupies the right half of the screen. The width of the zoom window can be adjusted to occupy a larger or smaller portion of the screen.

### Set Line window height to cursor height
As the text cursor moves through larger or smaller text, the height of the Line window increases or decreases, so that only the current line of text is displayed.

For information on adjusting zoom windows, see "Adjusting a Zoom Window" in this chapter.
Adjusting a Zoom Window

ZoomText's windows can be sized and/or moved to occupy a different portion of the screen (with the exception of Full zoom). The following table outlines the size/move characteristics for each zoom window type.

<table>
<thead>
<tr>
<th>Window Type</th>
<th>Sizeable</th>
<th>Moveable</th>
</tr>
</thead>
<tbody>
<tr>
<td>Full</td>
<td>no</td>
<td>no</td>
</tr>
<tr>
<td>Overlay</td>
<td>yes</td>
<td>yes</td>
</tr>
<tr>
<td>Lens</td>
<td>yes</td>
<td>automatic</td>
</tr>
<tr>
<td>Line</td>
<td>yes</td>
<td>automatic</td>
</tr>
<tr>
<td>Docked</td>
<td>yes</td>
<td>no</td>
</tr>
<tr>
<td>Freeze</td>
<td>yes</td>
<td>yes</td>
</tr>
</tbody>
</table>
To size and move a zoom window

1. On the **Magnifier toolbar**, choose **Type ▶ Adjust**.
   
   *The Adjust tool becomes active and sizing handles appear on the zoom window frame.*
   
   **Hotkey:** `CTRL + SHIFT + A`

2. To size the window, drag any handle.
3. To move the window, drag inside the window frame.
4. To scroll the contents of the window, hold down **CTRL**, and then drag inside the window frame.
5. To exit the Adjust tool, right-click or press **ESC**.
The Freeze Window

In a magnified view, it is impossible to see the entire screen at once. As a result, you may not be able to view multiple items of interest at the same time, such as information located at opposite edges of the screen. The Freeze window solves this problem by allowing you to monitor a selected area of the screen, while you simultaneously view and work in other areas of the screen. Here’s how it works...

Using the Freeze tool, you select an area of the screen that you want to monitor. When you’ve completed your selection, the Freeze window automatically appears on top of the Full zoom window displaying the selected area. The Full zoom window continues to operate normally, tracking all on-screen activity and allowing you to navigate and work in all areas of the screen.
To set up a Freeze window

1. Set the zoom window type to **Full**.

2. On the **Magnifier** toolbar, select **Type > Freeze > New**.

   *The Freeze tool becomes active.*

   **Hotkey:** **CTRL + SHIFT + N**

3. Move the mouse pointer until the area you want to freeze is scrolled into view.

4. Hold down the left button, drag to selection rectangle around the desired freeze area and release the button.

   *When you complete the drag, the Freeze window will appear with sizing handles on the frame.*

5. To size the window, drag any handle. To move the window, drag inside the window frame. To scroll the contents of the window, hold down **CTRL** and drag inside the window frame.

6. To exit the Freeze tool, right click or press **ESC**.

**Note:** The Freeze window can be resized or moved using the Adjust tool.
To enable and disable the Freeze window

On the Magnifier toolbar, choose Type ▶ Freeze ▶ Enable (or Type ▶ Freeze ▶ Disable).

Hotkey: CTRL + SHIFT + E

To adjust the Freeze window options

1. In the Magnifier menu, choose Freeze Window...

   The Zoom Windows dialog appears with the Freeze tab displayed.

2. Adjust the freeze window options as desired.

3. Click the OK button.
The following table describes the Freeze window settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable freeze window</td>
<td>Enables the Freeze window (when the zoom window type is set to Full).</td>
</tr>
<tr>
<td>Use full zoom magnification level</td>
<td>Sets the Freeze window to use the same magnification level as the Full zoom window.</td>
</tr>
<tr>
<td>Use the magnification level below</td>
<td>Allows the Freeze window to use its own magnification level (set using the Power spinbox).</td>
</tr>
<tr>
<td>Power</td>
<td>Sets the Freeze window’s magnification level. Magnification levels include: 1x to 8x in steps of 1, 10x to 16x in steps of 2, 20x to 36x in steps of 4x, and fractional powers of 1.25x, 1.5x, 1.75x and 2.5x.</td>
</tr>
<tr>
<td>New Freeze Window</td>
<td>Activates the Freeze Tool.</td>
</tr>
</tbody>
</table>
Using View Mode and the View Locator

View mode shows you the area of the screen that is currently being magnified and allows you to select a new area to zoom in on. When view mode is activated, magnification turns off and the view locator appears in the normal screen. By moving the view locator, you can select a new area to zoom in on.

▸ To use View Mode

1. In the Actions menu, choose View Mode.

   Magnification is temporarily turned off and the view locator appears.

   Hotkey: CTRL + SHIFT + V

2. Move the view locator to the desired screen location.

3. Click to zoom-in on the new location.

   Magnification is restored with the selected screen area displayed.

You can configure the view locator to appear in a variety of shapes and colors. The view locator can also be enabled to appear in normal (unmagnified) portions of the screen when using Overlay or Docked zoom windows.
To enable and configure the view locator

1. In the Magnifier menu, choose View Locator...

   The Zoom Window dialog appears with the View Locator tab displayed.

2. Make sure the Enable view locator box is checked.

3. Adjust the locator options as desired.

4. Click the OK button.

**Note:** The view locator can be enabled and disabled using the Locator command: **CTRL + SHIFT + L**.

The following table describes the View Locator settings.
<table>
<thead>
<tr>
<th><strong>Setting</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable view locator</td>
<td>Enables the display of the view locator.</td>
</tr>
<tr>
<td>Locator Type</td>
<td>Selects the type of view locator that is displayed: Block, Inverted Block, Frame or Cross.</td>
</tr>
<tr>
<td>Color</td>
<td>Selects the color that the view locator will appear in.</td>
</tr>
<tr>
<td>Transparency</td>
<td>Sets the level of transparency for the view locator. The transparency level controls the amount of the desktop image that is visible through the view locator.</td>
</tr>
<tr>
<td>Blink view locator</td>
<td>Turns locator blinking on or off.</td>
</tr>
<tr>
<td>Blink Rate</td>
<td>Sets the blink rate for the view locator in seconds (from .5 to 5, in increments of .5).</td>
</tr>
</tbody>
</table>
Dual Monitor Support

When using a computer equipped with two monitors, ZoomText's Dual Monitor Support allows you to use the primary and secondary monitors to double the width of the magnified view (Primary Span), duplicate the magnified view (Primary Clone), or simultaneously see a magnified and unmagnified view of the screen (Primary with 1x). ZoomText's dual monitor views are designed to enhance productivity and comfort for individual users (working alone) or a group of users (low vision and normal sighted) that are working together on the same system.
**Primary Span** extends ZoomText's magnified view across the primary and secondary monitors, doubling the amount of information that can be seen at any time. With twice as much information in view you can work with greater speed and comfort than is possible when using a single monitor.

**Primary Clone** displays the same magnified view on your primary and secondary monitors. This mode is useful when two or more users need to see the same magnified view, but are not seated so that they can share a single monitor.

**Primary with 1x** displays a magnified view on your primary monitor and an unmagnified view on your secondary monitor. This mode is useful when a low-vision user and normal-sighted user are working together on the same system. The low-vision user can zoom-in to the desired level (on the primary monitor) while the normal-sighted user sees the unmagnified view on the secondary monitor.
Dual Monitor System Requirements

To use ZoomText's Dual Monitor Support your system must have the following hardware and software:

• Windows Vista or Windows XP
• A desktop or laptop computer with a dual-head video card or two video cards
• Two computer monitors (any combination of CRT or LCD)

Note: For best viewing in Primary Span view, we recommend using a matched set of LCD monitors (size wise) that are positioned immediately side by side. This configuration provides a magnified view that's seamless and aligned.
Required Display Settings

In addition to the system requirements for using ZoomText's dual monitor feature, the Windows display settings for your primary and secondary monitors must be configured as follows:

- The extended desktop option must be enabled.
- The screen resolution and color quality must be set to equal values.
- The physical arrangement of your primary and secondary monitors must be horizontally aligned.

In Windows XP, ZoomText will automatically adjust these settings for you when you enable the dual monitor feature. In Windows Vista you must manually enable the extended desktop, as follows:

1. Select Start ► Control Panel ► Appearance and Personalization ► Adjust Screen Resolution. 
   
   The Display Properties dialog appears.

2. Select the Settings tab.

3. Click on the box labeled '2', then click Extend my Windows desktop onto this monitor.

4. Click the OK button.
Using ZoomText's Dual Monitor Support

The first time you start ZoomText, it will automatically detect the presence of two monitors on your system and ask if you want to enable the dual monitor feature. If you choose 'Yes', ZoomText will enable the dual monitor feature in Primary Span view (default). However, you can enable and disable the dual monitor feature or select a different dual monitor view at any time.

▸ To enable and disable the dual monitor feature
  • On the Magnifier toolbar, select Type ▶ Dual Monitor ▶ Enable (or Disable).

  Hotkey: WINDOWS + SHIFT + D

▸ To select a dual monitor view
  • On the Magnifier toolbar, select Type ▶ Dual Monitor, and then select the desired dual monitor view – Primary Span, Primary Clone, or Primary with 1x.

  Hotkey: WINDOWS + SHIFT + Z
  Cycle through the dual monitor views.
A dual monitor view can also be selected in the Zoom Windows dialog, as follows:

1. In the **Magnifier** menu, choose **Zoom Windows**…

   *The Zoom Windows dialog appears with the Window tab displayed.*

2. Adjust the dual monitor options as desired.

3. Click the **OK** button.

*Window tab*

The following table describes the Dual Monitor Support settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable Dual Monitor</td>
<td>Enables ZoomText's dual monitor support.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> When you enable Dual Monitor Support any applications located on the extended desktop are moved to the primary desktop.</td>
</tr>
<tr>
<td></td>
<td>When you disable Dual Monitor Support your extended desktop is re-enabled. Applications can then be moved back onto the extended desktop.</td>
</tr>
<tr>
<td>Primary Span</td>
<td>Primary Span displays a Full magnified view of your primary desktop that spans across the primary and secondary monitors. This mode doubles the width of your magnified view. With twice as much area in view scrolling is reduced and productivity is increased.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Mode</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Primary Clone</td>
<td>Primary Clone displays a magnified view of your primary desktop on both the primary and secondary monitors. This mode is useful when two or more users need to see the same magnified view, but are not seated so that they can share a single monitor.</td>
</tr>
<tr>
<td>Primary with 1x</td>
<td>Primary with 1x displays a magnified view of your primary desktop on the primary monitor and a 1x view of your primary desktop on your secondary monitor. This mode is useful when a low-vision user and normal-sighted user are working together on the same system. The low-vision user can zoom-in and out as needed on the magnified screen while the normal-sighted user views the unmagnified (1x) screen.</td>
</tr>
<tr>
<td>Advanced</td>
<td>Displays settings for identifying and selecting a secondary display device and allows you to open and adjust settings in the Windows Display Properties dialog (sometimes used to resolve compatibility issues).</td>
</tr>
</tbody>
</table>
Advanced Dual Monitor Settings

ZoomText's Advanced Dual Monitor Settings allow you to select a display device to use for your secondary screen (on systems configured with three or more display devices), and provides quick access to the Windows display properties settings.

To access the Advanced Dual Monitor Settings

- In the Window tab of the Zoom Windows dialog, select Advanced.

The following table describes the Advanced Dual Monitor Settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>View Windows' Display Properties Settings</td>
<td>Opens the Windows Display Properties Settings dialog box.</td>
</tr>
<tr>
<td>Display Device</td>
<td>Displays a list of display devices that can be used by ZoomText for the secondary monitor.</td>
</tr>
<tr>
<td>Identify</td>
<td>Identifies the secondary monitors on your system. On systems configured with two monitors, a large 'Z' is displayed on the secondary monitor. On systems configured with three or more monitors, an identifying number appears on each of the secondary monitors (e.g. 1, 2, 3).</td>
</tr>
</tbody>
</table>

**Using ZoomText with Dual Monitors Disabled**

When ZoomText's dual monitor support is disabled, ZoomText will magnify and speak applications and documents located on the primary desktop. You can move application windows onto the secondary desktop, but they will not be magnified or spoken.
Primary Monitor and Physical Arrangement

On a system configured with multiple monitors, Windows provides settings that allow you to select which monitor will be the primary monitor (that is where your Windows taskbar appears), and to tell Windows how your monitors are physically arranged in your workspace.

More about selection of the primary monitor

On a system configured with multiple monitors, Windows numbers each monitor device, as displayed in the Settings tab of the Display Properties dialog. By default, monitor 1 is configured as the primary display with monitor 2 configured as the secondary display, and so on.

Although Windows normally sets monitor 1 as the primary display, on some systems you can select another numbered monitor to operate as the primary monitor. Whichever monitor you select as your primary monitor, ZoomText will use that monitor for its primary display.

More about physical arrangement of multiple monitors

By arranging the monitors in the Display Properties dialog as they are physically arranged on your desktop, Windows can properly configure the extended desktop so that you can intuitively move the mouse and application windows directly across from one monitor to another, as if it were one seamless screen.
When using ZoomText's Dual Monitor feature in Span View, it is important that your monitors are properly arranged in the Display Properties dialog, so that the two magnified screens line up to provide a seamless magnified view.

**Using the Dual Monitor Feature with Three or More Monitors**

When activating ZoomText's dual monitor feature on a system configured with three or more monitors, the following will occur:

- All application windows that are located on the secondary displays (monitor devices 2 and greater) will be moved to the primary screen.

- ZoomText will utilize the primary display and the secondary display selected in ZoomText's advanced dual monitor settings. To access the advanced settings, from the ZoomText menu bar, choose **Magnifier ➤ Zoom Windows... ➤ Advanced** (button).

- Additional display devices will display the Windows desktop wallpaper, but they cannot be accessed and used. That is, you cannot move the mouse or application windows into these areas.
Dual Monitor Troubleshooting

This Help topic's provides information for troubleshooting problems that can occur when using ZoomText's dual monitor feature.

ZoomText asked "Do you see a yellow 'Z' on your secondary monitor", but I did not see the 'Z'.

This problem can occur for the following reasons:

- You have a second monitor, but it is not properly attached to your computer, not connected to a power source, or not switched on. Check the connections for your second monitor and make sure it is switched on.
- Your system is configured with a video card (or cards) that support a secondary monitor, but you do not have a second monitor on your workstation. Attach a second monitor to your system or do not attempt to enable the dual monitor feature.

ZoomText asked "Do you see a yellow 'Z' on your secondary monitor". I saw the yellow 'Z' but when I clicked the 'Yes' button ZoomText displayed a message saying "ZoomText was unable to activate the dual monitor feature..."

This problem occurs for the following reason:
• ZoomText was unable to adjust the primary and secondary display settings so that they have matching screen resolutions and color quality. Note: Matched settings are required. You must manually adjust these settings so that they have matched values.

To adjust the screen resolutions and color quality for your primary and secondary monitors:

1. **In Windows Vista:**
   Select Start ▶ Control Panel ▶ Appearance and Personalization ▶ Adjust Screen Resolution.
   
   In Windows XP:
   Select Start ▶ Control Panel ▶ Display ▶ Settings (tab).

   *The Windows display settings appear.*

2. Click on the display box labeled '1' (or the number that represents your primary monitor), and then select the desired Screen Resolution and Color Quality.

3. Click on the display box labeled '2' (or the number that represents your secondary monitor), and then select the same Screen Resolution and Color Quality that you chose for '1'. If you cannot select equal values, repeat steps 3 and 4 choosing a lower resolution or color quality.

4. Click the OK button.
ZoomText asked "Please select the number displayed on your secondary monitor", but you didn’t see a number on the monitor you want to use.

This problem can occur for the following reasons:

- You have a second monitor, but it is not properly attached to your computer, not connected to a power source, or not switched on. Check the connections for your second monitor and make sure it is switched on.
- Your system is configured with a video card (or cards) that support a secondary monitor, but you do not have a second monitor on your workstation. Attach a second monitor to your system or do not attempt to enable the dual monitor feature.

**Note:** This problem can only occur on systems that are configured with three or more display devices.
In Windows Vista, ZoomText informs you that "The desktop must be manually extended in order to utilize the dual monitor feature. Extend the desktop and restart ZoomText."

To enable the extended desktop in Windows Vista:

1. Select Start ▶ Control Panel ▶ Appearance and Personalization ▶ Adjust Screen Resolution.
   
   *The display settings appear.*

2. Click on the box labeled '2' (or the number that represents your secondary monitor), and then click Extend my desktop onto this monitor.

3. Click the OK button.

Your system has three (or more) monitors and when the ZoomText dual monitor feature is enabled you cannot move the mouse pointer into the third monitor.

This is normal behavior. ZoomText's dual monitor feature only supports two monitors. When ZoomText’s dual monitor feature is enabled the third monitor cannot be accessed.
Your system has three (or more) monitors and when you attempted to activate ZoomText's dual monitor feature, ZoomText displayed a message saying "ZoomText was unable to activate the dual monitor feature..."

This error will occur if you have three or more active monitors and the primary monitor and selected secondary monitor are not positioned adjacently in the Display Properties dialog. To correct this problem, you must reposition the monitors as follows:

1. **In Windows Vista:**
   Select Start ▶ Control Panel ▶ Appearance and Personalization ▶ Adjust Screen Resolution.

   **In Windows XP:**
   Select Start ▶ Control Panel ▶ Display ▶ Settings (tab).

   The Windows display settings appear.

2. Drag the numbered box that represents your secondary monitor so that it is positioned next to the primary monitor.

3. Click the OK button.
When using Span View the left half of the magnified view is on the right and vice versa.

The position of your primary and secondary monitors must be switched in the Display Properties dialog, as follows:

1. **In Windows Vista:**
   Select Start ▶ Control Panel ▶ Appearance and Personalization ▶ Adjust Screen Resolution.

   **In Windows XP:**
   Select Start ▶ Control Panel ▶ Display ▶ Settings (tab).

   *The Windows display settings appear.*

2. Switch the positions of the boxes representing your primary and secondary monitors.

3. Click the OK button.
ZoomText only magnifies and scrolls across half of the desktop area.

This problem can occur for the following reasons:

- ZoomText's dual monitor feature is enabled and you are only looking at one of your monitors. The other half of the desktop area is displayed on the second monitor.
- ZoomText detected support for two monitors on your system and although you do not have a second monitor, you chose to enable the dual monitor support.
- You chose to activate dual monitor support while you had two monitors attached to your system, but you are now running your system with only one monitor. Note: ZoomText is not able to detect that the second monitor is no longer present.

To disable ZoomText's dual monitor support:

- On the Magnifier toolbar, select Type ▶ Dual Monitor ▶ Disable.
  
  You can also disable ZoomText's dual monitor feature using the Dual Monitor On/Off hotkey: **WINDOWS + SHIFT + D**.
Screen Enhancements

Screen enhancements improve the legibility of the screen. With these settings you can:

- Adjust screen colors for improved contrast and clarity.
- Modify the mouse pointer and text cursor, making them easier to see and follow.
- Apply focus enhancements, making it easy to see and follow the control focus.
- Apply font enhancements for sharp print-quality text that's easy to read at all magnification levels.

Color Enhancements

Color enhancements improve clarity of text and graphics, providing easier viewing and reduced eyestrain. The color enhancement options consist of a variety of filter effects that adjust color, contrast and brightness. You can choose from preset color schemes or configure your own custom color settings.

➢ To choose a preset color scheme

On the Magnifier toolbar, select Color ▶ Scheme, and then select the desired color scheme.

Note: You can turn color enhancements on and off using the Color Enhancements On/Off hotkey: CTRL + SHIFT + C.
To configure custom color settings

1. In the **Magnifier** menu, choose **Color Enhancements...**

   *The Enhancements dialog appears with the Color tab displayed.*

2. Select **Custom...**

3. Adjust the custom settings as desired.

4. Click the **OK** button.
The following table describes the Color Enhancement settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Disables all color enhancements.</td>
</tr>
<tr>
<td>Scheme:</td>
<td>Activates a preset color scheme (selected in the neighboring combo box).</td>
</tr>
<tr>
<td>Custom...</td>
<td>Activates the <strong>Custom Settings</strong>, allowing you to create your own custom color scheme.</td>
</tr>
<tr>
<td>Customize</td>
<td>Activates and configures the <strong>Custom Settings</strong> to match the selected preset color scheme. This allows you to use a preset scheme as the starting point for a custom scheme.</td>
</tr>
<tr>
<td>Effect</td>
<td>Selects the type of color effect and activates the associated settings.</td>
</tr>
<tr>
<td></td>
<td><strong>None</strong>  No filtering is applied.</td>
</tr>
<tr>
<td></td>
<td><strong>Black and White</strong>  Converts all screen colors to equivalent shades of gray.</td>
</tr>
<tr>
<td></td>
<td><strong>Reverse Video</strong>  Inverts all screen colors.</td>
</tr>
</tbody>
</table>

*(Continued)*
**Dyed**  Transforms all screen colors to a single hue while preserving their light and dark values. When the Dye effect is selected, a **Color** combo box appears, allowing you to select the dye color.

**Two-Color**  Transforms all screen colors to a two-color spectrum. When the Two-Color effect is selected, **Foreground Color** and **Background Color** combo boxes appear, allowing you to define the two-color spectrum.

**Replace Color**  Replaces one screen color with another. When the Replace Color effect is selected, **Replace** and **With** combo boxes appear, allowing you to choose the color to replace and the replacement color.

**Remove Color**  Removes a selected color from the screen. When the Remove Color effect is selected, a **Color to Remove** combo box appears allowing you to choose the color that you want to remove. A **Bandwidth** slider also appears, allowing you to expand the range of color removal to hues close to the selected color.

*(Continued)*
<table>
<thead>
<tr>
<th>Invert Brightness</th>
<th>Inverts the brightness of all screen colors. Light colors become dark and vice-versa.</th>
</tr>
</thead>
</table>
| Color Level           | Adjusts the amount of color saturation on the screen. At 0%, color is completely removed and the screen resembles black and white television. At 100%, colors are intensified.  
**Note:** This setting is only available when **Effect** is set to 'None'. |
| Bandwidth             | Increases the range of color replacement or color removal to include all shades of the selected color.  
**Note:** This setting is only available when **Effect** is set to 'Replace Color' or 'Remove Color'. |
<p>| Brightness            | Increases or decreases the brightness of the screen image from 0% to 100%. Normal brightness is 50%. |
| Contrast              | Increases or decreases the contrast of the screen image from 0% to 100%. Normal contrast is 50%. |
| Restore Normal Settings | Restores <strong>Brightness</strong> and <strong>Contrast</strong> to 50% (normal). |</p>
<table>
<thead>
<tr>
<th>Apply color enhancements to</th>
<th>Determines whether color enhancements are applied to the zoom window, background (normal screen) or both.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Preview</td>
<td>Displays the color spectrum as it will appear with the selected color enhancements.</td>
</tr>
</tbody>
</table>
**Pointer Enhancements**

Pointer enhancements make it easy to locate and follow the mouse pointer. You can adjust the size and color of the pointer and activate a locator that emphasizes the pointer's position on the screen. You can choose from preset pointer schemes or configure your own custom pointer settings.

▶ **To choose a preset pointer scheme**

On the **Magnifier** toolbar, select **Pointer ▶ Scheme**, and then select the desired pointer scheme.

**Note:** You can turn pointer enhancements on and off using the Pointer Enhancements On/Off hotkey: `CTRL + SHIFT + P`.

▶ **To configure custom pointer settings**

1. In the **Magnifier** menu, choose **Pointer Enhancements**...

   *The Enhancements dialog appears with the Pointer tab displayed.*

2. Select **Custom**...

3. Adjust the custom settings as desired.

4. Click the **OK** button.
The following table describes the Pointer Enhancement settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Disables all pointer enhancements.</td>
</tr>
<tr>
<td>Scheme</td>
<td>Enables a preset pointer scheme (selected in the neighboring combo box).</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th><strong>Custom...</strong></th>
<th>Activates the <strong>Custom Settings</strong>, allowing you to create your own custom pointer scheme.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Customize</strong></td>
<td>Activates and configures the <strong>Custom Settings</strong> to match the selected preset pointer scheme. This allows you to use a preset scheme as the starting point for a custom scheme.</td>
</tr>
<tr>
<td><strong>Size</strong></td>
<td>Sets the size of the enhanced mouse pointer to standard (1x), large (2x) or extra large (4x) sizes.</td>
</tr>
<tr>
<td><strong>Color (pointer)</strong></td>
<td>Sets the color for the mouse pointer.</td>
</tr>
</tbody>
</table>
| **Type**      | Selects the type of pointer locator:  
  **Circle** Displays a circle that is centered over the pointer's hot spot.  
  **Sonar** Displays animated circles that radiate inward toward the pointer's hot spot.  
  **Full Cross** Displays a set of crosshairs that extend across the entire zoom window and intersect the pointer's hot spot.  
  **Crosshairs** Displays a set of crosshairs that are centered over the pointer's hot spot. |

*(Continued)*
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Color (locator)</td>
<td>Sets the color for the pointer locator.</td>
</tr>
<tr>
<td>Thickness</td>
<td>Sets the thickness of the pointer locator: Thin, Medium or Thick.</td>
</tr>
<tr>
<td>Transparency</td>
<td>Sets the level of transparency for the pointer locator. The transparency level controls the amount of the desktop image that is visible through the pointer locator.</td>
</tr>
<tr>
<td>Always</td>
<td>The pointer locator is always displayed.</td>
</tr>
<tr>
<td>When pointer is stationary</td>
<td>The pointer locator is only displayed when the pointer is stationary (not moving).</td>
</tr>
<tr>
<td>When pointer is moving</td>
<td>The pointer locator is only displayed when the pointer is moving.</td>
</tr>
<tr>
<td>When modifier key is pressed</td>
<td>The pointer locator is only displayed when the pointer modifier keys are held down.</td>
</tr>
<tr>
<td>Modifier Keys</td>
<td>Selects a key or combination of keys that, when pressed, will display the pointer locator.</td>
</tr>
</tbody>
</table>

**Note:** The pointer locator must be set to **When modifier key is pressed**.
Cursor Enhancements

Cursor enhancements make it easy to locate and follow the text cursor. A choice of high visibility locators mark the cursor’s position, without obscuring the surrounding text. You can choose from preset cursor schemes or configure your own custom cursor settings.

▶ To choose a preset cursor scheme

On the Magnifier toolbar, select Cursor ▶ Scheme, and then select the desired cursor scheme.

**Note:** You can turn cursor enhancements on and off using the Cursor Enhancements On/Off hotkey: `CTRL + SHIFT + R`.

▶ To configure custom cursor settings

1. In the Magnifier menu, choose Cursor Enhancements...

   *The Enhancements dialog appears with the Cursor tab displayed.*

2. Select Custom...

3. Adjust the custom settings as desired.

4. Click the OK button.
The following table describes the Cursor Enhancement settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Disables all cursor enhancements.</td>
</tr>
<tr>
<td>Scheme</td>
<td>Activates a preset cursor scheme (selected in the neighboring combo box).</td>
</tr>
<tr>
<td>Custom...</td>
<td>Activates the Custom Settings, allowing you to create your own custom cursor scheme.</td>
</tr>
<tr>
<td>Customize</td>
<td>Activates and configures the Custom Settings to match the selected preset cursor scheme. This allows you to use a preset scheme as the starting point for a custom scheme.</td>
</tr>
<tr>
<td>Preview</td>
<td>When you click in the Preview box a text cursor appears with the selected cursor enhancement settings.</td>
</tr>
</tbody>
</table>
| Type       | Selects the type of cursor locator:  
  **Wedges** Displays triangular wedges above and below the cursor.  
  **Circle** Displays a circle around the cursor.  
  **Frame** Displays a rectangular frame around the cursor. |
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Size</td>
<td>Sets the size of the cursor locator: Thin, Medium or Thick.</td>
</tr>
<tr>
<td>Color</td>
<td>Sets the color for the cursor locator.</td>
</tr>
<tr>
<td>Transparency</td>
<td>Sets the level of transparency for the cursor locator. The transparency level controls the amount of the desktop image that is visible through the cursor locator.</td>
</tr>
<tr>
<td>Always</td>
<td>The cursor locator is always displayed.</td>
</tr>
<tr>
<td>When cursor is stationary</td>
<td>The cursor locator is only displayed when the cursor is stationary (not moving).</td>
</tr>
<tr>
<td>When cursor is moving</td>
<td>The cursor locator is only displayed when the cursor is moving.</td>
</tr>
<tr>
<td>When modifier key is pressed</td>
<td>The cursor locator is only displayed when the cursor modifier keys are held down.</td>
</tr>
<tr>
<td>Modifier Keys</td>
<td>Selects a key or combination of keys that, when pressed, will display the cursor locator.</td>
</tr>
</tbody>
</table>

**Note:** Display the cursor locator must be set to **When modifier key is pressed**.
Focus Enhancements

Focus enhancements make it easy to locate and follow the control focus when you tab and arrow key through menus, dialogs, toolbars, and other application controls.

When enabled, a choice of high visibility locators mark the position of the control with focus, without obscuring any surrounding text. You can choose from preset focus schemes or configure your own custom focus settings.

▶ To choose a preset focus scheme

On the Magnifier toolbar, select Focus ▶ Scheme, and then select the desired focus scheme.

Note: You can turn focus enhancements on and off using the Focus Enhancements On/Off hotkey: CTRL + SHIFT + O.

▶ To configure custom focus settings

1. In the Magnifier menu, choose Focus Enhancements...

   The Enhancements dialog appears with the Focus tab displayed.

2. Select Custom...

3. Adjust the custom settings as desired.

4. Click the OK button.
Focus tab

The following table describes the Focus Enhancement settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Normal</td>
<td>Disables all focus enhancements.</td>
</tr>
<tr>
<td>Scheme</td>
<td>Activates a preset focus scheme (selected in the neighboring combo box).</td>
</tr>
<tr>
<td>Custom...</td>
<td>Activates the <strong>Custom Settings</strong>, allowing you to create your own custom focus scheme.</td>
</tr>
<tr>
<td>Customize</td>
<td>Activates and configures the <strong>Custom Settings</strong> to match the selected preset focus scheme. This allows you to use a preset scheme as the starting point for a custom scheme.</td>
</tr>
<tr>
<td>Type</td>
<td>Selects the type of focus locator:</td>
</tr>
<tr>
<td></td>
<td><strong>Block</strong> Displays a block over the control that has focus.</td>
</tr>
<tr>
<td></td>
<td><strong>Underline</strong> Displays a line beneath the control that has focus.</td>
</tr>
<tr>
<td></td>
<td><strong>Frame</strong> Displays a rectangular around the control that has focus.</td>
</tr>
<tr>
<td>Color</td>
<td>Sets the color for the focus locator.</td>
</tr>
<tr>
<td>Thickness</td>
<td>Sets the thickness of the focus locator.</td>
</tr>
<tr>
<td>Feature</td>
<td>Description</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
</tbody>
</table>
| Transparency         | Sets the level of transparency for the focus locator. The transparency level controls the amount of the desktop image that is visible through the focus locator.  
**Note:** This setting is not available when the locator color is set to 'Invert'. |
| Margin               | Increases or decreases the space between the control with focus and the focus locator.                                                                 |
| Continuously         | Enables continuous display of the focus locator (when a control has focus).                                                                   |
| Briefly              | Enables brief display of the focus locator. When a control receives focus the locator is displayed for 1.5 seconds.                           |
| When modifier key is pressed | The focus locator is only displayed when the focus modifier keys are held down.                                                            |
| Modifier Keys        | Selects a key or combination of keys that, when pressed, will display the focus locator.                                                     
**Note:** Display the focus locator must be set to When modifier key is pressed. |
Font Enhancements

With conventional screen magnifiers, the clarity of fonts (text characters) is degraded in the magnified view. As a result, many fonts are difficult to read, including; small fonts, serif and italic fonts, and most cursive and ornate fonts. These problems are eliminated with ZoomText's new 'xFont' text enhancement technology (patented).

With xFont, all font types are magnified with perfect clarity – at all magnification levels. In addition, xFont options allow you to fine-tune text legibility by applying Smooth, Bold, and Condense options. The Smooth option sharpens the edges of text characters. Bold increases the thickness of text characters. Condense increases the spacing between characters and/or lines of text.

If your system is too slow to support xFont, you can switch to Standard font enhancements, which displays medium quality text with faster system performance.
▶ **To switch font enhancement types**

Press the Font Enhancements hotkey: **CTRL + SHIFT + F**. Repeated presses of this hotkey cycles through the three enhancement type settings: **xFont**, **Standard** and **None**.

**Note:** You can also set the font enhancement type in the Font Enhancement dialog.

▶ **To configure font enhancement options**

1. In the **Magnifier** menu, choose **Font Enhancements...**
   
   *The Enhancements dialog appears with the Font tab displayed.*

2. Adjust the Font enhancement options as desired.

3. Click the **OK** button.
Font tab

The following table describes the Font Enhancement settings.

<table>
<thead>
<tr>
<th>Enhancement Type</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xFont</td>
<td>Displays print-quality text in the magnified view (recommended setting). Use xFont Options to adjust xFont character attributes.</td>
</tr>
<tr>
<td>Standard</td>
<td></td>
</tr>
<tr>
<td>None</td>
<td></td>
</tr>
</tbody>
</table>

**xFont Options**

- Smooth edges
- Bold
- Condense by:
  - Width: 50%
  - Height: 0%

**Exclude Applications...**

**Sample Text:**

Font: **Tahoma**

1234567890!@#$%^&*()
abcdefghijklmnopqrstuvwxyz
ABCDEFGHIJKLMNOPQRSTUVWXYZ
The quick brown fox jumps over the lazy dog.
The quick brown fox jumps over...
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>xFont</td>
<td>Displays print quality text in the magnified view.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> xFont is the recommended and default font enhancement type.</td>
</tr>
<tr>
<td>Standard</td>
<td>Displays medium quality text in the magnified view. Use this setting when faster system performance is required.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> The Standard enhancement type is not applied when using fractional magnification levels.</td>
</tr>
<tr>
<td>None</td>
<td>Disables all smoothing of text and graphics. Use this setting when you want to view the magnified screen without any font enhancements.</td>
</tr>
<tr>
<td>Smooth edges *</td>
<td>Text character edges are smoothed.</td>
</tr>
<tr>
<td>Bold *</td>
<td>Text characters are bolded.</td>
</tr>
<tr>
<td>Condense by *</td>
<td>Each text character is condensed, increasing inter-character and line spacing.</td>
</tr>
<tr>
<td>Width *</td>
<td>Condenses the width of text characters from 0% (no condensing) to 100% (maximum condensing).</td>
</tr>
<tr>
<td><strong>Height</strong> *</td>
<td>Condenses the height of text characters from 0% (no condensing) to 100% (maximum condensing). *</td>
</tr>
<tr>
<td>--------------</td>
<td>--------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Exclude Applications...</strong> *</td>
<td>Displays settings for excluding the use of xFont in problem applications. See &quot;Excluding xFont in Problem Applications&quot; below.</td>
</tr>
<tr>
<td><strong>Font</strong> *</td>
<td>Displays a list of fonts available on your system. The selected font is displayed in the sample text box according to the selected enhancement type and xFont options.</td>
</tr>
</tbody>
</table>

* These settings only apply when using the xFont enhancement type.
Excluding xFont in Problem Applications

Some applications contain user-interface components that are not compatible with ZoomText's xFont feature, resulting in missing or corrupted text. When this occurs, you can exclude the use of xFont within the problem application by selecting (checking) the application’s name in the Exclude Applications dialog box.

Note: Applications that have known conflicts with xFont have been excluded in the default ZoomText configuration.

To exclude xFont in selected applications

1. In the Font Enhancements dialog, select Exclude Applications...

The Exclude Applications dialog appears.

2. In the Exclude xFont from listbox, check the applications in which you would like to exclude the use of xFont.

3. Click the OK button.
Exclude Applications dialog

The following table describes the Exclude Applications settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Exclude xFont from:</td>
<td>Displays a list of applications that are currently running on the system.</td>
</tr>
<tr>
<td></td>
<td>Checked applications are excluded from xFont processing; the <strong>Standard</strong></td>
</tr>
<tr>
<td></td>
<td>font enhancement type is applied in these applications.</td>
</tr>
</tbody>
</table>
Finders

ZoomText's Desktop, Web and Text Finders allow you to quickly find applications and documents, web page links, and text within the active application or the entire screen. With intuitive filters and search tools, you can quickly find any item of interest.

Desktop Finder

The Desktop Finder helps you find and open programs and documents located in the Windows desktop environment - including the quick launch bar, system tray and control panel. When executing the Desktop Finder, a dialog box displays a list of items located in the desktop environment. This list can be filtered and searched, allowing you to quickly locate the desired item. Desktop Finder 'Actions' allow you to open the item or view its properties.
To use the Desktop Finder

1. On the Magnifier toolbar, select Desktop. The Desktop Finder dialog appears.
   
   Hotkey: CTRL + SHIFT + D

2. Filter and sort the Desktop Items list by selecting the desired options under Show These Items and Sort Items By.

3. To narrow the search, type the information you are searching for in the Search For combo box, or select a recent entry from the combo box list.

   As you type, the Desktop Items list is automatically filtered to display only items that contain the search string.

4. Select the desired item in the Desktop Items list.

5. Click the Open button to launch the selected program or open the selected folder.

6. Click the Properties button to view the properties for the selected item.

   When selecting the Properties button the Desktop Finder remains open, allowing you to repeat this action on other desktop items. To bring the Desktop Finder dialog back into view, switch the focus back to ZoomText by pressing ALT + INSERT, or click the ZoomText button in the Windows task bar.
The following table describes the Desktop Finder settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Desktop Items</td>
<td>Displays a list of desktop items - according to the selections under Show These Items and Sort Items By.</td>
</tr>
<tr>
<td>Search For</td>
<td>Provides a place for you to type the information you want to search for; or you can select a recent entry from the combo box list. As you type, the Desktop Items list is automatically filtered to display only items that contain the search string.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th><strong>Desktop</strong></th>
<th>Programs, shortcuts and folders located on the Windows desktop are shown in the <strong>Desktop Items</strong> listbox.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Quick Launch</strong></td>
<td>Shortcuts located in the Quick Launch toolbar are shown in the <strong>Desktop Items</strong> listbox.</td>
</tr>
<tr>
<td><strong>Tray</strong></td>
<td>Utilities located in the system tray are shown in the <strong>Desktop Items</strong> listbox.</td>
</tr>
<tr>
<td><strong>Programs menu</strong></td>
<td>Items in the <strong>Start ▶ Programs</strong> menu are shown in the Desktop Items listbox.</td>
</tr>
<tr>
<td><strong>My Documents folder</strong></td>
<td>Items in the <strong>My Documents</strong> folder are shown in the Desktop Items listbox.</td>
</tr>
<tr>
<td><strong>Control Panel</strong></td>
<td>Appletes in the Control Panel are shown in the <strong>Desktop Items</strong> listbox.</td>
</tr>
<tr>
<td><strong>Type</strong></td>
<td>The <strong>Desktop Items</strong> are sorted by type (programs, folders, documents and links).</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>The <strong>Desktop Items</strong> are sorted by name.</td>
</tr>
<tr>
<td><strong>Source</strong></td>
<td>The <strong>Desktop Items</strong> are sorted by source (where the item came from, such as the Programs Folder).</td>
</tr>
<tr>
<td><strong>Target</strong></td>
<td>The <strong>Desktop Items</strong> are sorted by target string (i.e. directory path or URL).</td>
</tr>
<tr>
<td><strong>Open</strong></td>
<td>Opens the selected item.</td>
</tr>
<tr>
<td><strong>Properties</strong></td>
<td>Displays the properties dialog for the selected item.</td>
</tr>
</tbody>
</table>
Web Finder

The Web Finder helps you find links and controls in Internet Explorer, Firefox 2.0, AOL, HTML email, and HTML Help systems. When executing the Web Finder, a dialog box displays a list of links and controls in the active HTML document. This list can be filtered and searched, allowing you to quickly find the desired item. Web Finder 'Actions' allow you to execute a selected link, scroll to a link or control, or begin reading (with AppReader) at the location of a link or control.
To use the Web Finder


   The Web Finder dialog appears.

   **Hotkey:** **CTRL + SHIFT + W**

2. Filter and sort the Web Page Items list by selecting the desired options under Show These Items and Sort Items By.

3. To narrow the search, type the information you are searching for in the Search For combo box, or select a recent entry from the combo box list.

   As you type, the Web Page Items list is automatically filtered to display only items that contain the search string.

4. Select the desired item in the Web Page Items list.

5. Click the Execute Link button to execute the selected link. Click the Scroll To button to scroll the selected item into view. Click the Read From button to begin reading (with AppReader) at the location of the selected item.

   **Note:** The Read From option is not available in ZoomText Magnifier.
Chapter 3  Magnification Features  •  119

Web Finder dialog

The following table describes the Web Finder settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window</td>
<td>Displays a list of all web pages (open in Internet Explorer), HTML email (open in Outlook) and HTML Help windows that are currently open. Links and controls that appear in the selected window are displayed in the Web Page Items listbox.</td>
</tr>
<tr>
<td>Web Page Items</td>
<td>Displays a list of links and controls from the web page specified in the Window combo box.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th><strong>Search For</strong></th>
<th>Provides a place for you to type the information you want to search for; or you can select a recent entry from the combo box list. As you type, the <strong>Web Page Items</strong> list is automatically filtered to display only items that contain the search string.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Visited Links</strong></td>
<td>Links that have been visited are shown in the <strong>Web Page Items</strong> listbox.</td>
</tr>
<tr>
<td><strong>Unvisited Links</strong></td>
<td>Links that have not been visited are shown in the <strong>Web Page Items</strong> listbox.</td>
</tr>
<tr>
<td><strong>Controls</strong></td>
<td>Controls (edit boxes, buttons, etc.) are shown in the <strong>Web Page Items</strong> listbox.</td>
</tr>
<tr>
<td><strong>Tab Order</strong></td>
<td>Sorts the <strong>Web Page Items</strong> listbox by the tab order of the links and controls.</td>
</tr>
<tr>
<td><strong>Name</strong></td>
<td>Sorts the <strong>Web Page Items</strong> listbox by item name.</td>
</tr>
<tr>
<td><strong>Description</strong></td>
<td>Sorts the <strong>Web Page Items</strong> listbox by item description (URL and/or control type).</td>
</tr>
</tbody>
</table>
| **Execute Link** | Executes the selected link.  
**Note:** **Execute Link** is disabled (grayed out) when a control item is selected. |
| **Scroll To** | Scrolls the selected link or control into view and sets the focus to the object. |
| **Read From** | Launches AppReader and begins reading from the location of the selected item.  
**Note:** The **Read From** option is not available in ZoomText Magnifier. |
Text Finder

The Text Finder helps you locate words or phrases within the active application window or the entire screen. After entering the text you want to search for, the Text Finder highlights and reads each found occurrence of the text or the entire line that contains the text.

Note: Text is not spoken by ZoomText Magnifier.

To use the Text Finder

1. On the Magnifier toolbar, select Text. The Text Finder dialog appears. For information on this dialog, see "Text Finder Settings" in this chapter.

   Hotkey: CTRL + SHIFT + T

2. In the Search For box, type the word or phrase you want to search for.

3. Select any other Text Finder options you want to use.

4. Click the Search button. The Text Finder dialog is hidden and the first occurrence of the search text is highlighted and spoken according to the selected options. The Text Finder toolbar appears above the found text, providing controls for navigating and reading occurrences of the search text.

   Note: Text is not spoken by ZoomText Magnifier.

5. To navigate to the next or previous occurrence of the search text, use the Text Finder toolbar or associated Text Finder commands.

6. To exit the Text Finder, right-click or press ESC.
**Text Finder Toolbar**

The Text Finder toolbar appears above the found text, providing controls for navigating and reading occurrences of the search text.

*The Text Finder toolbar*

- **Read**  
  Reads the entire line that contains the found word.  
  Shortcut Key: **ENTER**

- **Previous**  
  Displays the previous occurrence of the search text.  
  Shortcut Key: **LEFT** or **SHIFT + TAB**

- **Next**  
  Displays the next occurrence of the search text.  
  Shortcut Key: **RIGHT** or **TAB**

- **Start AppReader**  
  Launches AppReader and begins reading from the location of the highlighted search text.  
  Shortcut Key: **A** or **CTRL + ALT + A**

- **Settings**  
  Returns to the Text Finder dialog.  
  Shortcut Key: **BACKSPACE**

- **Close**  
  Exits the Text Finder.  
  Shortcut Key: **ESC**

* This option is not available in ZoomText *Magnifier.*
The following commands can also be used to speak the highlighted search text; or the line or sentence in which it resides.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say current word/phrase</td>
<td>CTRL + NUMPAD 5</td>
</tr>
<tr>
<td>Say line</td>
<td>SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say sentence</td>
<td>CTRL + ALT + NUMPAD 5</td>
</tr>
</tbody>
</table>

**Text Finder Settings**

The Text Finder settings allow you to refine and accelerate your search. These options allow you to select the search area, search starting point and text matching criteria. When running ZoomText Magnifier/Reader, you can also configure Text Finder to speak each found occurrence of the search text, or the entire line containing the text.

![Text Finder dialog](Image)
The following table describes the Text Finder settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Search For</td>
<td>Provides a place for you to type the text you want to search for; or you can select a recent entry from the combo box list.</td>
</tr>
<tr>
<td>Search</td>
<td>Finds and selects the next occurrence of the text specified in the Search For box.</td>
</tr>
<tr>
<td>Active window</td>
<td>Text Finder searches the active application or dialog window for occurrences of the search text.</td>
</tr>
<tr>
<td>Entire screen</td>
<td>Text Finder searches the entire screen for occurrences of the search text.</td>
</tr>
<tr>
<td>Top</td>
<td>ZoomText searches the selected search area from top to bottom.</td>
</tr>
<tr>
<td>Bottom</td>
<td>ZoomText searches the selected search area from bottom to top.</td>
</tr>
<tr>
<td>Cursor or focus</td>
<td>ZoomText starts searching from the cursor position (when a cursor is present) or the control that currently has focus.</td>
</tr>
<tr>
<td>Match whole words only</td>
<td>When selected, ZoomText searches for occurrences that are whole words and not part of a larger word.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th><strong>Match case</strong></th>
<th>When selected, ZoomText finds only those instances in which the capitalization matches the text typed into the <strong>Search For</strong> box.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Search text</strong> *</td>
<td>When an instance of the search text is found, only the search text is spoken.</td>
</tr>
<tr>
<td><strong>Entire line</strong> *</td>
<td>When an instance of the search text is found, the entire line containing the search text is spoken.</td>
</tr>
<tr>
<td><strong>Nothing</strong> *</td>
<td>When an instance of the search text is found, the text is not spoken.</td>
</tr>
</tbody>
</table>

* These settings are not available in ZoomText **Magnifier**.
Navigation Settings

Navigation settings control how ZoomText keeps tracked activity in view, including movement of the mouse pointer and text cursor, and keyboard navigation through menus, dialogs and other application controls. With these settings you can:

- Select the types of activity that will be tracked.
- Define how tracked items are aligned in the zoom window.
- Route and constrain mouse pointer for smoother navigation.

Tracking

As you move the mouse, type text, and navigate menus, dialogs and other program controls, the zoom window automatically scrolls to keep the focus in view. This behavior is driven by ZoomText’s tracking options, which allow you to choose the items that you want ZoomText to track (when they become active). You can also limit tracking to a selected area of the screen.

- **To adjust the tracking options**
  1. In the Settings menu, choose Tracking...
     
     *The Navigation Settings dialog appears with the Tracking tab displayed.*
  2. Adjust the tracking options as desired.
  3. Click the OK button.
### Tracking tab

The following table describes the Tracking settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Mouse pointer</td>
<td>Track on the mouse pointer when it moves.</td>
</tr>
<tr>
<td>Text cursor</td>
<td>Track on the text cursor when it moves.</td>
</tr>
<tr>
<td>Menus</td>
<td>Track on highlighted menu items.</td>
</tr>
<tr>
<td>Controls</td>
<td>Track on controls when they receive focus. Controls include buttons, check boxes, listboxes, etc.</td>
</tr>
<tr>
<td>Tool Tips</td>
<td>Track on tool tips when they appear. (Continued)</td>
</tr>
<tr>
<td><strong>Windows</strong></td>
<td>Track on windows when they are activated.</td>
</tr>
<tr>
<td><strong>Alerts</strong></td>
<td>Track on alert popups when they appear.</td>
</tr>
<tr>
<td><strong>Entire Screen</strong></td>
<td>Allows activity anywhere on the screen to be tracked.</td>
</tr>
<tr>
<td><strong>Inside Area</strong></td>
<td>Limits tracking to activity inside the defined tracking area. The tracking area can be set by clicking the <strong>Set Tracking Area</strong> button.</td>
</tr>
<tr>
<td><strong>Outside Area</strong></td>
<td>Limits tracking to activity outside the defined tracking area. The tracking area can be set by clicking the <strong>Set Tracking Area</strong> button.</td>
</tr>
<tr>
<td><strong>Set Tracking Area</strong></td>
<td>Activates a tool for setting the Inside and Outside tracking areas (whichever is currently selected). When the tool is activated, a tracking area frame with sizing handles appears on the screen. To size the frame, drag any handle. To move the frame, drag inside the frame. Right-click to exit the tool.</td>
</tr>
</tbody>
</table>
Turning tracking on and off

At times you may want to disable tracking – to keep a specific view in the zoom window.

To turn tracking on and off

Press the Tracking On/Off hotkey: 
CTRL + ALT + SHIFT + T.

Note: ZoomText configurations are always saved with Tracking in the on state.
Alignment

Alignment options control how the zoom window scrolls to keep tracked items in view. There are two general types of alignment: edge and center. With edge alignment, the zoom window scrolls only as needed to keep the tracked object in view. With center alignment, the zoom window scrolls as needed to keep the tracked object in the center of the zoom window. A third alignment type, "smart alignment", scrolls a control and the maximum portion of its parent menu or window into view.

▷ To adjust the alignment options

1. In the Settings menu, choose Alignment...
   The Navigation Settings dialog appears with the Alignment tab displayed.
2. Adjust the alignment options as desired.
3. Click the OK button.
Alignment tab

The following table describes the Alignment settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Within edge margins</td>
<td>The zoom window scrolls only as needed to bring the tracked object within</td>
</tr>
<tr>
<td></td>
<td>the edge margins.</td>
</tr>
<tr>
<td>Centered within the zoom</td>
<td>The zoom window scrolls to keep the tracked object centered in the</td>
</tr>
<tr>
<td>window</td>
<td>magnified view.</td>
</tr>
</tbody>
</table>

(Continued)
| **Edge Margin** | Defines how close to the edge of the zoom window a tracked object can move before the window begins to scroll. The edge margin can be set from 0% (no margin) to 50% (half the width and height of the zoom window). |
| **Smart alignment with parent window** | The zoom window scrolls to bring the tracked control or menu item and the maximum portion of its parent window or menu into view. |
Mouse

The Mouse navigation options, pointer positioning and pointer constraints, make it easy to explore and move about the screen. With pointer positioning, the mouse pointer is always brought into view when you need it. With pointer constraints, you can limit mouse pointer movement to horizontal or vertical directions, or within the active window.

To adjust the mouse navigation options
1. In the **Settings** menu, choose **Mouse**...

   *The Navigation Settings dialog appears with the Mouse tab displayed.*

2. Adjust the mouse navigation options as desired.
3. Click the **OK** button.

![Navigation Settings dialog]

*Mouse tab*
The following table describes the Mouse settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Route pointer into view when it is moved</strong></td>
<td>Automatically moves the pointer to the center of the magnified view – whenever the pointer moves while located outside the view.</td>
</tr>
<tr>
<td><strong>Route pointer over the active control</strong></td>
<td>Automatically moves the pointer to menu items and dialog controls when they receive focus.</td>
</tr>
<tr>
<td><strong>Hold Shift key to move only horizontally or vertically</strong></td>
<td>While holding down the <strong>SHIFT</strong> key, the mouse pointer moves horizontally or vertically only, depending on the initial direction of mouse movement. This constrained movement provides smoother scrolling through rows and columns of information.</td>
</tr>
<tr>
<td><strong>Hold Ctrl key to stay within the active window</strong></td>
<td>While holding down the <strong>CTRL</strong> key, mouse pointer movement is constrained to the active window, preventing you from accidentally scrolling away from your area of interest.</td>
</tr>
</tbody>
</table>
Smooth Panning

Smooth panning (patent-pending) provides a more natural panning motion when the magnified view scrolls to keep the focus in view. As you type text and navigate menus, dialogs and other program controls the magnified view smoothly pans across the screen, rather than jumping in an abrupt manner. You can also use “smooth mouse panning” to smoothly pan and explore in any direction.

Note: Smooth mouse panning is only available when the zoom window type is set to Full.

▷ To enable and adjust the smooth panning options

1. In the Settings menu, choose Panning...
   
   The Navigation Settings dialog appears with the Panning tab displayed.

2. Make sure the Enable smooth panning box is checked.

3. Adjust the panning options as desired.

4. Click the OK button.

▷ To turn smooth panning on and off

- Press the Smooth Panning On/Off hotkey: WINDOWS + SHIFT + P.
Panning tab

The following table describes the Panning settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable smooth panning</td>
<td>Enables ZoomText’s smooth panning feature.</td>
</tr>
<tr>
<td>Panning Speed</td>
<td>Controls how fast ZoomText pans from one location to another.</td>
</tr>
<tr>
<td>Use smooth panning in AppReader</td>
<td>Enables smooth panning between highlighted words in AppReader.</td>
</tr>
<tr>
<td>Enable smooth mouse panning</td>
<td>Enables ZoomText’s smooth mouse panning feature.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Sensitivity</th>
<th>Controls the sensitivity of smooth mouse panning when moving the mouse. At lower settings the mouse must be moved further to start panning and to accelerate panning speed.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Wheel click modifiers</td>
<td>Selects the key combination to be used when clicking the mouse wheel to activate smooth mouse panning. The selected keys must be held down while clicking the mouse wheel.</td>
</tr>
</tbody>
</table>

**To use smooth mouse panning**

1. Make sure the zoom window type is set to **Full**.
2. Press the Smooth Mouse Panning hotkey: **CTRL + mouse wheel click**.
   
   *The mouse panning tool becomes active.*
3. To start panning, move the mouse pointer in the direction you want to pan.
4. To increase the panning speed, move the pointer further away from the center point.
5. To decrease the panning speed, move the pointer back toward the center point.
6. To change the panning direction, move the pointer to a new direction (relative to the center point).
7. To stop panning, move the pointer back to the center point.
8. To exit smooth mouse panning, right click or press **ESC**.
Smooth Scrolling

Scroll hotkeys allow you to smoothly scroll to any area of the screen, or jump instantly to a specific screen location.

**Note:** *Num Lock* must be turned off when using ZoomText commands that use the numeric keypad.

▷ **To smoothly scroll the zoom window**

1. Hold down **ALT** and press the arrow key that corresponds to the desired direction.

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll left</td>
<td><strong>ALT + LEFT</strong></td>
</tr>
<tr>
<td>Scroll right</td>
<td><strong>ALT + RIGHT</strong></td>
</tr>
<tr>
<td>Scroll up</td>
<td><strong>ALT + UP</strong></td>
</tr>
<tr>
<td>Scroll down</td>
<td><strong>ALT + DOWN</strong></td>
</tr>
</tbody>
</table>

2. To increase the scrolling speed, press the same arrow key without releasing the **ALT** key (each press will increase the speed).

3. To decrease the scrolling speed, press the opposite arrow key without releasing the **ALT** key (each press will decrease the speed until scrolling stops).

4. To scroll in a different direction, press the arrow key corresponding to the new direction without releasing the **ALT** key.

5. To stop scrolling, release the **ALT** key.
To jump to an edge or the center of the screen

Use the following hotkeys:

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Jump to left edge</td>
<td>ALT + HOME</td>
</tr>
<tr>
<td>Jump to right edge</td>
<td>ALT + END</td>
</tr>
<tr>
<td>Jump to top edge</td>
<td>ALT + PAGE UP</td>
</tr>
<tr>
<td>Jump to bottom edge</td>
<td>ALT + PAGE DOWN</td>
</tr>
<tr>
<td>Jump to center</td>
<td>ALT + NUMPAD 5</td>
</tr>
</tbody>
</table>

To save and restore a specific view of the screen

The current view can be saved and restored (at a later time) using the following hotkeys:

<table>
<thead>
<tr>
<th>To...</th>
<th>Press...</th>
</tr>
</thead>
<tbody>
<tr>
<td>Save the current view</td>
<td>ALT + NUMPAD /</td>
</tr>
<tr>
<td>Restore the saved view</td>
<td>ALT + NUMPAD *</td>
</tr>
</tbody>
</table>
CHAPTER 4

Screen Reading Features

This chapter describes ZoomText's screen reading features. These features are included in ZoomText Magnifier/Reader only.

The Reader Toolbar

The Reader toolbar provides quick access to ZoomText's screen reading features. Each toolbar button has an intuitive icon and label for easy identification. Many of these buttons have pop-up menus that provide fast access to the most important and frequently used settings. Related buttons are grouped together and the group is labeled with a clickable link that opens their associated dialog box.
**Speech**  Turns speech output on and off, and allows you to quickly switch between recently used speech synthesizers.

**Rate**  Controls how fast ZoomText speaks.

**Typing**  Selects typing echo settings. Typing echo provides immediate feedback of the keys and words that you type. Settings are specified in the Typing Echo dialog box.

**Mouse**  Selects mouse echo settings. Mouse echo automatically reads text beneath the pointer. Settings are specified in the Mouse Echo dialog box.

**Verbosity**  Selects a verbosity level. Verbosity allows you to adjust the amount of information spoken when a program item receives focus. Settings are specified in the Verbosity dialog box.

**AppReader**  Launches AppReader to read text from the last active application. AppReader provides continuous reading of documents, web pages and email, within the parent application.

**DocReader**  Launches DocReader to read text from the last active application. DocReader provides continuous reading of documents, web pages and email, in a special environment where text is reformatted for easier viewing.

**Zones**  Allows you to create, edit and navigate reading zones. Reading zones let you instantly see and hear selected locations in an application window.
**SpeakIt**  The SpeakIt tool allows you to read selected areas of the screen by clicking or dragging with the mouse. Any text that is visible on the screen can be spoken, even if it is outside the active program.

* The AppReader and DocReader buttons gray out when the active application does not have text available for reading.
Speech Settings

Speech settings allow you to customize speech output to fit your needs. You can customize the screen reading voice (synthesizer settings), reading style (text processing), and activate audible cues (hints).

Turning Speech On and Off

You can turn speech output on and off without disabling the magnification features.

▶ To enable and disable speech

On the Reader toolbar, select Speech ▶ Enable (or Disable).

Note: AppReader, DocReader and the SpeakIt tool can still be used when speech is disabled.

There may be times when you want to terminate speech output while it is occurring. For example, when ZoomText is reading a message box that you are already familiar with. You can force ZoomText to stop speaking this text without turning speech off altogether.

▶ To terminate speech output as it occurs

Press and release the CTRL key.

*The information that is currently being spoken is terminated.*
Adjusting the Speech Rate

Speech rate allows you to control how fast ZoomText speaks in words per minute (SAPI 4 synthesizers) or in percentage of the synthesizer's range (SAPI 5 synthesizers).

> **To adjust the speech rate**

On the Reader toolbar, adjust the level in the Rate spinbox.

<table>
<thead>
<tr>
<th>Hotkeys:</th>
<th>Increase Speech Rate:</th>
<th>CTRL + NUMPAD PLUS</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td>Decrease Speech Rate:</td>
<td>CTRL + NUMPAD MINUS</td>
</tr>
</tbody>
</table>

**Note:** The speech rate can also be adjusted in the Speech Synthesizer dialog box. For more information, see "Speech Settings - Synthesizer Settings" in this chapter.

A separate speech rate is available for AppReader and DocReader. This setting is located in the Reading Options dialog box. For more information, see "Reading Options" in this chapter.
Synthesizer Settings

Synthesizer settings let you customize the screen reading voice. You can select from a variety of male and female voices, and adjust their speaking rate, pitch and volume.

ZoomText comes with four speech synthesizers: NeoSpeech (English only), TruVoice, ViaVoice and Microsoft Speech. The ZoomText Setup program allows you to install any combination of these synthesizers. ZoomText also supports other SAPI 4 or SAPI 5 based synthesizers that have been installed on your system.

▶ To adjust the speech synthesizer settings

1. In the Reader menu, choose Synthesizer...

   *The Speech dialog appears with the Synthesizer tab displayed.*

2. Make sure the Enable speech output box is checked.

3. Choose a Synthesizer and Voice, and then adjust the Rate, Pitch and Volume as desired.

4. To preview the synthesizer settings, type some text in the Sample Text edit box, and then click Speak Sample.

5. Click the OK button.
The following table describes the Synthesizer settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable speech output</td>
<td>Enables or disables speech output for screen reading.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This setting cannot be adjusted when the Speech dialog is opened</td>
</tr>
<tr>
<td></td>
<td>from the DocReader toolbar.</td>
</tr>
<tr>
<td>Synthesizer</td>
<td>Displays a list of speech synthesizers available on your system.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> ZoomText supports SAPI 4 and SAPI 5 based speech synthesizers.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Voice</th>
<th>Displays a list of voices available in the selected synthesizer.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Rate</td>
<td>Controls how fast ZoomText speaks. When using a SAPI 4 speech synthesizer, rate is represented in words per minute. When using a SAPI 5 speech synthesizer, rate is represented in percentage of the synthesizer's range, where 0% is the slowest rate and 100% is the fastest rate. A separate reading rate is available for AppReader and DocReader. * For more information, see &quot;Reading Options&quot; in this chapter.</td>
</tr>
<tr>
<td>Pitch</td>
<td>Selects the pitch of the current voice. Pitches range from 5% to 100%, in steps of 5%.</td>
</tr>
<tr>
<td>Volume</td>
<td>Selects the volume of the current voice. Volumes range from 5% to 100%, in steps of 5%.</td>
</tr>
<tr>
<td>Options...</td>
<td>Displays optional settings for the selected speech synthesizer, including the synthesizer's pronunciation manager. If the speech device is not pronouncing a word properly, you can adjust the pronunciation by supplying the phonetic spelling.</td>
</tr>
</tbody>
</table>

*(Continued)*
| Sample Text / Speak Sample | Allows you to test particular speech settings. Text can be typed into the **Sample Text** box and spoken by clicking the **Speak Sample** button. The current speech settings are used to speak the sample text, including settings in the Text Processing and Hints tabs. |

* If AppReader and DocReader are set to use their own reading rate, this rate setting will be grayed out (disabled) when opening the Speech dialog from the DocReader toolbar.
Text Processing

Text processing modifies how numbers, punctuations and mixed case words are spoken, so that they are pronounced in the proper context or desired format. With these settings you can create a reading style that clarifies complex words and numbers.

▶ To adjust the text processing options

1. In the Reader menu, choose Text Processing...

   The Speech dialog appears with the Text Processing tab displayed.

2. Adjust the text processing options as desired.

3. Click the OK button.

Text Processing tab

The following table describes the Text Processing settings.
<table>
<thead>
<tr>
<th><strong>Setting</strong></th>
<th><strong>Description</strong></th>
</tr>
</thead>
<tbody>
<tr>
<td>Speak mixed case as separate words</td>
<td>Breaks mixed case words into separate words for more accurate pronunciation by the speech synthesizer. For example, the word 'ZoomText' is broken apart and spoken as &quot;Zoom Text&quot;.</td>
</tr>
<tr>
<td>Filter out repeated characters</td>
<td>Limits the number of times that repeated characters are spoken. This is useful when encountering a string of repeated characters used in formatting.</td>
</tr>
<tr>
<td>Repeat Count</td>
<td>Sets the maximum number of times a repeated character is spoken. The repeat count range is from 2 to 10.</td>
</tr>
<tr>
<td>Speak numbers according to synthesizer settings</td>
<td>Numbers are spoken according to the synthesizer's built in settings.</td>
</tr>
<tr>
<td>Speak numbers using their full word representation</td>
<td>Numbers are spoken using their full-word representation. For example, the number '1995' is spoken &quot;one thousand nine hundred and ninety five&quot;.</td>
</tr>
<tr>
<td>Speak numbers as single digits</td>
<td>Numbers are spoken as individual digits. For example, the number '1995' is spoken &quot;one nine nine five&quot;.</td>
</tr>
</tbody>
</table>

(Continued)
**Speak numbers as digit pairs**
Numbers are spoken as digit pairs. For example, the number '1995' is spoken "nineteen ninety five".

**Speak punctuation according to synthesizer settings**
Punctuation characters are spoken according to the synthesizer's built in settings.

**Speak all punctuation**
All punctuation characters are spoken.

**Speak embedded punctuation only**
Only punctuation characters embedded within words are spoken. For example, sales@aisquared.com is spoken "sales at Ai Squared dot com".
Hints

Hints provide audible cues when you encounter capital letters, hypertext links, or the start or end of a document. Hints can be heard as a momentary pitch change while the item is read or a verbal announcement such as "Cap" or "Link" prior to the item being read.

To adjust the hints options
1. In the Reader menu, choose Hints...
   The Speech dialog appears with the Hints tab displayed.
2. Adjust the Hints options as desired.
3. Click the OK button.

Hints tab

The following table describes the Hints settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No hints for capitals</td>
<td>No hint is applied when a capital letter is read.</td>
</tr>
<tr>
<td>Change pitch when reading a capital</td>
<td>The synthesizer pitch is changed when a capital letter is read.</td>
</tr>
<tr>
<td>Say &quot;Cap&quot; before reading a capital</td>
<td>The word &quot;cap&quot; is spoken before a capital letter is read.</td>
</tr>
<tr>
<td>Pitch Change (Capital Letters)</td>
<td>A percentage change to the voice pitch occurs when a capital letter is read. Pitch change ranges from -50% to +50% in steps of 10%.</td>
</tr>
<tr>
<td>No hints for links</td>
<td>No hint is applied when a hypertext link is read.</td>
</tr>
<tr>
<td>Change pitch when reading a link</td>
<td>The synthesizer pitch is changed when a hypertext link is read.</td>
</tr>
<tr>
<td>Say &quot;Link&quot; before a link is read</td>
<td>The word &quot;link&quot; is spoken when a hypertext link is read.</td>
</tr>
<tr>
<td>Pitch Change (Hypertext Links)</td>
<td>A percentage change to the voice pitch occurs when a hypertext link is read. Pitch change ranges from -50% to +50% in steps of 10%.</td>
</tr>
</tbody>
</table>

(Continued)
| Say "Beginning of document" and "End of document" | The words "beginning of document" and "end of document" are spoken when navigating to the beginning or end of a document in AppReader and DocReader. |
Echo Settings

Echo settings control how ZoomText speaks as you type, use the mouse, and navigate Microsoft Windows and your applications. These settings allow you to fine-tune the amount of information spoken according to your personal needs.

Typing Echo

Typing echo allows you to hear the keys and words that you type. You can choose to have individual keys, words, or both keys and words spoken. Typed words are spoken upon completion (as soon as you type a space or punctuation character). Additional typing echo options also allow you to select which keys are spoken – all keys or selected groups of keys.

To enable typing echo

On the Reader toolbar, select Typing, and then select the desired typing echo mode.

Hotkey: ALT + SHIFT + T
Cycles through the typing echo modes.

To adjust the typing echo options

1. In the Reader menu, choose Typing Echo...
   
   The Echo Settings dialog appears with the Typing tab displayed.
   
2. Adjust the typing echo options as desired.
3. Click the OK button.
Typing tab

The following table describes the Typing Echo settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Echo</td>
<td>Turns off typing echo.</td>
</tr>
<tr>
<td>Keys</td>
<td>Activates typing echo by keystroke. You can select which keys are echoed using the settings under <strong>Echo these keys when they are pressed</strong>.</td>
</tr>
<tr>
<td>Words</td>
<td>Activates typing echo by word. Echoing occurs only when a completed word appears on the screen.</td>
</tr>
<tr>
<td>Keys and Words</td>
<td>Activates typing echo by keystroke and by word.</td>
</tr>
<tr>
<td>----------------------</td>
<td>--------------------------------------------------</td>
</tr>
<tr>
<td><strong>Printable Keys</strong></td>
<td>Echoes all printable characters: letters, numbers and symbols.</td>
</tr>
<tr>
<td><strong>Navigation Keys</strong></td>
<td>Echoes navigation keys: arrows, <strong>Home</strong>, <strong>End</strong>, <strong>Page Up</strong> and <strong>Page Down</strong>.</td>
</tr>
<tr>
<td><strong>Editing Keys</strong></td>
<td>Echoes text-editing keys: <strong>Space</strong>, <strong>Tab</strong>, <strong>Backspace</strong>, <strong>Insert</strong>, <strong>Delete</strong>, <strong>Escape</strong> and <strong>Enter</strong>.</td>
</tr>
<tr>
<td><strong>Function Keys</strong></td>
<td>Echoes the function keys: <strong>F1</strong> through <strong>F12</strong>.</td>
</tr>
<tr>
<td><strong>Modifier Keys</strong></td>
<td>Echoes the modifier keys: <strong>ALT</strong>, <strong>CTRL</strong>, <strong>SHIFT</strong> and the Windows key.</td>
</tr>
<tr>
<td><strong>Locking Keys</strong></td>
<td>Echoes the locking keys and their state: <strong>Caps Lock</strong>, <strong>Num Lock</strong>, and <strong>Scroll Lock</strong>.</td>
</tr>
<tr>
<td><strong>Other Keys</strong></td>
<td>Echoes miscellaneous keys: <strong>Pause</strong>, <strong>Print Screen</strong> and the Application Key.</td>
</tr>
</tbody>
</table>

**Note:** Selections under **Echo these keys**... are only available when typing echo is set to **Keys** or **Keys and Words**.
Mouse Echo

Mouse echo automatically reads text beneath the pointer. As you move the pointer across the screen, single words or complete lines of text are echoed instantly or after hovering briefly.

▶ To enable mouse echo

On the Reader toolbar, select Mouse, and then select the desired mouse echo mode.

Hotkey: ALT + SHIFT + M

Cycles through the mouse echo modes.

▶ To adjust the mouse echo options

1. In the Reader menu, choose Mouse Echo...

   The Echo Settings dialog appears with the Mouse tab displayed.

2. Adjust the mouse echo options as desired.

3. Click the OK button.
Mouse tab

The following table describes the Mouse Echo settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>No Echo</td>
<td>Turns off mouse echo.</td>
</tr>
<tr>
<td>Instant Echo</td>
<td>Enables instant mouse echo. Words are spoken immediately when the mouse pointer is moved over them.</td>
</tr>
<tr>
<td>Hover Echo</td>
<td>Enables delayed mouse echo. Words are spoken after the mouse pointer hovers over them for the selected hover time.</td>
</tr>
</tbody>
</table>
Hover Time (seconds) | The amount of time in seconds that the mouse pointer must hover over an object before it is spoken. This setting applies to Hover Echo only.
---|---
Echo the word only | Only the word beneath the mouse pointer is echoed.
Echo all words in the line or object | When the mouse pointer moves into a new line of text or over a new object, all words in the line or object are spoken. Objects include: title bars, menu items, dialog controls, desktop icons and task bar buttons.

**Note:** When using mouse echo, holding down the **SHIFT** key toggles the echo mode from Echo the word only to Echo all words in the line or object (or vice-versa).

**Program Echo**

Program echo determines what items are spoken as you navigate and use your applications. These items include: window titles, menus, dialogs, list views, tree views, and text that the cursor moves through. The amount of detail that is spoken for these items can be adjusted using the Verbosity Settings. For more information, see "Echo Settings - Verbosity" in this chapter.
To adjust the program echo options

1. In the Reader menu, choose **Program Echo**...

   The Echo Settings dialog appears with the Program tab displayed.

2. Adjust the program echo options as desired.

3. Click the **OK** button.

![Echo Settings dialog box](image)

*Program tab*

The following table describes the Program Echo settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Text Cursor</td>
<td>When the text cursor moves, text at the new cursor location is spoken. The amount of text that is spoken is in accordance with how far the cursor has moved (by character, word, line, sentence or paragraph).</td>
</tr>
<tr>
<td>Menus</td>
<td>When you pull down a menu, its title is spoken followed by each menu item that becomes highlighted.</td>
</tr>
<tr>
<td>Controls</td>
<td>As you navigate through dialog boxes, tree views and list views, each item is spoken as it becomes highlighted or selected.</td>
</tr>
<tr>
<td>Tool Tips</td>
<td>When a tool tip appears, it is spoken.</td>
</tr>
<tr>
<td>Window Titles</td>
<td>When a window becomes active, the contents of its title bar are spoken.</td>
</tr>
<tr>
<td>Alerts</td>
<td>When a popup appears, it is spoken.</td>
</tr>
<tr>
<td>Echo the word at the cursor</td>
<td>When the text cursor moves to a new line, the word at the new cursor location is spoken.</td>
</tr>
<tr>
<td>Echo the entire line</td>
<td>When the text cursor moves to a new line, the entire line is spoken.</td>
</tr>
</tbody>
</table>
Verbosity

Verbosity allows you to adjust the amount of information spoken about program controls when they become active or highlighted. Program controls include: application and document windows, menus, dialogs, buttons, icons, and more.

Three verbosity levels – Beginner, Intermediate and Expert – allow you to quickly increase or decrease the verbosity. Beginner verbosity provides more information, while Expert verbosity provides less information. Each of these verbosity levels can be fully customized according to your personal needs.

To select a verbosity level

On the Reader toolbar, select Verbosity, and then select the desired verbosity level.

Hotkey: \text{ALT + SHIFT + V}
Cycles through the verbosity levels.

To adjust the verbosity options

1. In the Reader menu, choose Verbosity...

   \textit{The Echo Settings dialog appears with the Verbosity tab displayed.}

2. Adjust the verbosity options as desired.

3. Click the OK button.
The following table describes the Verbosity settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Beginner</td>
<td>Selects beginner level verbosity settings. Displayed text is spoken along with complete details about the object.</td>
</tr>
<tr>
<td>Intermediate</td>
<td>Selects intermediate level verbosity settings. Displayed text is spoken along with basic details about the object.</td>
</tr>
<tr>
<td>Expert</td>
<td>Selects expert level verbosity settings. Displayed text is spoken along with minimal details about the object.</td>
</tr>
<tr>
<td>Verbosity Settings</td>
<td>A list of checkboxes that define the verbosity levels. The displayed settings reflect the current verbosity level and automatically update when a different verbosity level is selected.</td>
</tr>
<tr>
<td>Select All</td>
<td>Checks all items in the Verbosity Settings listbox.</td>
</tr>
<tr>
<td>Unselect All</td>
<td>Un-checks all items in the Verbosity Settings listbox.</td>
</tr>
<tr>
<td><strong>Verbosity Settings</strong></td>
<td><strong>Description</strong></td>
</tr>
<tr>
<td>-----------------------</td>
<td>----------------</td>
</tr>
<tr>
<td>Alerts</td>
<td>Announces the text within alerts when they are displayed.</td>
</tr>
<tr>
<td>Cell Column Title *</td>
<td>Announces the column title of the active cell in a spreadsheet.</td>
</tr>
<tr>
<td>Cell Comment *</td>
<td>Announces the comments associated with the active cell in a spreadsheet.</td>
</tr>
<tr>
<td>Cell Contents</td>
<td>Announces the contents of the active cell in a spreadsheet.</td>
</tr>
<tr>
<td>Cell Formula</td>
<td>Announces the formula for the active cell in a spreadsheet.</td>
</tr>
<tr>
<td>Cell Name</td>
<td>Announces the name of the active cell in a spreadsheet, such as &quot;A1.&quot;</td>
</tr>
<tr>
<td>Cell Row Title *</td>
<td>Announces the row title of the active cell in a spreadsheet.</td>
</tr>
<tr>
<td>Control Accelerator</td>
<td>Announces the accelerator key for the active control (the underlined character in the control’s label).</td>
</tr>
<tr>
<td>Control Name</td>
<td>Announces the name of the active control.</td>
</tr>
<tr>
<td>Control State</td>
<td>Announces the state of the active control, such as &quot;checked&quot; and &quot;disabled.&quot;</td>
</tr>
</tbody>
</table>

*(Continued)*
<table>
<thead>
<tr>
<th>Control Type</th>
<th>Announces the type of the active control, such as &quot;button&quot; or &quot;checkbox.&quot;</th>
</tr>
</thead>
<tbody>
<tr>
<td>Control Value</td>
<td>Announces the current value of the active control, such as the number displayed in a spinbox, or text in an edit box.</td>
</tr>
<tr>
<td>Dialog Tab</td>
<td>Announces the title of the active dialog tab.</td>
</tr>
<tr>
<td>Group Name</td>
<td>Announces the name of a control group when it receives focus. By default, the group name is only announced when navigating into the group, and not repeated while navigating within the group. To have the group name repeated while navigating within the group, select (check) the Repeat Group Name verbosity setting.</td>
</tr>
<tr>
<td>Item Number</td>
<td>Announces the item number of the selected item in a list control, and the total number of items in the list. For example, &quot;item 5 of 10.&quot;</td>
</tr>
<tr>
<td>Item State</td>
<td>Announces the item state of the selected item in a list control, such as &quot;checked&quot; or &quot;grayed.&quot;</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>List View Labels</td>
<td>Announces the data field names for the selected item in a list view control. This information is not spoken when List View Data (verbosity setting) is disabled.</td>
</tr>
<tr>
<td>List View Data</td>
<td>Announces the data for a selected item in a list view control.</td>
</tr>
<tr>
<td>Menu Item Accelerator</td>
<td>Announces the accelerator key for the selected menu item (the underlined character in the menu item name).</td>
</tr>
<tr>
<td>Menu Open</td>
<td>Announces the opening of a menu, such as &quot;File menu open.&quot;</td>
</tr>
<tr>
<td>Menu Item Shortcut</td>
<td>Announces the shortcut key for a menu item, such as &quot;Ctrl + S.&quot;</td>
</tr>
<tr>
<td>Menu Item State</td>
<td>Announces the state of a menu item, such as &quot;checked&quot; and/or &quot;disabled&quot;.</td>
</tr>
<tr>
<td>Message Text</td>
<td>Announces the text of a message box when opened.</td>
</tr>
<tr>
<td>Repeat Group Name</td>
<td>Repeats a control groups name while navigating to a new control within the group.</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This overrides the Group Name setting.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Sheet Tab *</td>
<td>Announces the name of a spreadsheet tab when initially selected.</td>
</tr>
<tr>
<td>Table Entry</td>
<td>Announces table entry and exit.</td>
</tr>
<tr>
<td>Tool Tips</td>
<td>Announces the text within tool tips when they are displayed.</td>
</tr>
<tr>
<td>Tree Level</td>
<td>Announces changes in tree level (such as &quot;level 3&quot;) when navigating a file tree in Windows Explorer and other applications.</td>
</tr>
<tr>
<td>Window Title</td>
<td>Announces the title of a window when it is activated.</td>
</tr>
<tr>
<td>Window Type</td>
<td>Announces the type of a window when it is activated. For example: &quot;application window&quot; or &quot;dialog window.&quot;</td>
</tr>
<tr>
<td>ZoomText Hotkey</td>
<td>Announces the command initiated by a ZoomText hotkey when the hotkey is pressed.</td>
</tr>
<tr>
<td>ZoomText Setting</td>
<td>Announces the new value of a ZoomText setting when it is changed by a hotkey.</td>
</tr>
</tbody>
</table>

* These items are only recognized in Microsoft Excel 2000 and later.
Reading Tools

ZoomText offers a variety of tools for quick and easy reading of documents, web pages and email. Each of these tools has unique characteristics that lend themselves to particular reading tasks. We recommend that you familiarize yourself with each of these tools so that you can achieve maximum reading efficiency.
AppReader

AppReader reads documents, web pages and email, within the parent application. As you enter and exit AppReader your view of the document does not change, providing quick and seamless transitions between document editing and reading.

AppReader can automatically read through the entire document, or you can manually read by word, line, sentence or paragraph. As reading occurs, each spoken word is highlighted. AppReader settings allow you to customize the appearance of word highlighting, including the highlight shape, size, color and transparency level.

*AppReader word highlighting in Microsoft Word*
To start and operate AppReader

1. Open the document, web page or email that you wish to read.

2. On the Reader toolbar, select AppRdr.  
   
   AppReader begins reading from the current text cursor position. If a text cursor does not exist, AppReader starts in paused mode, with the first word in the magnified view (from the top-left corner).

   Hotkey: ALT + SHIFT + A

   Note: The AppReader button is disabled (grayed out) when the last active application does not contain readable text.

3. To start and stop automatic reading, press ENTER or click the mouse.  
   
   When using the mouse, you can resume reading from a new location by clicking on the word where you wish to begin reading.

4. To read manually by word, line, sentence and paragraph, use the AppReader navigation commands (see "AppReader Commands" in this chapter).

5. To exit AppReader, right-click or press ESC.  
   
   When AppReader exits, the cursor is automatically positioned at the last word that was highlighted in AppReader (if a cursor exists in the application).
AppReader Settings

The AppReader settings allow you to customize the appearance of word highlighting in AppReader, including the highlight shape, color, and transparency level.

To adjust the AppReader settings

1. In the Reader menu, choose AppReader...

   The Reading dialog appears with the AppReader tab displayed.

2. Adjust the AppReader settings as desired.

3. Select the OK button.
The following table describes the AppReader settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Track and highlight words</td>
<td>Enables tracking and highlighting of words when AppReader is reading.</td>
</tr>
</tbody>
</table>
| Exit AppReader at end of document| When enabled, AppReader will automatically exit after reading to the end of the document.  
**Note:** AppReader will not automatically exit when manually navigating to the end of a document. |
| Shape                            | Sets the shape used to highlight words: Block, Underline, Frame, or Wedge.  |
| Color                            | Sets the highlight color.                                                   |
| Thickness                        | Sets the thickness of the highlight shape.                                  |
| Transparency                     | Sets the transparency of the highlight.                                    
**Note:** This setting is not available when the highlight color is set to 'Invert.' |
| Preview                          | Displays sample text with a preview of the selected highlight settings.     |
# AppReader Hotkeys

<table>
<thead>
<tr>
<th>General Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppReader</td>
<td>ALT + SHIFT + A</td>
</tr>
<tr>
<td>Toggle Reading (Play/Pause)</td>
<td>ENTER</td>
</tr>
<tr>
<td>Increase Magnification</td>
<td>ALT + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Magnification</td>
<td>ALT + NUMPAD MINUS</td>
</tr>
<tr>
<td>Increase Reading Rate</td>
<td>CTRL + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Reading Rate</td>
<td>CTRL + NUMPAD MINUS</td>
</tr>
<tr>
<td>Quiet</td>
<td>CTRL</td>
</tr>
<tr>
<td>Exit</td>
<td>ESC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Navigation Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Previous Word</td>
<td>CTRL + LEFT, or LEFT</td>
</tr>
<tr>
<td>Say Current Word *</td>
<td>CTRL + NUMPAD 5, or SPACEBAR</td>
</tr>
<tr>
<td>Say Next Word</td>
<td>CTRL + RIGHT, or RIGHT</td>
</tr>
<tr>
<td>Say Word Above</td>
<td>UP</td>
</tr>
<tr>
<td>Say Word Below</td>
<td>DOWN</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Feature</th>
<th>Keyboard Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Previous Sentence</td>
<td>CTRL + ALT + LEFT</td>
</tr>
<tr>
<td>Say Current Sentence</td>
<td>CTRL + ALT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Sentence</td>
<td>CTRL + ALT + RIGHT</td>
</tr>
<tr>
<td>Say Previous Paragraph</td>
<td>CTRL + UP</td>
</tr>
<tr>
<td>Say Current Paragraph</td>
<td>CTRL + SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Paragraph</td>
<td>CTRL + DOWN</td>
</tr>
<tr>
<td>Say First Word On Line</td>
<td>HOME</td>
</tr>
<tr>
<td>Say Last Word On Line</td>
<td>END</td>
</tr>
<tr>
<td>Previous Page</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>Next Page</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>Beginning of Document</td>
<td>CTRL + HOME</td>
</tr>
<tr>
<td>End of Document</td>
<td>CTRL + END</td>
</tr>
<tr>
<td>Next Link</td>
<td>TAB</td>
</tr>
<tr>
<td>Previous Link</td>
<td>SHIFT + TAB</td>
</tr>
<tr>
<td>Execute Link</td>
<td>CTRL + ENTER</td>
</tr>
</tbody>
</table>

* Repeated presses of the Say Current Word command provides the following behavior:
  
  - First press: speaks the word
  - Second press: spells the word
  - Third press: spells the word phonetically ("Alpha, Bravo, Charlie, ...")

**Note:** Repeated presses must occur within two seconds.
DocReader

DocReader reads documents, web pages and email, in a special environment where text is reformatted for easier viewing. Text is presented in a single line (Ticker) or wrapped lines (Prompter), with your choice of fonts, colors, word highlighting, and magnification level.

DocReader can automatically read through an entire document, or you can manually read by word, line, sentence or paragraph. As reading occurs, each spoken word is highlighted.

The DocReader screen occupies the entire display with a toolbar at the top of the screen and the document text below it. The document text is formatted and displayed according to the current DocReader settings.

**Prompter mode**

**Ticker mode**
To start and operate DocReader

1. Open the document, web page or email that you wish to read.

2. On ZoomText's Reader toolbar, select DocRdr.

   The DocReader screen appears with text from the source document. If the source document contains an active text cursor, the word at the cursor position is highlighted in the DocReader display. Otherwise, the first word in the DocReader display is highlighted.

   Hotkey: ALT + SHIFT + D

   Note: The DocReader button is disabled (grayed out) when the last active application does not contain readable text.

3. To start and stop reading, click the Play/Pause button or press ENTER.

   While paused, you can click any word to set a new location to read from. You can also perform repeated clicks on a word to speak, spell, and then phonetically spell the word (repeated clicks must occur within two seconds).

4. To read manually by word, line, sentence and paragraph, use the DocReader navigation commands (see "DocReader Commands" in this chapter).

5. To exit DocReader, right-click or press ESC.

   When DocReader exits, the text cursor is automatically positioned at the last word that was highlighted in DocReader (if a cursor exists).
The DocReader Toolbar

The DocReader toolbar provides the essential controls for operating DocReader, and provides access to dialogs for configuring the DocReader display.

**DocReader toolbar**

**Play/Pause** Starts and stops reading at the highlighted word. When Play mode is executed, the Pause button appears on the toolbar.

Shortcut Key: **ENTER**

**Rate** Controls how fast DocReader speaks – in words per minute (SAPI 4 synthesizers) or in percentage of the synthesizer’s range (SAPI 5 synthesizers). This setting also controls the reading rate for AppReader.

Hotkeys:
Increase speed: **CTRL + NUMPAD PLUS**
Decrease speed: **CTRL + NUMPAD MINUS**

**Power** Sets the magnification level used by DocReader, from 1x to 36x in steps of 1x.

Hotkeys:
Increase magnification: **ALT + NUMPAD PLUS**
Decrease magnification: **ALT + NUMPAD MINUS**
**Ticker**  Displays a single line of text, with a 1x view of the captured document. When reading, text scrolls horizontally like a ticker tape.

Shortcut Key: T

**Prompter**  Displays multiple wrapped lines of text that do not exceed the width of the DocReader screen. When reading, text scrolls vertically like a teleprompter.

Shortcut Key: P

**Settings**  Opens the Reading dialog box to change the DocReader settings.

Shortcut Key: E

**Speech**  Opens the Speech dialog box to change the speech settings.

Shortcut Key: S

**Exit**  Exits DocReader and activates the source application. The application's cursor (if exists) is positioned at the last spoken word.

Shortcut Keys: X or ESC
**DocReader Settings**

The DocReader settings allow you to customize the appearance of text and word highlighting in the DocReader environment.

- **To adjust the DocReader settings**
  1. In the **Reader** menu, choose **DocReader**...
     
     *The Reading dialog appears with the DocReader tab displayed.*
  2. Adjust the DocReader settings as desired.
  3. Select the **OK** button.
The following table describes the DocReader settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use fonts and styles from the captured document ¹</td>
<td>When selected, the font types and styles used in the captured document are preserved.</td>
</tr>
<tr>
<td>Font ²</td>
<td>Sets the font type that the captured document will be displayed in, such as Arial, Tahoma, or Verdana.</td>
</tr>
<tr>
<td>Style ²</td>
<td>Sets the font style that the captured document will be displayed in, such as Regular, Bold or Italic.</td>
</tr>
<tr>
<td>Use colors from captured document ¹</td>
<td>When selected, text colors used in the captured document are preserved.</td>
</tr>
<tr>
<td>Text ³</td>
<td>Selects the text color that the captured document will be displayed in. The text and background cannot be set to the same color.</td>
</tr>
<tr>
<td>Background ³</td>
<td>Selects the background color for the DocReader screen. The text and background cannot be set to the same color.</td>
</tr>
<tr>
<td>Shape</td>
<td>Selects the shape used for word highlighting: Block, Underline, Frame, or Wedge.</td>
</tr>
</tbody>
</table>

*(Continued)*
<table>
<thead>
<tr>
<th>Color</th>
<th>Sets the color of the word highlight.</th>
</tr>
</thead>
<tbody>
<tr>
<td>Thickness ¹, ⁴</td>
<td>Sets the thickness of the word highlight.</td>
</tr>
<tr>
<td>Transparency ⁴</td>
<td>Sets the transparency of the word highlight.</td>
</tr>
<tr>
<td>Preview</td>
<td>Displays sample text using the selected font, color and highlight settings.</td>
</tr>
</tbody>
</table>

¹ This setting is not available when highlight shape is set to 'Block'.

² This setting is not available when Use fonts and styles... is selected.

³ This setting is not available when Use colors from the captured document is selected.

⁴ This setting is not available when highlight shape is set to 'Block' or highlight color is set to 'Invert'.

Note: Additional settings for DocReader are available in the Options tab of the Reading dialog (see "Reader Options" in this chapter).
## DocReader Hotkeys

<table>
<thead>
<tr>
<th>General Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>DocReader</td>
<td>ALT + SHIFT + D</td>
</tr>
<tr>
<td>Toggle Reading (Play/Pause)</td>
<td>ENTER</td>
</tr>
<tr>
<td>Increase Magnification</td>
<td>ALT + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Magnification</td>
<td>ALT + NUMPAD MINUS</td>
</tr>
<tr>
<td>Increase Reading Rate</td>
<td>CTRL + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Reading Rate</td>
<td>CTRL + NUMPAD MINUS</td>
</tr>
<tr>
<td>Quiet</td>
<td>CTRL</td>
</tr>
<tr>
<td>Exit</td>
<td>ESC</td>
</tr>
</tbody>
</table>

<table>
<thead>
<tr>
<th>Navigation Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Previous Word</td>
<td>CTRL + LEFT, or LEFT</td>
</tr>
<tr>
<td>Say Current Word *</td>
<td>CTRL + NUMPAD 5, or SPACEBAR</td>
</tr>
<tr>
<td>Say Next Word</td>
<td>CTRL + RIGHT, or RIGHT</td>
</tr>
<tr>
<td>Say Word Above</td>
<td>UP</td>
</tr>
<tr>
<td>Say Word Below</td>
<td>DOWN</td>
</tr>
<tr>
<td>Say Previous Sentence</td>
<td>CTRL + ALT + LEFT</td>
</tr>
<tr>
<td>Say Current Sentence</td>
<td>CTRL + ALT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Sentence</td>
<td>CTRL + ALT + RIGHT</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Command</th>
<th>Shortcut</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Previous Paragraph</td>
<td>CTRL + UP</td>
</tr>
<tr>
<td>Say Current Paragraph</td>
<td>CTRL + SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Paragraph</td>
<td>CTRL + DOWN</td>
</tr>
<tr>
<td>Say First Word On Line</td>
<td>HOME</td>
</tr>
<tr>
<td>Say Last Word On Line</td>
<td>END</td>
</tr>
<tr>
<td>Previous Page</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>Next Page</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>Beginning of Document</td>
<td>CTRL + HOME</td>
</tr>
<tr>
<td>End of Document</td>
<td>CTRL + END</td>
</tr>
<tr>
<td>Next Link</td>
<td>TAB</td>
</tr>
<tr>
<td>Previous Link</td>
<td>SHIFT + TAB</td>
</tr>
<tr>
<td>Execute Link</td>
<td>CTRL + ENTER</td>
</tr>
</tbody>
</table>

* Repeated presses of the Say Current Word command provides the following behavior:

- First press: speaks the word
- Second press: spells the word
- Third press: spells the word phonetically ("Alpha, Bravo, Charlie, ...")

**Note:** Repeated presses must occur within two seconds.
Reading Zones

Reading zones let you instantly see and hear selected locations in an application window. For example, your database application may display a dozen or more fields of information. In your normal work flow you may be interested in only a few of these fields. With reading zones, you can instantly see and/or hear these select fields with the press of a hotkey.

You can create up to 10 reading zones for each of your applications. As you open and switch applications, zones defined for the active application are automatically loaded and ready to use.

Reading Zones Toolbar

The Reading Zones toolbar appears over the active reading zone whenever you access reading zones. The toolbar provides controls for navigating and reading the defined zones.

Reading Zones toolbar: Edit and Navigate modes
Reading Zones toolbar: Trigger mode
**Play/Pause/Stop**  Starts and stops reading. When Play mode is executed, the Pause or Stop button appears on the toolbar (according to the mode that is active). The Pause button appears in Trigger and Navigate modes where you can pause and restart reading at the highlighted word. The Stop button appears in Edit mode where reading always restarts at the first word in the zone.

Shortcut Key: **ENTER**

**Previous**  Activates the previous reading zone.

Shortcut Key: **SHIFT + TAB**

Note: This button does not appear in 'Trigger' mode.

**Next**  Activates the next reading zone.

Shortcut Key: **TAB**

Note: This button does not appear in 'Trigger' mode.

**Close**  Exits the Reading Zone mode.

Shortcut Key: **ESC**
Creating, Editing and Deleting Reading Zones

Creating a new reading zone is a straightforward process. For most new zones, you simply define the zone area, type in a descriptive zone name, and choose to have the zone displayed, spoken or both. You can always edit or delete the zone later, so there's no need to worry about mistakes.

To create a reading zone

1. Open the application in which you want to create a reading zone. Make sure the desired application tab, view or window is displayed.

2. Switch to the ZoomText user interface.


   The New Zone Tool becomes active and all existing zones for the active application are displayed.

   Hotkey: CTRL + ALT + Z

4. Move the mouse pointer to scroll the new zone area into view.

5. Hold down the left button, drag the selection rectangle over the desired zone area and release the button.

   When you complete the drag (release the mouse button) the Reading Zones dialog appears. This dialog allows you to name the zone and select zone options. For information on the Reading Zones dialog, see "Reading Zones Settings" in this chapter.
6. In the **Zone Name** box, type a descriptive name for the new zone.

   *When you navigate to the next dialog control, the new zone name will appear in the Zones list.*

7. Under **Zone is relative to**, select the zone's relative position within the application window.

8. Under **Zone Actions**, select the desired options.

9. To test the new zone, click **Trigger**.

   *The Reading Zones dialog is temporarily hidden while the zone is displayed and/or spoken according to the selected settings.*

10. To create additional zones, click **New Zone** and repeat steps 4 through 9.

11. When you're finished creating and editing zones, click the **OK** button.
To edit a reading zone

1. Open the application that contains the reading zone that you want to edit.

2. Switch to the ZoomText user interface.

3. On the Reader toolbar, select Zones ▶ Edit.

   The Edit Zones Tool becomes active and all existing zones for the active application are displayed. The Reading Zones toolbar appears over the active zone.

   Hotkey: CTRL + ALT + E

4. Move the mouse pointer to scroll the desired zone into view, or click the Next or Previous buttons on the Reading Zones toolbar.

   Note: The Next and Previous buttons are grayed if only one zone has been defined.

5. Click inside the zone to activate the sizing handles and toolbar.

6. To size the zone, drag any handle.

7. To move the zone, drag inside the zone frame.

8. To test reading of the zone, click the Play button.

9. To move to another zone, press the number of the desired zone, or click the Next or Previous buttons.

10. To edit another zone, repeat steps 4 through 8.

11. To exit the Edit Zones tool, right-click or press ESC.
To delete a reading zone

1. On the Reader toolbar, select Zones ▶ Settings...
   The Reading Zones dialog appears.

2. In the Show zones defined for combo box, select the application that contains the zone you wish to delete.
   The Zones list updates to display zones associated with the selected application.

3. In the Zones listbox, select the zone you wish to delete.

4. Click the Delete button.
   The deleted zone is removed from the Zones list.

5. To delete another zone, repeat steps 2 through 4.

6. When you're finished deleting zones, click the OK button.

Using Reading Zones

Once you've created reading zones for an application, you can use them any time the application is active. You can trigger a single zone at a time (via menu or hotkey), or enter a mode that allows you to navigate through all of the reading zones.
To trigger a specific reading zone

1. Open the application that contains the reading zones you want to trigger.

2. On the Reader toolbar, select Zones ➤ Trigger, then select the desired reading zone.

   The selected reading zone is displayed and/or spoken according to the zone settings.

<table>
<thead>
<tr>
<th>Hotkey:</th>
<th>CTRL + ALT + {reading zone number}</th>
</tr>
</thead>
<tbody>
<tr>
<td>Each applications set of reading zones are numbered 1 through 10. Reading zone hotkeys correspond to these numbers. For example, the hotkey for reading zone 1 is CTRL + ALT + 1, reading zone 2 is CTRL + ALT + 2, and so on.</td>
<td></td>
</tr>
</tbody>
</table>

**Note:** The hotkey for reading zone 10 is CTRL + ALT + 0.

You can also trigger reading zones using the following methods:

- Press the **List Reading Zones** hotkey: CTRL + ALT + L, then select the desired zone from the menu.

- Use the **Next** and **Previous** Reading Zone hotkeys:

<table>
<thead>
<tr>
<th>To trigger...</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Next Reading Zone</td>
<td>CTRL + ALT + N</td>
</tr>
<tr>
<td>Previous Reading Zone</td>
<td>CTRL + ALT + P</td>
</tr>
</tbody>
</table>
To navigate through all reading zones

1. Open the application that contains the reading zones you want to navigate.

2. On the Reader toolbar, select Zones ▶ Navigate.

   Navigate Mode becomes active and the Reading Zones toolbar appears over the first active zone. The zone name and number are spoken.

   Hotkey:  CTRL + ALT + V

3. To start and stop reading of the zone, click the Play/Pause button.

   Note: The Play/Pause button is disabled (grayed-out) when navigating to non-spoken zones.

4. To navigate to another zone, click the Next and Previous buttons.

5. To exit Navigate Mode, click the Exit button on the Navigate toolbar. You can also exit by right-clicking or pressing ESC.
Reading Zones Settings

The Reading Zones settings allow you to create, examine and edit reading zones. When activated, the Reading Zones dialog displays a list of zones that have been defined in the current application. By selecting a zone in the Zones list, you can modify its settings, trigger the zone, or delete the zone. You can also create new zones or navigate through all zones in the current application.

For complete information on creating, editing, navigating and triggering zones, see "Reading Zones" in this chapter.

▶ To adjust the reading zone settings

1. In the Reader menu, choose Reading Zones...

   The Reading dialog appears with the Zones tab displayed.

2. Adjust the reading zone settings as desired.

3. Select the OK button.
The following table describes the Reading Zones settings.

### Reading Zones dialog

<table>
<thead>
<tr>
<th>Zone Name</th>
<th>Zone Actions</th>
<th>Zone is relative to</th>
</tr>
</thead>
<tbody>
<tr>
<td>My Zone 1</td>
<td>-&lt;br&gt;- Dim area outside of zone</td>
<td>-&lt;br&gt;- Center</td>
</tr>
<tr>
<td>Setting</td>
<td>Description</td>
<td></td>
</tr>
<tr>
<td>-------------------------</td>
<td>---------------------------------------------------------------------------------------------------------------------------------------------</td>
<td></td>
</tr>
<tr>
<td>Show zones defined for</td>
<td>Displays a list of applications that are currently running. Zones associated with the selected application appear in the <strong>Zones</strong> listbox.</td>
<td></td>
</tr>
<tr>
<td>Zones</td>
<td>Displays a list of zones associated with the selected application (selected in the <strong>Show zones defined for</strong> listbox).</td>
<td></td>
</tr>
<tr>
<td>Hotkey</td>
<td>Displays the hotkey for the selected zone.</td>
<td></td>
</tr>
<tr>
<td>Edit</td>
<td>Activates the <strong>Edit Zone</strong> tool. When activated, the Reading Zones dialog is hidden and zones associated with the selected application appear. The <strong>Edit Zone</strong> tool also appears allowing you to size and move any of the zones.</td>
<td></td>
</tr>
<tr>
<td>Delete</td>
<td>Deletes the selected zone.</td>
<td></td>
</tr>
<tr>
<td>Trigger</td>
<td>Triggers the selected zone. When triggered, the Reading Zones dialog is hidden and the selected zone is displayed and spoken according to its zone settings. Afterward, the Reading Zone dialog reappears.</td>
<td></td>
</tr>
</tbody>
</table>

*(Continued)*
| **New Zone** | Activates the **New Zone** tool. When selected, the Reading Zones dialog is hidden and zones associated with the selected application appear. The **New Zone** tool also appears allowing you to create a new zone. |
| **Navigate Zones** | Activates the Zone Navigation mode. When activated, the Reading Zones dialog is hidden and the selected zone and Navigation toolbar appear. Using the toolbar controls or keyboard commands, you can start and stop reading of the zone, and navigate to the next or previous zone. |
| **Zone Name** | Allows you to type a meaningful name for the selected zone. Zone names appear in the **Zones** listbox (in the Readings Zones dialog). They also appear in the Reading Zones menu (when pressing the Reading Zones List hotkey: **CTRL + ALT + L**) and when clicking **Zones ▸ Trigger** on the **Reader** toolbar. |
| Zone is relative to | Sets the relative position of the zone within the application window: top-left, top-right, bottom-left, bottom-right, or center. This keeps the zone in the correct location even when the application window has been resized or moved.  
**Note:** In some cases, when resizing an application window, controls within the window may also be resized. When this occurs, you may need to resize the individual zones. |
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Speak text in zone</td>
<td>When the reading zone is triggered, all text within the zone is spoken.</td>
</tr>
<tr>
<td>Display zone</td>
<td>When the reading zone is triggered, the zone is scrolled into view and highlighted.</td>
</tr>
<tr>
<td>Display and speak zone</td>
<td>When the reading zone is triggered, the zone is scrolled into view, highlighted and spoken.</td>
</tr>
</tbody>
</table>
| Highlight zone for | Sets the amount of time (in seconds) that the reading zone is highlighted.  
**Note:** Highlighting only occurs when **Scroll to zone** is selected. |
| Return to previous location | After the zone is displayed, ZoomText scrolls back to the location that was in view prior to triggering the zone. |
| Dim area outside of zone | When a reading zone is triggered, the area outside of the reading zone is dimmed. |
Reading Options

Reading Options contain additional settings for AppReader and DocReader. You can set an independent reading rate for AppReader and DocReader, select how highlighted words are tracked and aligned, and activate the display of format marks in DocReader. Format marks appear in the DocReader's Prompter and Ticker displays, and indicate the layout of text in the source document.

To adjust the reading options

1. In the Reader menu, choose Reading Options...

   The Reading dialog appears with the Options tab displayed.

2. Adjust the reading options as desired.

3. Select the OK button.
Chapter 4  Screen Reading Features  •  201

The following table describes the AppReader and DocReader Options settings.

Options tab
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use screen reading speech rate</td>
<td>When selected, AppReader and DocReader reading rate are set by the Rate setting in the Speech dialog (Synthesizer tab).</td>
</tr>
<tr>
<td>Rate</td>
<td>Controls the reading rate for AppReader and DocReader in words per minute (ranges vary with speech synthesizers).</td>
</tr>
<tr>
<td></td>
<td><strong>Note:</strong> This setting is disabled when <strong>Use screen reading speech rate</strong> is selected.</td>
</tr>
<tr>
<td>AppReader</td>
<td>Sets the tracking type for AppReader: Edge, Center or Jump Ahead. With Edge alignment, the zoom window only scrolls as needed to keep the highlighted word in view. With Center alignment, the zoom window scrolls as needed to keep the highlighted word in the center of the zoom window. With Jump Ahead, when the highlighted word exits the magnified view, the zoom window scrolls to bring the highlighted word to the upper left corner.</td>
</tr>
</tbody>
</table>
**DocReader** | Sets the tracking type for DocReader: Edge, Center or Jump Ahead. With Edge alignment, DocReader scrolls as needed to keep the highlighted word in view. With Center alignment, DocReader scrolls as needed to keep the highlighted word in the center of the zoom window. With Jump Ahead, when the highlighted word exits the view, DocReader scrolls to bring the highlighted word to the upper left corner.

| **Show paragraph marks** | Displays paragraph marks where paragraphs end in the source document. |
| **Show line break marks** | Displays end of line marks where bulleted and numbered list items end in the source document. |
| **Show indent marks** | Displays indent marks where indents occur in the source document. |
| **Show space marks** | Displays space marks where extended space, such as tabs, occur in the source document. |

*(Continued)*
<table>
<thead>
<tr>
<th>Feature</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Show end of cell marks</td>
<td>Displays end of cell marks where text ends in each table cell.</td>
</tr>
<tr>
<td>Show end of frame marks</td>
<td>Displays end of frame marks where text ends in a web page frame.</td>
</tr>
<tr>
<td>Underline links</td>
<td>When selected, hypertext links are underlined in the Prompter and Ticker view.</td>
</tr>
</tbody>
</table>


**SpeakIt Tool**

The SpeakIt tool allows you to read selected areas of the screen by clicking or dragging with the mouse. Any text that is visible on the screen can be spoken, even if it is outside the active program.

**Note:** Text that appears in graphical images cannot be spoken.

**To use the SpeakIt tool**

1. On the Reader toolbar, select the **SpeakIt Tool**.
   
   *The SpeakIt tool becomes active.*
   
   **Hotkey:** **ALT + SHIFT + I**

2. To speak a single word, click on the word.

3. To speak a block of text; hold down the left button, drag the selection rectangle over the text you want to read and release the mouse button.
   
   *When you complete the drag (release the mouse button), all highlighted text will be spoken.*

4. To exit the SpeakIt tool, right-click or press **ESC**.

**Note:** The SpeakIt tool can be used when speech is disabled.
Reading the Windows Clipboard

The Windows Clipboard allows you to copy and move information within or between documents. Each time you use an application's Cut or Copy command, the selected information is placed in the Windows clipboard. Then, when you use the Paste command, the information in the clipboard is inserted into your document at the selected location.

At times you may want to hear what is in the Windows clipboard. This is easily accomplished using ZoomText's Read Clipboard command.

- **To read the Windows Clipboard**
  1. Press the Say Clipboard command: **ALT + SHIFT + C**.
  2. To terminate reading of the clipboard, press the **CTRL** key.

**Note:** The Read Clipboard command is useful for reading text from problem applications that do not display text in a screen reader friendly format.
Text Reading Hotkeys

Text reading hotkeys let you navigate and read while creating and editing documents (by word, line, sentence or paragraph). When using these commands, the text cursor moves in accordance with the command. For example, when pressing the Say Next Sentence command, the cursor moves to the beginning of the next sentence and the entire sentence is spoken. The following table lists the text reading commands.

**Note:** Num Lock must be turned off when using ZoomText commands that use the numeric keypad.

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Previous Character</td>
<td>LEFT</td>
</tr>
<tr>
<td>Say Current Character ¹</td>
<td>NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Character</td>
<td>RIGHT</td>
</tr>
<tr>
<td>Say Previous Word</td>
<td>CTRL + LEFT</td>
</tr>
<tr>
<td>Say Current Word ²</td>
<td>CTRL + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Word</td>
<td>CTRL + RIGHT</td>
</tr>
<tr>
<td>Say Previous Sentence</td>
<td>CTRL + ALT + LEFT</td>
</tr>
<tr>
<td>Say Current Sentence</td>
<td>CTRL + ALT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Sentence</td>
<td>CTRL + ALT + RIGHT</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Say Previous Line 3</th>
<th>UP</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Current Line</td>
<td>SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Line ³</td>
<td>DOWN</td>
</tr>
<tr>
<td>Say Previous Paragraph</td>
<td>CTRL + UP</td>
</tr>
<tr>
<td>Say Current Paragraph</td>
<td>CTRL + SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Paragraph</td>
<td>CTRL + DOWN</td>
</tr>
</tbody>
</table>

¹ Second press of the Say Current Character command speaks the character phonetically ("Alpha, Bravo, Charlie, ...").

² Repeated presses of the Say Current Word command provides the following behavior:

- First press: speaks the word
- Second press: spells the word
- Third press: spells the word phonetically ("Alpha, Bravo, Charlie, ...")

**Note:** Repeated presses must occur within two seconds.

³ This command reads the current word or entire line according to the Program Echo setting **When the text cursor moves into a new line.**

In addition to the Text Reading commands listed above, ZoomText will also speak when using standard text navigation and editing keys, listed in the following table.
<table>
<thead>
<tr>
<th>Keys</th>
<th>Application Action</th>
<th>ZoomText Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACKSPACE</td>
<td>Deletes the character to the left of the cursor.</td>
<td>Speaks the deleted character.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Deletes the character to the right of the cursor.</td>
<td>Speaks the new character to the right of the cursor.</td>
</tr>
<tr>
<td>HOME</td>
<td>Moves the cursor to the beginning of the line.</td>
<td>Speaks the first word on the line (or nothing if the line begins with a space or tab).</td>
</tr>
<tr>
<td>END</td>
<td>Moves the cursor to the end of the line.</td>
<td>Speaks &quot;End of line.&quot;</td>
</tr>
<tr>
<td>PAGEUP</td>
<td>Pages the application window up.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Command</th>
<th>Description</th>
<th>Notes</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAGEDOWN</td>
<td>Pages the application window down.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting 'When the text cursor moves to a new line.'</td>
</tr>
<tr>
<td>CTRL + HOME</td>
<td>Moves to beginning of the document.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting 'When the text cursor moves to a new line.'</td>
</tr>
<tr>
<td>CTRL + END</td>
<td>Moves to the end of the document.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting 'When the text cursor moves to a new line.'</td>
</tr>
</tbody>
</table>
Preferences are convenience features that control how ZoomText starts, exits and appears on the Windows desktop while running. You can also enable Automatic Updating, so that ZoomText automatically checks for available online updates each time you launch the program.

### Program Preferences

Program preferences control how ZoomText starts and exits, and allows you to enable automatic updating.

- **To adjust the program preferences**
  1. In the **Settings** menu, choose **Program**...
     
     The Preferences dialog appears with the Program tab displayed.
  2. Adjust the program preference options as desired.
  3. Select the **OK** button.
Program tab

The following table describes the Program preference settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start ZoomText automatically</td>
<td>ZoomText will automatically run each time you start your system.</td>
</tr>
<tr>
<td>Run ZoomText minimized</td>
<td>The ZoomText user interface is minimized when ZoomText is started.</td>
</tr>
<tr>
<td>Display a ZoomText icon</td>
<td>Displays the ZoomText desktop icon.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Preference</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Start ZoomText from a shortcut key</td>
<td>Enables ZoomText to be started by pressing a shortcut key. The box to the right provides a space for you to define (type) the keyboard shortcut for starting or switching to ZoomText. Shortcut keys consist of a two modifier keys (any combination of <code>CTRL</code>, <code>ALT</code>, and <code>SHIFT</code>), and a primary key (any letter, number or symbol). For example, to define the ZoomText shortcut key as <code>CTRL + SHIFT + Z</code>, select the Shortcut key field, and then press <code>CTRL</code>, <code>SHIFT</code> and <code>Z</code> simultaneously. <strong>Note:</strong> When <strong>Start ZoomText from a shortcut key</strong> is enabled, no other program can use the defined shortcut key.</td>
</tr>
<tr>
<td>Save ZoomText settings automatically</td>
<td>All ZoomText settings are saved to the active configuration when the program exits.</td>
</tr>
<tr>
<td>Prompt before exiting ZoomText</td>
<td>You are prompted to confirm your choice to exit the program.</td>
</tr>
<tr>
<td><strong>Check for online updates</strong></td>
<td>Each time you start ZoomText, if an Internet connection is established, ZoomText will check the Ai Squared website for available program updates. If updates are available, the Update Wizard will give you the option to download and install the updates.</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td><strong>Report ZoomText errors to Ai Squared</strong></td>
<td>When a ZoomText program error occurs, an error report is transmitted to Ai Squared via the Internet (if an active Internet connection exists). No personal information is included in the error report.</td>
</tr>
</tbody>
</table>
User Interface Preferences

User interface preferences control how the ZoomText user interface appears on the Windows desktop.

To adjust the user interface preferences
1. In the Settings menu, choose User Interface...
   The Preferences dialog appears with the User Interface tab displayed.
2. Adjust the user interface options as desired.
3. Select the OK button.

User Interface tab
The following table describes the User Interface settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Always on top</td>
<td>The ZoomText user interface window will remain on top of all other windows, even when ZoomText is not the active application.</td>
</tr>
<tr>
<td>Restore toolbar after using tool</td>
<td>The ZoomText toolbar is always restored when exiting a ZoomText tool.</td>
</tr>
<tr>
<td>Display the status bar</td>
<td>Displays the name of the active application and informs you when ZoomText's reading tools, reading zones and application settings are available to be used.</td>
</tr>
<tr>
<td>Highlight toolbar buttons</td>
<td>When the mouse moves over buttons on ZoomText's toolbar, the buttons are highlighted.</td>
</tr>
<tr>
<td>Color</td>
<td>Selects the color for button highlighting.</td>
</tr>
<tr>
<td>Display taskbar button and tray icon</td>
<td>When ZoomText is running, its taskbar button and tray icon are both displayed.</td>
</tr>
<tr>
<td>Display taskbar button only</td>
<td>When ZoomText is running, only its taskbar button is displayed.</td>
</tr>
<tr>
<td>Display tray icon only</td>
<td>When ZoomText is running, only its system tray icon is displayed.</td>
</tr>
<tr>
<td>Language</td>
<td>Selects the language that the ZoomText user interface will appear in.</td>
</tr>
</tbody>
</table>

**Note:** This option is not available in English only versions.
Windows Vista Preferences

Windows Vista preferences allow you to enable ZoomText's logon support and disable Windows ClearType font smoothing for improved quality of ZoomText's magnified text.

Note: The Windows Vista preferences only appear when running ZoomText in Windows Vista.

To adjust the Windows Vista preferences

1. In the Settings menu, choose Windows Vista...

   The Preferences dialog appears with the Windows Vista tab displayed.

2. Adjust the Windows Vista options as desired.

3. Select the OK button.
The following table describes the Windows Vista settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable ZoomText's logon support</td>
<td>Enables ZoomText's magnification and screen reading support in the Windows Vista logon screen. The ZoomText logon toolbar is also displayed allowing you to adjust the magnification level, invert the screen colors, and turn screen reading on and off.</td>
</tr>
</tbody>
</table>

(Continued)
| **Disable font smoothing** | Disables Windows font smoothing option, allowing ZoomText to display the highest quality of magnified text. When Windows font smoothing is enabled, some of ZoomText magnified text may be degraded. This Windows font smoothing option can also be enable and disabled in Windows Appearance Settings dialog. To access these settings, in the Windows Control Panel, select **Personalization** → **Window Color and Appearance**.  
**Note:** When selecting this option and clicking the OK button, you will be prompted to restart your system. Restarting the system insures that font smoothing has been disabled in all applications. |
| **When starting ZoomText, prompt if smoothing is enabled** | When you start ZoomText, if the Windows font smoothing option is enabled ZoomText will prompt you with the option to disable font smoothing.  
**Note:** If you choose to disable font smoothing you will be prompted to restart your system. |
Hotkeys are key combinations that execute ZoomText commands without having to activate the ZoomText user interface. Hotkeys exist for almost all ZoomText features, allowing you to control ZoomText while another program is active.

Some important facts about ZoomText hotkeys are:

- Individual hotkeys can be changed or disabled to eliminate conflicts with other programs.
- Keys and mouse buttons can be used to define a hotkey.
- Each hotkey must be unique.

**Hotkey Combinations**

Each hotkey consists of one or more modifier keys and a single primary key. The modifier keys consist of any combination of ALT, CTRL, SHIFT, CAPS LOCK and the Windows Key. The primary key can be any other key or any mouse button.
Hotkeys Dialog Box

All ZoomText hotkeys can be examined and modified in the Hotkeys dialog box.

![Hotkeys dialog]

The following table describes the Hotkeys settings.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hotkey Group</td>
<td>Selects a group of related hotkeys. The hotkeys in the selected group appear in the Hotkey Command list.</td>
</tr>
<tr>
<td>Hotkey Command</td>
<td>Displays a list of all hotkeys in the selected hotkey group. When a hotkey is highlighted, its primary and modifier keys are displayed.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th><strong>Primary Key</strong></th>
<th>Sets the primary key for the highlighted hotkey command. Any key in the drop down list can be selected, including mouse buttons.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Modifier Keys</strong></td>
<td>Sets the modifier keys for the highlighted hotkey command. One or more modifier keys must be selected.</td>
</tr>
<tr>
<td><strong>Disable Hotkey</strong></td>
<td>Disables a hotkey command from functioning. When a hotkey is disabled, the primary and modifier keys are grayed out. Click on the <strong>Enable Hotkey</strong> button to re-enable the hotkey.</td>
</tr>
<tr>
<td><strong>Restore Defaults</strong></td>
<td>Restores all hotkeys to their original settings.</td>
</tr>
<tr>
<td><strong>Configuration File</strong></td>
<td>Displays the name of the configuration file associated with a Load Configuration hotkey. For more information, see Chapter 7 - &quot;Configuration Files.&quot;</td>
</tr>
</tbody>
</table>
| **Browse...** | Displays the Select Configuration dialog box, which lists the existing configuration files. A configuration file can be assigned to a Load Configuration hotkey by selecting the desired file and choosing **OK**.  
**Note:** The **Browse** button is only enabled when a Load Configuration hotkey command is highlighted. |
Changing Hotkey Settings

▶ To change hotkey settings
   1. In the Settings menu, choose Hotkeys...
      
      *The Hotkeys dialog appears.*
   2. Select the desired Hotkey Group and Hotkey Command.
   3. Adjust the hotkey combination as desired.
   4. Repeat steps 2 and 3 for each hotkey you wish to modify.
   5. Click the OK button.

▶ To assign a configuration file to a configuration hotkey
   1. In the Settings menu, choose Hotkeys...
      
      *The Hotkeys dialog appears.*
   2. In the Hotkeys Group box, select Configuration Hotkeys.
   3. In the Hotkey Command box, select the desired configuration hotkey.
   4. Click on the Browse button.
   5. In the Select Configuration dialog box, select the desired configuration file.
   6. Click on the OK button.
Passing Hotkeys to the Current Application

When a key combination is assigned to a ZoomText hotkey, this command will only be processed by ZoomText. If the key combination is also used by the current application, this program will not respond to the command. However, you can force ZoomText to pass a hotkey to the current application.

- **To pass a hotkey to the current application**
  1. Press the Pass Thru hotkey: ALT + PAUSE
  2. Press the desired key combination.

  *The current application will process the key combination.*
ZoomText Hotkeys

The following tables list the command names and default assignments for all ZoomText hotkeys (by Hotkey Group). Hotkey assignments can be changed in the Hotkeys dialog box.

Note: AppReader and DocReader 'Navigation Commands' and all 'Text Reading Commands' have fixed key assignments that cannot be changed. These commands do not appear in the Hotkeys dialog.

AppReader and DocReader Hotkeys *(Magnifier/Reader only)*

<table>
<thead>
<tr>
<th>General Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>AppReader</td>
<td>ALT + SHIFT + A</td>
</tr>
<tr>
<td>DocReader</td>
<td>ALT + SHIFT + D</td>
</tr>
<tr>
<td>Toggle Reading (Play/Pause)</td>
<td>ENTER</td>
</tr>
<tr>
<td>Increase Magnification</td>
<td>ALT + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Magnification</td>
<td>ALT + NUMPAD MINUS</td>
</tr>
<tr>
<td>Increase Reading Rate</td>
<td>CTRL + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Reading Rate</td>
<td>CTRL + NUMPAD MINUS</td>
</tr>
<tr>
<td>Quiet</td>
<td>CTRL</td>
</tr>
<tr>
<td>Exit</td>
<td>ESC</td>
</tr>
<tr>
<td>Navigation Commands</td>
<td>Keys</td>
</tr>
<tr>
<td>-----------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Say Previous Word</td>
<td>CTRL + LEFT, or LEFT</td>
</tr>
<tr>
<td>Say Current Word</td>
<td>CTRL + NUMPAD 5, or SPACEBAR</td>
</tr>
<tr>
<td>Say Next Word</td>
<td>CTRL + RIGHT, or RIGHT</td>
</tr>
<tr>
<td>Say Word Above</td>
<td>UP</td>
</tr>
<tr>
<td>Say Word Below</td>
<td>DOWN</td>
</tr>
<tr>
<td>Say Previous Sentence</td>
<td>CTRL + ALT + LEFT</td>
</tr>
<tr>
<td>Say Current Sentence</td>
<td>CTRL + ALT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Sentence</td>
<td>CTRL + ALT + RIGHT</td>
</tr>
<tr>
<td>Say Previous Paragraph</td>
<td>CTRL + UP</td>
</tr>
<tr>
<td>Say Current Paragraph</td>
<td>CTRL + SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Paragraph</td>
<td>CTRL + DOWN</td>
</tr>
<tr>
<td>Say First Word On Line</td>
<td>HOME</td>
</tr>
<tr>
<td>Say Last Word On Line</td>
<td>END</td>
</tr>
<tr>
<td>Page Up</td>
<td>PAGE UP</td>
</tr>
<tr>
<td>Page Down</td>
<td>PAGE DOWN</td>
</tr>
<tr>
<td>Beginning of Document</td>
<td>CTRL + HOME</td>
</tr>
<tr>
<td>End of Document</td>
<td>CTRL + END</td>
</tr>
<tr>
<td>Next Link</td>
<td>TAB</td>
</tr>
<tr>
<td>Previous Link</td>
<td>SHIFT + TAB</td>
</tr>
<tr>
<td>Execute Link</td>
<td>CTRL + ENTER</td>
</tr>
</tbody>
</table>
## Configuration Hotkeys

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Load Configuration 1</td>
<td>ALT + SHIFT + 1</td>
</tr>
<tr>
<td>Load Configuration 2</td>
<td>ALT + SHIFT + 2</td>
</tr>
<tr>
<td>Load Configuration 3</td>
<td>ALT + SHIFT + 3</td>
</tr>
<tr>
<td>Load Configuration 4</td>
<td>ALT + SHIFT + 4</td>
</tr>
<tr>
<td>Load Configuration 5</td>
<td>ALT + SHIFT + 5</td>
</tr>
<tr>
<td>Load Configuration 6</td>
<td>ALT + SHIFT + 6</td>
</tr>
<tr>
<td>Load Configuration 7</td>
<td>ALT + SHIFT + 7</td>
</tr>
<tr>
<td>Load Configuration 8</td>
<td>ALT + SHIFT + 8</td>
</tr>
<tr>
<td>Load Configuration 9</td>
<td>ALT + SHIFT + 9</td>
</tr>
<tr>
<td>Load Configuration 10</td>
<td>ALT + SHIFT + 0</td>
</tr>
<tr>
<td>Save Application Settings</td>
<td>CTRL + SHIFT + S</td>
</tr>
</tbody>
</table>

## Magnification Hotkeys

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Increase Magnification</td>
<td>ALT + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Magnification</td>
<td>ALT + NUMPAD MINUS</td>
</tr>
</tbody>
</table>
## Magnifier Toolbar Hotkeys

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Window Type</td>
<td>CTRL + SHIFT + Z</td>
</tr>
<tr>
<td>Adjust Window Tool</td>
<td>CTRL + SHIFT + A</td>
</tr>
<tr>
<td>Dual Monitor On/Off</td>
<td>WINDOWS + SHIFT + D</td>
</tr>
<tr>
<td>Dual Monitor View</td>
<td>WINDOWS + SHIFT + Z</td>
</tr>
<tr>
<td>Freeze Tool</td>
<td>CTRL + SHIFT + N</td>
</tr>
<tr>
<td>Freeze Window On/Off</td>
<td>CTRL + SHIFT + E</td>
</tr>
<tr>
<td>Color Enhancements On/Off</td>
<td>CTRL + SHIFT + C</td>
</tr>
<tr>
<td>Pointer Enhancements On/Off</td>
<td>CTRL + SHIFT + P</td>
</tr>
<tr>
<td>Cursor Enhancements On/Off</td>
<td>CTRL + SHIFT + R</td>
</tr>
<tr>
<td>Focus Enhancements On/Off</td>
<td>CTRL + SHIFT + O</td>
</tr>
<tr>
<td>Font Enhancements Type</td>
<td>CTRL + SHIFT + F</td>
</tr>
<tr>
<td>Desktop Finder</td>
<td>CTRL + SHIFT + D</td>
</tr>
<tr>
<td>Web Finder</td>
<td>CTRL + SHIFT + W</td>
</tr>
<tr>
<td>Text Finder</td>
<td>CTRL + SHIFT + T</td>
</tr>
<tr>
<td>Commands</td>
<td>Keys</td>
</tr>
<tr>
<td>-------------------------------</td>
<td>-------------------------------</td>
</tr>
<tr>
<td>Locator On/Off</td>
<td>CTRL + SHIFT + L</td>
</tr>
<tr>
<td>View Mode On/Off</td>
<td>CTRL + SHIFT + V</td>
</tr>
<tr>
<td>Move Mouse To View</td>
<td>CTRL + SHIFT + B</td>
</tr>
<tr>
<td>Move View To Mouse</td>
<td>CTRL + SHIFT + Y</td>
</tr>
<tr>
<td>Smooth Panning On/Off</td>
<td>WINDOWS + SHIFT + P</td>
</tr>
<tr>
<td>Pass Thru (next hotkey)</td>
<td>ALT + PAUSE</td>
</tr>
<tr>
<td>AHOI On/Off</td>
<td>CTRL + ALT + SHIFT + A</td>
</tr>
<tr>
<td>AHOI Status Report</td>
<td>CTRL + ALT + SHIFT + S</td>
</tr>
<tr>
<td>Capture ZoomText Screen</td>
<td>CTRL + ALT + SHIFT + C</td>
</tr>
<tr>
<td>Cursor Detect</td>
<td>CTRL + ALT + SHIFT + D</td>
</tr>
<tr>
<td>Highlight Detect</td>
<td>CTRL + ALT + SHIFT + H</td>
</tr>
<tr>
<td>MSAA On/Off</td>
<td>CTRL + ALT + SHIFT + M</td>
</tr>
<tr>
<td>Tracking On/Off</td>
<td>CTRL + ALT + SHIFT + T</td>
</tr>
<tr>
<td>Update Screen Model</td>
<td>CTRL + ALT + SHIFT + U</td>
</tr>
</tbody>
</table>
### Reader Toolbar Hotkeys *(Magnifier/Reader only)*

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Speech On/Off</td>
<td>ALT + SHIFT + S</td>
</tr>
<tr>
<td>Increase Speech Rate</td>
<td>CTRL + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Speech Rate</td>
<td>CTRL + NUMPAD MINUS</td>
</tr>
<tr>
<td>Typing Echo Mode</td>
<td>ALT + SHIFT + T</td>
</tr>
<tr>
<td>Mouse Echo Mode</td>
<td>ALT + SHIFT + M</td>
</tr>
<tr>
<td>Verbosity Level</td>
<td>ALT + SHIFT + V</td>
</tr>
<tr>
<td>AppReader</td>
<td>ALT + SHIFT + A</td>
</tr>
<tr>
<td>DocReader</td>
<td>ALT + SHIFT + D</td>
</tr>
<tr>
<td>SpeakIt Tool</td>
<td>ALT + SHIFT + I</td>
</tr>
</tbody>
</table>
### Reading Zones Hotkeys

*(Magnifier/Reader only)*

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Trigger Zone 1</td>
<td>CTRL + ALT + 1</td>
</tr>
<tr>
<td>Trigger Zone 2</td>
<td>CTRL + ALT + 2</td>
</tr>
<tr>
<td>Trigger Zone 3</td>
<td>CTRL + ALT + 3</td>
</tr>
<tr>
<td>Trigger Zone 4</td>
<td>CTRL + ALT + 4</td>
</tr>
<tr>
<td>Trigger Zone 5</td>
<td>CTRL + ALT + 5</td>
</tr>
<tr>
<td>Trigger Zone 6</td>
<td>CTRL + ALT + 6</td>
</tr>
<tr>
<td>Trigger Zone 7</td>
<td>CTRL + ALT + 7</td>
</tr>
<tr>
<td>Trigger Zone 8</td>
<td>CTRL + ALT + 8</td>
</tr>
<tr>
<td>Trigger Zone 9</td>
<td>CTRL + ALT + 9</td>
</tr>
<tr>
<td>Trigger Zone 10</td>
<td>CTRL + ALT + 0</td>
</tr>
<tr>
<td>Next Reading Zone</td>
<td>CTRL + ALT + N</td>
</tr>
<tr>
<td>Previous Reading Zone</td>
<td>CTRL + ALT + P</td>
</tr>
<tr>
<td>List Reading Zones</td>
<td>CTRL + ALT + L</td>
</tr>
<tr>
<td>Navigate Reading Zones</td>
<td>CTRL + ALT + V</td>
</tr>
<tr>
<td>New Reading Zone</td>
<td>CTRL + ALT + Z</td>
</tr>
<tr>
<td>Edit Reading Zones</td>
<td>CTRL + ALT + E</td>
</tr>
</tbody>
</table>
### Screen Reading Hotkeys *(Magnifier/Reader only)*

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Window Title</td>
<td>CTRL + ALT + W</td>
</tr>
<tr>
<td>Say Dialog Tab</td>
<td>CTRL + ALT + T</td>
</tr>
<tr>
<td>Say Dialog Message</td>
<td>CTRL + ALT + M</td>
</tr>
<tr>
<td>Say Focus</td>
<td>CTRL + ALT + F</td>
</tr>
<tr>
<td>Say Default Button</td>
<td>CTRL + ALT + B</td>
</tr>
<tr>
<td>Say Group Name</td>
<td>CTRL + ALT + G</td>
</tr>
<tr>
<td>Say Status Bar</td>
<td>CTRL + ALT + X</td>
</tr>
<tr>
<td>Say All</td>
<td>CTRL + ALT + A</td>
</tr>
<tr>
<td>Say Selected Text</td>
<td>CTRL + ALT + S</td>
</tr>
<tr>
<td>Say Cell Row Title</td>
<td>CTRL + ALT + R</td>
</tr>
<tr>
<td>Say Cell Column Title</td>
<td>CTRL + ALT + K</td>
</tr>
<tr>
<td>Say Cell Formula</td>
<td>CTRL + ALT + O</td>
</tr>
<tr>
<td>Say Cell Comment</td>
<td>CTRL + ALT + C</td>
</tr>
<tr>
<td>Say Current Time</td>
<td>CTRL + ALT + I</td>
</tr>
<tr>
<td>Say Current Date</td>
<td>CTRL + ALT + Y</td>
</tr>
<tr>
<td>Say Clipboard</td>
<td>ALT + SHIFT + C</td>
</tr>
<tr>
<td>Quiet</td>
<td>ALT + SHIFT + Q, or CTRL</td>
</tr>
<tr>
<td>Change Speech Engine</td>
<td>ALT + SHIFT + E</td>
</tr>
</tbody>
</table>
## Scroll Hotkeys

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Scroll Up</td>
<td>ALT + UP</td>
</tr>
<tr>
<td>Scroll Down</td>
<td>ALT + DOWN</td>
</tr>
<tr>
<td>Scroll Left</td>
<td>ALT + LEFT</td>
</tr>
<tr>
<td>Scroll Right</td>
<td>ALT + RIGHT</td>
</tr>
<tr>
<td>Jump Up</td>
<td>ALT + PGUP</td>
</tr>
<tr>
<td>Jump Down</td>
<td>ALT + PGDN</td>
</tr>
<tr>
<td>Jump Left</td>
<td>ALT + HOME</td>
</tr>
<tr>
<td>Jump Right</td>
<td>ALT + END</td>
</tr>
<tr>
<td>Jump Center</td>
<td>ALT + NUMPAD 5</td>
</tr>
<tr>
<td>Save View</td>
<td>ALT + NUMPAD /</td>
</tr>
<tr>
<td>Restore View</td>
<td>ALT + NUMPAD *</td>
</tr>
</tbody>
</table>
### Text Reading Hotkeys *(Magnifier/Reader only)*

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Say Previous Character</td>
<td>LEFT</td>
</tr>
<tr>
<td>Say Current Character</td>
<td>NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Character</td>
<td>RIGHT</td>
</tr>
<tr>
<td>Say Previous Word</td>
<td>CTRL + LEFT</td>
</tr>
<tr>
<td>Say Current Word</td>
<td>CTRL + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Word</td>
<td>CTRL + RIGHT</td>
</tr>
<tr>
<td>Say Previous Sentence</td>
<td>CTRL + ALT + LEFT</td>
</tr>
<tr>
<td>Say Current Sentence</td>
<td>CTRL + ALT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Sentence</td>
<td>CTRL + ALT + RIGHT</td>
</tr>
<tr>
<td>Say Previous Line</td>
<td>UP</td>
</tr>
<tr>
<td>Say Current Line</td>
<td>SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Line</td>
<td>DOWN</td>
</tr>
<tr>
<td>Say Previous Paragraph</td>
<td>CTRL + UP</td>
</tr>
<tr>
<td>Say Current Paragraph</td>
<td>CTRL + SHIFT + NUMPAD 5</td>
</tr>
<tr>
<td>Say Next Paragraph</td>
<td>CTRL + DOWN</td>
</tr>
</tbody>
</table>
In addition to the Text Reading commands listed above, ZoomText will also speak when using the standard text navigation and editing keys listed in the following table.

<table>
<thead>
<tr>
<th>Keys</th>
<th>Application Action</th>
<th>ZoomText Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>BACKSPACE</td>
<td>Deletes the character to the left of the cursor.</td>
<td>Speaks the deleted character.</td>
</tr>
<tr>
<td>DELETE</td>
<td>Deletes the character to the right of the cursor.</td>
<td>Speaks the new character to the right of the cursor.</td>
</tr>
<tr>
<td>HOME</td>
<td>Moves the cursor to the beginning of the line.</td>
<td>Speaks the first word on the line (or nothing if the line begins with a space or tab).</td>
</tr>
<tr>
<td>END</td>
<td>Moves the cursor to the end of the line.</td>
<td>Speaks &quot;End of line.&quot;</td>
</tr>
<tr>
<td>PAGEUP</td>
<td>Pages the application window up.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting. When the text cursor moves to a new line.</td>
</tr>
</tbody>
</table>

(Continued)
<table>
<thead>
<tr>
<th>Hotkey</th>
<th>Action</th>
<th>Speak Action</th>
</tr>
</thead>
<tbody>
<tr>
<td>PAGEDOWN</td>
<td>Pages the application window down.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting When the text cursor moves to a new line.</td>
</tr>
<tr>
<td>CTRL + HOME</td>
<td>Moves to the beginning of the document.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting When the text cursor moves to a new line.</td>
</tr>
<tr>
<td>CTRL + END</td>
<td>Moves to the end of the document.</td>
<td>Speaks the word or line that the cursor appears on, according to the program echo setting When the text cursor moves to a new line.</td>
</tr>
</tbody>
</table>

**Note:** When holding down the **SHIFT** key to select text by character, word, line or paragraph, the visible text that is selected or de-selected will be spoken.
# User Interface Hotkeys

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Enable ZoomText</td>
<td>ALT + INS</td>
</tr>
<tr>
<td>Disable ZoomText</td>
<td>ALT + DEL</td>
</tr>
<tr>
<td>Display User Interface</td>
<td>CTRL + SHIFT + U</td>
</tr>
<tr>
<td>Help Tool</td>
<td>CTRL + SHIFT + H</td>
</tr>
</tbody>
</table>

# Windows Vista Logon Support Hotkeys

<table>
<thead>
<tr>
<th>Commands</th>
<th>Keys</th>
</tr>
</thead>
<tbody>
<tr>
<td>Logon Support On</td>
<td>ALT + INSERT</td>
</tr>
<tr>
<td>Logon Support Off</td>
<td>ALT + DELETE</td>
</tr>
<tr>
<td>Increase Magnification</td>
<td>ALT + NUMPAD PLUS</td>
</tr>
<tr>
<td>Decrease Magnification</td>
<td>ALT + NUMPAD MINUS</td>
</tr>
<tr>
<td>Color Invert On/Off</td>
<td>CTRL + SHIFT + C</td>
</tr>
<tr>
<td>Speech On/Off</td>
<td>ALT + SHIFT + S</td>
</tr>
</tbody>
</table>
All ZoomText settings can be saved and restored using configuration files. Configuration files control all ZoomText features; including magnification level, zoom window type, screen enhancements, reading options, application settings and hotkeys. Any number of files can be saved, allowing you to create custom ZoomText configurations that can be recalled at any time.
Saving and Loading Configurations

The current ZoomText settings can be saved to a configuration file at any time. This configuration file can be loaded at a later time and the new settings will take effect immediately.

► To save settings to a configuration file
1. Set all ZoomText features as desired.
2. In the File menu, choose Save Configuration...
   The Save Configuration dialog box appears displaying the existing configuration files.
3. Type the name of the new configuration in the File name box.
4. Click on the OK button.

► To load settings from a configuration file
1. In the File menu, choose Open Configuration...
   The Open Configuration dialog box appears displaying the existing configuration files.
2. Highlight the desired configuration file.
3. Click on the Open button.
The Default Configuration

When you start ZoomText, the default configuration file, ZT.ZXC, is automatically loaded. This file contains the built-in defaults for all ZoomText settings. You can create your default configuration, which will load your custom settings whenever ZoomText is run. Don't worry about losing the built-in settings – the original default file can be easily restored.

▶ To save a custom default configuration
1. Set all ZoomText features as desired.
2. In the File menu, choose Save As Default.
   
   A dialog appears prompting you to confirm saving the configuration.
3. Select Yes to overwrite the current default configuration.

▶ To restore the original default configuration file
1. In the File menu, choose Restore Defaults.
   
   A dialog appears prompting you to confirm restoring the configuration.
2. Select Yes to overwrite the current default configuration.
You can use hotkeys to load configuration files, without activating the ZoomText user interface. Before a configuration hotkey can be used, a configuration file must be assigned to it. The following table lists the default configuration hotkeys. For information on assigning configurations to hotkeys, see "Changing Hotkey Settings" in Chapter 6.

<table>
<thead>
<tr>
<th>To load...</th>
<th>Press</th>
</tr>
</thead>
<tbody>
<tr>
<td>Configuration File 1</td>
<td>ALT + SHIFT + 1</td>
</tr>
<tr>
<td>Configuration File 2</td>
<td>ALT + SHIFT + 2</td>
</tr>
<tr>
<td>Configuration File 3</td>
<td>ALT + SHIFT + 3</td>
</tr>
<tr>
<td>Configuration File 4</td>
<td>ALT + SHIFT + 4</td>
</tr>
<tr>
<td>Configuration File 5</td>
<td>ALT + SHIFT + 5</td>
</tr>
<tr>
<td>Configuration File 6</td>
<td>ALT + SHIFT + 6</td>
</tr>
<tr>
<td>Configuration File 7</td>
<td>ALT + SHIFT + 7</td>
</tr>
<tr>
<td>Configuration File 8</td>
<td>ALT + SHIFT + 8</td>
</tr>
<tr>
<td>Configuration File 9</td>
<td>ALT + SHIFT + 9</td>
</tr>
<tr>
<td>Configuration File 10</td>
<td>ALT + SHIFT + 0</td>
</tr>
</tbody>
</table>
Application Settings

Within each ZoomText configuration, you can define custom settings for each application that you use. For example, you can have ZoomText display your web browser at one magnification level and your word processor at another. Whenever these applications become active their ZoomText settings are automatically restored. Applications without custom settings are displayed and spoken according to the settings of the current configuration file.

To define and save application settings

1. Open the application for which you want to define settings.
2. Switch directly to ZoomText and select the settings you wish to use with that application.
3. In the File menu, choose Save Application Settings.

A dialog prompts you to save the application settings.

Hotkey: CTRL + SHIFT + S

4. Click the Yes button to save the application settings.

At any time, you can disable or delete application settings. Disabled application settings remain in your configuration and may be re-enabled at any time. Deleted application settings are removed from your configuration.
To disable or delete application settings

1. In the ZoomText File menu, choose Manage Application Settings...

   The Manage Application Settings dialog appears.

2. To disable application settings; in the Use application Settings for listbox, uncheck the desired applications.

   The selected application remains in the list, but application settings are not used.

3. To delete application settings, select the desired application and choose Delete Selected.

   The selected application is removed from the list.

4. Click on the OK button.

Manage Application Settings dialog

The following table describes settings in the Manage Application Settings dialog.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Use application settings for</td>
<td>Displays a list of application settings that have been saved in the current</td>
</tr>
<tr>
<td></td>
<td>ZoomText configuration.</td>
</tr>
<tr>
<td>Enable All</td>
<td>Enables all items listed in the Use Application Settings for listbox.</td>
</tr>
<tr>
<td>Disable All</td>
<td>Disables all items listed in the Use Application Settings for listbox.</td>
</tr>
<tr>
<td>Delete Selected</td>
<td>Deletes the selected items in the Use Application Settings for listbox.</td>
</tr>
</tbody>
</table>
Naming Applications

When ZoomText is enabled, the name of the active application appears in ZoomText's status bar. The status bar also indicates whether or not ZoomText's reading tools, reading zones and application settings are available or defined for use in the active application.

In some cases, the name of the application may be difficult to identify. When this occurs, you can specify a friendlier application name for ZoomText to display in the Name Applications dialog.

**Note:** Applications names also appear in ZoomText's Manage Application Settings and Exclude Applications dialog boxes. These application names are displayed according to the specified friendly name (if a friendly name has been defined).
To name an application

1. In the File menu, choose Name Applications...

   The Name Applications dialog appears.

2. In the Application name listbox, select the application you wish to rename.

3. In the Friendly name text box, type a new name that makes sense to you.

4. To name another application, repeat steps 2 through 4.

5. Click on the OK button.

Note: Some built-in Windows applications and utilities have pre-assigned friendly names that cannot be modified. These items are grayed out when selected in the Name Applications dialog.

Name Applications dialog

The following table describes the Name Application settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Application name</td>
<td>Displays a list of applications that are currently running on your system. The application name is the name of the program's executable file.</td>
</tr>
<tr>
<td>Friendly name</td>
<td>Allows you to type a new friendly name for the selected application. The name will appear in the ZoomText status bar when the associated application is active.</td>
</tr>
</tbody>
</table>
In today’s computer-centric world, visually-impaired individuals are challenged to meet the same performance goals as their normal-sighted peers. In many situations, especially job related, it can be difficult for these individuals to meet their goals, even when equipped with ZoomText.

With ZoomText’s scripting feature you can create and utilize scripts to customize the behavior of ZoomText and other applications, providing more informative visual and audible feedback, and automation of tasks. This in turn allows you to work with improved speed and efficiency.

Here are just a few examples of things you can do with ZoomText scripting:

- Automatically announce selected fields of information in a database or spreadsheet.
- Automatically announce new items in your email inbox and automatically read email when opened.
- Automatically announce application controls and data in more meaningful way.
- Automatically read new text that arrives in a chat window.
- Automatically announce when a selected field of information changes, such as the balance in spreadsheet dipping below a specified value.
What are Scripts and Scripting Languages?

- **What is a script?** A script is a text file containing programming commands that initiate a given ZoomText or application task. Scripts can consist of a few lines of very simple commands or many lines of complex programming. ZoomText scripts are written using one of the industry standard scripting languages, such as VBScript, Jscript/JavaScript, C# or Perl. No special tools are required to write a script, in fact, scripts can be written using the Windows Notepad. However, you must have some knowledge and experience writing scripts.

- **What are scripting languages?** Scripting languages are programming languages that control existing applications or their components. Scripting languages can be created and used without special programming software or the need for traditional compiling and building of program code. Thus, they favor rapid development and the ability to communicate with other programs. There are many different scripting languages, each of which is generally designed for a specific type of use.

- **What scripting languages can be used to write ZoomText scripts?** The standard industry scripting languages that we suggest are: VBScript, Jscript/JavaScript, C# and Perl.
Writing ZoomText Scripts

Although most anyone can learn to write basic ZoomText scripts, writing true productivity scripts requires an amount of experience and expertise. Therefore, Ai Squared recommends using an experienced script writer to design, create and test scripts – preferably one that is understands the challenges faced by visually-impaired computer users.

An experienced script writer may be available within your company or organization – start by checking with your department manager or IT department. You may also find an experienced script writer through services advertised on the Internet. If you are unable to find a script writer on your own, Ai Squared may be able to assist you in finding a script writer – contact Ai Squared’s product support department at (802) 362-3612 or send email to support@aisquared.com.

Other Sources of ZoomText Scripts

With growing popularity of ZoomText scripting a variety of scripts for mainstream applications will become available for users to download and purchase. These scripts will be made available in the ZoomText Scripting Library on Ai Squared’s website. For more information, go to www.aisquared.com/scripting.
Scripting Documentation for Script Writers

The ZoomText Scripting Documentation for Script Writers provides instructional information for writing and testing ZoomText scripts.

▸ To view the Documentation for Script Writers

Do one of the following:

• In the Settings menu, choose Scripting ➤ Documentation.

• In the Windows Start menu, select All Programs ➤ ZoomText 9.1 ➤ Scripting ➤ Documentation.
Managing Scripts

ZoomText’s scripting feature allows you to register and run scripts for any application. Some users may only require a few scripts for a single application, while other may need many scripts for many applications. The ZoomText Script Manager makes the process of registering, viewing and managing scripts a simple and intuitive task.

Here's what you can do with the ZoomText Script Manager:

- Register new scripts written for ZoomText
- Enable and disable scripts as needed (without having to unregister them)
- Open and edit scripts. **Important:** Editing scripts should only be performed by a qualified script writer.
- View a description of each script, including the script’s purpose

**Note:** You must have administrative privileges to make changes in the ZoomText Script Manager. Registering and modifying scripts can adversely affect the behavior of your system and should only be performed by a qualified individual or according to their instructions.
To view and manage ZoomText scripts

In the Settings menu, choose Scripting ► Script Manager...

The Script Manager dialog appears.

Modify the registered scripts as desired.

Click the OK button.

The ZoomText Script Manager dialog

The following table describes the Script Manager settings.
### Setting | Description
--- | ---
Registered Scripts: | Displays a list of scripts that are currently registered for use when ZoomText is running. Scripts that appear in this list may be enabled and disabled, moved up and down to prioritize their execution (when triggered by the same event), or removed altogether by unregistering the script. To perform these actions, select the desired script (or scripts) and then choose the desired script action.

Register a Script... | Opens the Register Script dialog where you can specify scripts that you want to register for use with ZoomText. For information on how to register a script, see Registering Scripts.

Enable | Enables the highlighted script (or scripts). When a script is enabled it is executed whenever ZoomText is running – according to its designed purpose.

**Note:** A script can also be enabled or disabled by clicking its associated check box.

*(Continued)*
<table>
<thead>
<tr>
<th><strong>Disable</strong></th>
<th>Enables the highlighted script (or scripts). When a script is disabled it remains registered with ZoomText but is not executed. <strong>Note:</strong> A script can also be enabled or disabled by clicking its associated check box.</th>
</tr>
</thead>
<tbody>
<tr>
<td><strong>Edit...</strong></td>
<td>Opens the selected script in Windows Notepad where it may be viewed and edited.</td>
</tr>
<tr>
<td><strong>Unregister</strong></td>
<td>Removes the selected script so that it is no longer loaded by ZoomText. When a script is unregistered, it is immediately terminated and removed from the list of Registered Scripts.</td>
</tr>
<tr>
<td><strong>Script Information:</strong></td>
<td>Displays information about the highlighted script (if provided by the script author), including the author date, version, contact information and a description of the script's purpose.</td>
</tr>
</tbody>
</table>

For more information about creating and registering scripts, see the ZoomText Scripting Documentation for Script Writers. In the **Settings** menu, choose **Scripting** ➤ **Documentation**.
Registering Scripts

In order to use scripts written for ZoomText they must first be registered using ZoomText's Script Manager. There are two types of ZoomText scripts that can be registered – script programs and script components.

- A **script program** is a text file and can be registered by simply browsing to and selecting its corresponding file. Script program files are typically written in VBScript (.VBS), Jscript (.JS) or Perl (.PL) scripting languages.

- A **script component** is a program file that must first be registered with Windows and ZoomText. These program files typically have a .DLL or .WSC file extension.

**Important!** You must have administrative privileges to register scripts and make changes in the ZoomText Script Manager. Registering and modifying scripts can adversely affect the behavior of your system and should only be performed by a qualified individual or according to their instructions.
To register a 'script program' with ZoomText (e.g. VBS, JS, PL)

In the Settings menu, choose Scripting ➤ Script Manager...

The Script Manager dialog appears.

In the Script Manager dialog, choose Register a Script...

The Register Script dialog appears.

Browse to folder containing the script program you want to register.

Select the script program and click the OK button.

The Script Manager dialog appears.

Click the OK button.
To register a 'script component' with ZoomText (e.g. DLL, WSC)

If your script component is already registered with the Windows operating system, proceed to step 2. Otherwise, first register your script with Windows as follows:

- To register a Windows scripting component (.WSC file):
  a) In Windows Explorer, locate the scripting file.
  b) Right-click on the file and select Register.

- To register a COM scripting component (.DLL file):
  a) Click on the Windows Start button and select Run...
  b) Type COMMAND and click the OK button.

    The command prompt appears.
  c) At the command prompt, type:

    REGSVR32 \{path\filename of script\}

  d) Press the ENTER key.

    The script is registered with Windows.
  e) Type EXIT and press the ENTER key.

    The command prompt window closes.

In the Settings menu, choose Scripting ▶ Script Manager...

The Script Manager dialog appears.
In the Script Manager dialog, choose **Register a Script**...

*The Register Script dialog appears.*

In the **Script component program ID** field, type the program ID (aka ProgID) for the script component you want to register.

Click the **OK** button.

![Register Script dialog](image)

*The Register Script dialog*

The following table describes the Register Script settings.
<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Script file path and name:</td>
<td>Provides a place for you to type the location and file name of the script program you want to register. If you are not sure of the program's location or file name, click Browse.</td>
</tr>
<tr>
<td>Browse...</td>
<td>Displays the Select Script File dialog box, which allows you to navigate files folders and select existing script files.</td>
</tr>
<tr>
<td>Script component program ID (ProgID):</td>
<td>Provides a place for you to type the program ID for the script component you want to register. Program IDs are provided by the script author.</td>
</tr>
<tr>
<td>Script information</td>
<td>Displays information about the specified script file or script component (if provided within the script), including the author date, version, contact information and a description of the script's purpose.</td>
</tr>
<tr>
<td>Show Script Information</td>
<td>When entering a program ID, clicking the Show Script Information button will display the script information (if provided within the script).</td>
</tr>
</tbody>
</table>
Script Hotkeys

ZoomText scripts can be written so that they execute automatically in response to specified events or when pressing a hotkey (or hotkeys). When a script is written for execution by hotkey(s), the hotkey(s) will appear in ZoomText’s Hotkeys dialog box. Like all ZoomText hotkeys, you can view and modify the script hotkey assignments.

- **To view the script hotkeys**
  
  In the Options menu, choose Hotkeys...

  
  *A list of script hotkeys appear in the Hotkeys Command list.*

  In the Hotkey Group box, select Scripts.

  *The Hotkeys dialog appears.*

  To view a script hotkeys assigned key combination, click on the desired script hotkey.

  *The hotkey’s assigned key combination appears in the Primary Key and Modifier Keys settings.*

  Adjust the hotkey combination as desired.

  Repeat steps 3 and 4 for each hotkey you wish to view or modify.

  Click the OK button.
The Hotkeys dialog

The following table describes the new Hotkey settings related to scripts.

<table>
<thead>
<tr>
<th>Setting</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>Hotkey Group</td>
<td>Selects a group of related hotkeys. The hotkeys in the selected group appear in the Hotkey Command list.</td>
</tr>
<tr>
<td>Hotkey Command</td>
<td>Displays a list of all hotkeys in the selected hotkey group. When a hotkey is highlighted, its primary and modifier keys are displayed.</td>
</tr>
<tr>
<td>Primary Key</td>
<td>Sets the primary key for the highlighted hotkey command. Any key in the drop down list can be selected, including mouse buttons.</td>
</tr>
<tr>
<td>Modifier Keys</td>
<td>Sets the modifier keys for the highlighted hotkey command. One or more modifier keys must be selected.</td>
</tr>
<tr>
<td>---------------</td>
<td>--------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Disable Hotkey</td>
<td>Disables a hotkey command from functioning. When a hotkey is disabled, the primary and modifier keys are grayed out. Click on the Enable Hotkey button to re-enable the hotkey.</td>
</tr>
<tr>
<td>Restore Defaults</td>
<td>Restores all hotkeys to their original settings.</td>
</tr>
<tr>
<td>Configuration File</td>
<td>Displays the name of the configuration file associated with a Load Configuration hotkey.</td>
</tr>
</tbody>
</table>
| Browse... | Displays the Select Configuration dialog box, which lists the existing configuration files. A configuration file can be assigned to a Load Configuration hotkey by selecting the desired file and choosing OK.  
**Note:** The Browse button is only enabled when a Load Configuration hotkey command is highlighted. |
A

about the user’s guide 10, 11
   documentation formatting 11
activating ZoomText 21
   activating on more than one computer 26
activation FAQs 28-29
activation process 23-25
preparing to activate 22
transferring your license 27
wizard 23, 24, 25
Adjust tool 61, 63
   hotkey 61, 225
   using the 61
   scrolling with 61
alignment 130
   changing options 130
   dialog box 131-132
   edge margin 132
   types of
      center 131
      edge 131
always on top 215, 216  See also preferences, user interface
application names  See naming applications
application settings 242
   defining and saving 242
   disabling and deleting 244-245
   hotkey 242, 226
Manage Application Settings dialog box 244
AppReader 172
  changing settings 174
dialog box 174-175
exiting 172
hotkeys 172, 176-177, 226-227, 231
options 200  See also reading options
rate 202  See also speech, adjusting speech rate
starting 173
AppReader button 142, 173
  hotkey 173, 226, 231
automatic updating 18
  disabling 19, 212, 214
  manually checking for updates 19
  wizard 18-19

C
center alignment 131  See also alignment, types of
checking for updates  See automatic updating
ClearType 217
clipboard reading  See Windows clipboard
Close box 38  See also exiting ZoomText
Color button 48, 88
color enhancements 88
  custom settings 89
dialog box 89-93
  hotkey 88, 225
  schemes 88
commands  See hotkeys
configuration files 239
  default (Zt.zxc) 241
    restoring 241
    saving 241
loading 240
saving 240
saving automatically 212, 213
configuration hotkeys 228, 242
assigning configuration files to 224
contrast 92  See also color enhancements, custom settings
control tracking 127  See also tracking, types of
Cursor button 48
cursor color 100  See also cursor enhancements
Cursor Detect hotkey 230
cursor enhancements 98
  custom settings 98
dialog box 99-101
  hotkey 98, 229
  schemes 98
cursor locator 100  See also cursor enhancements
cursor size 100  See also cursor enhancements, types of
cursor tracking  See mouse pointer tracking

D
default configuration file 241  See also configuration files
Desktop button 49, 114
Desktop Finder 113
  dialog box 115-116
  hotkey 114, 229
  starting 114
  using the 114
disabling ZoomText 35, 36
Display User Interface hotkey 34, 234
Docked zoom windows 55, 58, 59, 61, 66
  See also zoom windows
types
  Docked Bottom 59
  Docked Left 59
  Docked Right 59
  Docked Top 58

DocReader 178
  changing settings 182
  dialog box 182-184
  display formats (modes)
    Prompter 178, 181
    Ticker 178, 181
  exiting 179, 181
  hotkeys 179, 185-186, 226-227, 231
  options 200-204 See also reading options
  Power (magnification) 180
  rate (reading speed) 180, 201-202
    See also speech, adjusting speech rate
  screen 178
  speech settings See speech, settings
  starting 179
  toolbar 180-181

DocReader button 100, 143
  hotkey 179, 226, 231

downloading program components 17

Dual Monitor Support 69
  advanced settings 77-78
  dialog box 74-76
  hotkeys 73, 229
  primary monitor and physical arrangement 79-80
  requirements 71-72
  troubleshooting 81-87
  using 73
  views 69, 70, 74, 75, 76
Index  •  269

E

Echo settings  156
  mouse  159
    changing settings  159
    dialog  160-161
    enabling and disabling  159
    hotkey  159, 231
  program  161
    changing settings  162
    dialog  162-163
  typing  156
    changing settings  156
    dialog  157-158
    enabling and disabling  156
    hotkey  156, 231
  verbosity  164
    changing level  164
    changing settings  164
    dialog  165-170
    hotkey  164, 231

edge alignment  130, 131  See also alignment, types of
edge margin  131, 132  See also alignment

enabling ZoomText  35, 36
excluding applications (xFont)  111
  See also  font enhancements, xFont options

exiting ZoomText  36, 38  See also  preferences, program

F

Finders  See Desktop Finder, Text Finder and Web Finder
Focus button  48, 102
focus enhancements 3, 7, 48, 102
  custom settings 102
dialog box 103-105
hotkey 102, 229
schemes 102
font enhancements 106
dialog box 108-110
hotkey 107, 229
types of
  None 108, 109
  Standard 106, 108, 109
  xfont 106, 108, 109
xFont options 107, 108
  bold 106, 109
  condensing 106, 109
  excluding applications 111
  smooth edges 106, 109
fractional magnification levels 50, 51, 65, 109
  See also magnification (Power)
Freeze tool 62-65
Freeze window 62
  adjusting 62
  creating 63
dialog 64-65
  enabling and disabling 64
  magnification level (Power) 64, 65
Full zoom window 48, 55, 58, 61, 62, 63, 65
  See also zoom windows
H

Help, documentation and tools 45
Help tool 33, 45  See also What’s This? tool
  using the 46
hotkeys 221
  changing hotkey settings 224
  combinations 221
  configuration hotkeys 228
    assigning to a configuration file 224
dialog box 222-223
disabling 222, 223
groups
  AppReader and DocReader 226-227
  configuration 228
  magnification 228
  magnifier toolbar 229
  miscellaneous 230
  reader toolbar 224
  reading zones 232
  screen reading 233
  scroll 234
  text reading 235-237
  user interface 237
  passing to current application 225
  restoring defaults 222,223

I

inside area (tracking bounds) 128  See also tracking, area
installing ZoomText 14
  running Setup 16
interface settings (language) 215, 216
Language (interface settings) 215, 216
Lens zoom window 48, 55, 58, 60  See also zoom windows
Line zoom window 48, 55, 58, 59, 60  See also zoom windows
locator 66
  changing options  67
  dialog box  67-68
  enabling and disabling  67
  hotkey  67, 230
logon support (Windows Vista) 40-42, 217, 218

Magnifier  See product types, Magnifier
Magnifier/Reader  See product types, Magnifier/Reader
Magnifier toolbar 47  See also toolbars
magnification (Power)  See also DocReader, magnification
  adjusting  36, 50
  dialog  51
  displaying whole powers only  51
  fractional levels  50, 51
  hotkeys  50, 228
  Power spinbox 48, 50, 51, 65
margins  See alignment, edge margin
menu tracking  127  See also tracking, types of
menus
  File  See configuration files
  Actions
    Enable ZoomText  See ZoomText, enabling and disabling
    Disable ZoomText  See ZoomText, enabling and disabling
    Enable Speech  See speech, enabling and disabling
    Disable Speech  See speech, enabling and disabling
    Start AppReader  See AppReader, starting
Start DocReader  See DocReader, starting
SpeakIt Tool  See SpeakIt tool
Adjust Tool  See Adjust tool
Enable Freeze Window  See Freeze window
New Freeze Window  See Freeze tool
New Reading Zone  See Reading Zones, creating
Edit Reading Zones  See Reading Zones, editing
Trigger Reading Zone  See Reading Zones, triggering
Navigate Reading Zones  See Reading Zones, navigating
View Mode  See View mode

Magnifier
Power  See magnification (Power)
Zoom Window  See zoom windows
Freeze Window  See Freeze tool and Freeze window
View Locator  See view locator
Color Enhancements  See color enhancements
Pointer Enhancements  See pointer enhancements
Cursor Enhancements  See cursor enhancements
Text Enhancements  See text enhancements
Desktop Finder  See Desktop Finder
Web Finder  See Web Finder
Text Finder  See Text Finder

Reader
Synthesizer  See speech, settings
Text Processing  See speech, settings
Hints  See speech, settings
Typing Echo  See echo settings
Mouse Echo  See echo settings
Program Echo  See echo settings
Verbosity  See echo settings
AppReader  See AppReader
DocReader  See DocReader
Reading Zones  See Reading Zones
Reading Options  See reading options
Settings
Tracking  See navigation settings
Alignment  See navigation settings
Mouse  See navigation settings
Program  See preferences
User Interface  See preferences
Hotkeys  See hotkeys
Help
ZoomText Help  See Help, documentation and tools
Help Tool  See Help tool
Check for Program Updates  See checking for updates
Download Program Components
  See downloading program components
Transfer Software License
  See activating ZoomText, transferring your license
Microsoft Speech  146
Minimize button  33, 34
minimizing ZoomText  34
  See also starting ZoomText, minimized
Mouse button  142, 159
Mouse navigation  133
  changing options  133
  dialog box  133-134
mouse pointer tracking  127  See also tracking, types of
mouse wheel zooming  53
  dialog box  54
  enabling and configuring  53
N
naming applications 246
  dialog box 247-248
  naming and saving 247
navigation settings 126
  alignment 130-132 See also alignment
  mouse 133-134 See also mouse navigation
  smooth scrolling 138-139 See also smooth scrolling
  tracking 126-129 See also tracking
NeoSpeech 5, 146

O
outside area (tracking bounds) 128 See also tracking, area
Overlay zoom window 48, 55, 58, 60, 66
  See also zoom windows

P
panning 135
Pass Thru hotkey 225, 230
  See also hotkey, passing to current application
Pointer button 48, 94
pointer enhancements
  custom settings 94
  dialog box 95-97
  hotkey 94, 229
  schemes 94
Power spinbox 48, 50, 51, 65 See also magnification (Power)
Primary Clone 69, 70, 74, 76 See also dual monitors
Primary Span 69, 70, 74, 75 See also dual monitors
Primary with 1x 69, 70, 74, 76 See also dual monitors
preferences
  program 211
    changing options 211
    dialog box 211-213
  user interface 215
    changing options 215
    dialog box 215-216
product types 1, 2, 4, 10
  Magnifier 1, 2, 4, 10
  Magnifier/Reader 1, 4, 10
    exclusive features 10, 141
Prompter mode See DocReader, display formats

Rate spinbox 141, 142, 145 See also speech, synthesizer settings
Reader toolbar 141 See also toolbars
reading options 200
  changing settings 200
  dialog box 201-204
reading text
  See AppReader, DocReader, Reading Zones and text reading
Reading Zones 187
  adjusting settings 195
  creating 189-190
  deleting 162
  dialog 196-199
  editing 191
  hotkeys 189, 191, 193, 194, 198, 232
  navigating 194
  toolbar 187-188
  triggering 193
restoring ZoomText 34
S

SAPI 145, 146, 147, 148, 180,
saving and restoring a view 139
screen enhancements
  color enhancements See color enhancements
  cursor enhancements See cursor enhancements
  focus enhancements See focus enhancements
  font enhancements See font enhancements
  pointer enhancements See pointer enhancements
screen reading 141
  commands 233
Scripting 249
  documentation for scripting writers 252
  hotkeys 262-264
  languages
  managing 253-256
  other sources 251
  registering 257-261
  scripts
    what are scripts and scripting languages 250
    writing 251
scrolling 138 See also Adjust tool, scrolling with
  hotkeys 138, 139, 238
  saving and restoring a view 139
    hotkeys 139, 234
Setup 16 See also installing ZoomText
smooth mouse panning 137
smooth panning 135-137
  hotkeys 135, 230
smooth scrolling 138
  hotkeys 138, 139, 234
SpeakIt button 143, 205
SpeakIt tool 144, 205
  hotkey 205, 231
  using the 205
speech 144
  adjusting speech rate 145
  enabling and disabling 144
    hotkey 144, 231
  hotkeys 144, 145, 231
  pitch 146, 147, 148
settings
  hints 153-155
  synthesizer 146-149
    text processing 150-152
  terminating (silencing) 144
  volume 146, 147, 148
Speech button 141, 142, 144
  See also speech, enabling and disabling
speech rate 145  See also speech
speech synthesizer 146  See also speech, settings
starting ZoomText 20
  minimized 212
  shortcut key 212, 213
  starting automatically 212
status bar 33, 215, 216
synthesizer settings 146-149  See also speech, settings
system requirements 9
System tray icon 36
Index

T

taskbar button 215, 216
Text button 49, 121
text cursor tracking 126, 127  *See also* tracking, types of
Text Finder 121
  dialog box 123-125
  hotkey 121, 229
  starting 121
  toolbar 122
  using the 121
text processing  *See* speech, settings
text reading 207  *See also* AppReader and DocReader
  commands 207-210, 235-237
text smoothing  *See* text enhancements
Ticker mode  *See* DocReader, display formats
tool tip tracking 127  *See also* tracking, types of
toolbars 32
  button highlighting 215-216
  commands
    Magnifier 229
    Reader 231
  restoring 215, 216
types
  DocReader 180-181  *See also* DocReader
    Magnifier 47-49
    Reader 141-143
    Reading Zones 187-188
    Text Finder 122
tools

types
  Adjust *See* Adjust tool
  Freeze *See* Freeze tool
  SpeakIt *See* SpeakIt tool

using with the keyboard 37

tracking 126

area
  inside area 128
  outside area 128
  setting 128

changing options 126

dialog box 127-128

enabling and disabling 129

hotkey 129, 226

types of
  controls 127
  menus 127
  mouse pointer 127
  text cursor 127
  tool tips 127
  windows 128

transferring your ZoomText license
  *See* activating ZoomText, transferring your license

tray icon 36, 215, 216

TruVoice 146

Type button 48, 56
  hotkey 56, 229

Typing button 142, 156

typing echo 156  *See also* echo settings, typing
uninstalling ZoomText  39
user interface  32-33
  commands  238

verbosity  See echo settings, verbosity
Verbosity button  142, 164
  hotkey  164, 231
ViaVoice  146
view, saving and restoring  139
view mode  66
  enabling  66
    hotkey  66, 230
view locator  66
  changing options  67
dialog  67-68
  enabling  67
  hotkey  67
**W**

Web button 49, 118
Web Finder 117
  - dialog box 119-120
  - hotkey 118, 229
  - starting 118
  - using the 118
What’s New in ZoomText 9.1 6-8
What’s This? tool 45  See also Help tool
  - using the 46
window tracking 126, 127, 128  See also tracking, types of windows  See zoom windows
Windows clipboard 206
  - hotkey 206, 233
  - reading the clipboard 206
Windows Vista 217
  - ClearType 217
  - logon support 40-42, 217, 218
  - preferences 217-219
  - user account control 43-44

**X**

xFont  See font enhancements
Z

Zones button 142, 189, 191, 192, 193, 194
zoom window type hotkey 56, 229
zoom windows 55
  dialog 57-59
  moving and sizing 60 See also Adjust tool
  selecting 56
  types 55, 57-59
ZoomText
  activating 21 See also activating ZoomText
  enabling and disabling 35
  exiting 38
  installing 14
  minimizing and restoring 34
  starting 20
ZoomText button 33, 35
ZoomText toolbar See also user interface
  minimizing and restoring 34
Zt.zxc file See configuration files, default